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Preface

CBSE has introduced Information Technology (IT) as Vocational course at 
secondary level in class IX (Level-1) and class X (level-2). In the present day 
of globalized competition, Information Technology plays a significant role. 
Information Technology (IT) has created a revolution in every field and 
enabled students towards progressive learning. To enable students towards 
progressive learning CBSE equip the students with specialized vocational 
training.

This Students Handbook titled "Information Technology NSQF Level-2" for 
class - X was prepared by PSSCIVE Bhopal for the benefit of the students who 
opt for the course.

Ample care has been taken to align the subject with National Occupation 
Standards (NOS) which are competency based standards identified by the 
IT industry to train students in knowledge and skills that equip students to 
perform effectively with confidence.

The language used in this book is simple and easily understandable to the 
students at class X level. Relevant pictorial illustrations, tables, examples and 
simplified concepts provided in this book help the students to learn with ease 
and comfort.

This book is authored by competent educationists in the field of Information 
Technology under the supervision of PSSCIVE with focus on helping the 
students to learn without any difficulty and use this book as a tool for easy 
learning.

I congratulate everyone who is associated in developing this book which is a 
very useful resource for the benefit of the students.

Dr. Satbir Bedi, IAS
Chairperson, CBSE
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SeSSioN 1: orDeriNg FooD AT A reSTAUrANT

relevant Knowledge
imagine that you are at a restaurant. the waiter has come to ask what you would like to have, and 
you want to order a plate of vegetable chowmein. How would you place the order? think about it 
and try to frame some sentences to do so.

When we place an order, there are some common terms used. Some of them are introduced here. 
Read aloud the following terms:

•	 Starters	-	The	first	course	in	a	meal,	also	called	“appetizers”	or	“starters”.
	 Usage:	“I	would	like	to	have	Fried	Vegetarian	Momos	for	starters.”

•	 main course - the primary or main dish in a meal.
	 Usage:	“I	would	like	to	have	Shahi Paneer, Chane Pindi, Raita and Rumali Roti for the main 

course.”

•	 Dessert	-	The	final	course	of	a	meal	-	it	may	be	fruits	or	a	sweet	dish.	
	 Usage:	“I	would	like	to	have	Kheer	for	dessert.”

Study	the	dialogue	given	below	and	fill	up	the	blanks	using	the	following	information:

•	 Starters	-	Chilly	Potatoes.

•	 Main	course	-	Vegetable	Fried	Rice	and	Chicken	Manchurian	with	gravy.

•	 Dessert	-	Chocolate	Ice-cream.

•	 A	bottle	of	mineral	water.

Using Articles - a, an, the

examples

A false friend is worse than an enemy. 

Are you a good teacher?

Are you the teacher who is going to teach English?

exerCiSe

Given below is a conversation between a waiter and the customer at a restaurant. imagine that 
you	are	the	customer.	Now	fill	in	the	blanks	with	the	statements	that	you	like	to	make	while	talking	
to the waiter.

1. Waiter : Are you ready to place your order, Ma’am/Sir?
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2. Customer : Yes. For___________, i would like to have

3. Waiter : How many?

4. Customer : Just one plate will do.

5. Waiter : Okay.

6. Customer : For____________________________________, i will have

7. Waiter : Okay. Anything else Ma’am/Sir?

8. Customer : Yes. i  would   like  to  order a ____________________________  

9. Waiter : Okay. One Chilly Potatoes, one Vegetable Fried Rice, one Chicken Manchurian 
with gravy, and one Chocolate ice-cream. is that correct, Ma’am?

10. Customer : Yes.

11. Waiter : Can i get you anything else?

12. Customer : Could you get me___________________________?

13. Waiter : Sure, Ma’am/Sir.

14. Customer : ________________________ you. that will be all.

ASSeSSmeNT

Fill in the blanks with the correct articles A, AN, and THe, wherever necessary.

1. Could you get me _______________ bowl of chicken soup? (a, the).

2. i would like to cancel _______________ (a, the) Masala Dosa i ordered and have 
_______________ plate of Tandoori chicken with fried rice instead (a, the).

3. i ordered _______________ chocolate ice cream, not strawberry (a, the, no article 
needed).

4. i will have a tomato and mushroom pizza with _______________ cheese topping. (a, the, 
no article needed).

5. For dessert, _______________ plate of kheer will do (a, the, no article needed).

6. i will have _______________ kheer for dessert (a, the, no article needed).

7. Our specialty is _______________ Tandoori chicken. Do try it (a, the, no article needed).

8. Please get me _______________ glass of water.

9. i would like to have _______________ onion masala dosa and vanilla ice-cream.

10. Excuse me, where is _______________ washroom?



5information technology

Unit-1

11. What is _______________ specialty of this restaurant?

12. Can i smoke _______________ cigarette here?

13.	 Can	we	sit	on	_______________	upper	floor?

14. What is on _______________ menu today?

15. Do you serve _______________ Chinese food here?

16. Please give me some _______________ tissue paper.

17. Could you tell me _______________ recipe of this dish?

SeSSioN 2: mAKiNg reSoLUTioNS

relevant Knowledge
Have you ever made a promise to yourself? A promise could be as simple as:

1. i will never lose my temper again.

2. i will try to study hard this year and get a 1st division.

3. i will talk less on my mobile.

4. i will help mother out with her household chores when she comes home tired from work.

5. i will get 95% in Math this year.

6. i will learn to speak properly in English within six months.

think about what you would like to promise to yourself. these promises are actually what are 
known	as	your	own	“resolution”.	In	the	session,	we	will	learn	about	this	concept.

Simple future tense
the use of words like will and shall denote the future time of action. 
now read the following sentences:

Set A

1. i will try to learn English well.

2. i will try to see fewer movies.

3. i will learn three new words every day.

4. i will exercise every morning for 1 hour.

5. i will not carry forward any regrets.
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6. i will keep my room neat and clean.

7. i will accept the terms and conditions.

8. He will not let you join.

9. But we will argue in your favour.

now compare the above sentences with the following:

Set B

1. i try to learn English well.

2. i try to see fewer movies.

3. i learn three new words every day.

4. i exercise every morning for 1 hour.

5. i take care of the dogs in my colony.

6. i do not carry any regrets.

7. i keep my room neat and clean.

Do	you	see	the	difference	between	the	two	sets	i.e.	set	A	and	B	of	sentences?	The	first	set	of	
sentences is in simple future tense. the second set denotes a fact or a habit, and are all in the 
simple present tense.

exerCiSe
Read	the	following	sentences.	These	are	 incomplete	sentences.	Try	 to	fill	 them	with	what	you	
wish to do in your life.

1. i promise to...

2. i promise i will...

3. i resolve never to...

4. i resolve to...

5. i will try to...

6. i will try my best...

7. i am never going to...

ASSeSSmeNT
From the following options, select and tick the one that is in the simple future tense.

1. i did not smoke.

 (a) i will not smoke.
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 (b) i will not smoking

 (c) i will not smoked.

2.	 I	exercise	everyday	to	stay	fit	and	healthy.

	 (a)	 I	will	exercised	everyday	to	stay	fit	and	healthy.

	 (b)	 I	will	exercising	everyday	to	stay	fit	and	healthy.

	 (c)	 I	will	exercise	everyday	to	stay	fit	and	healthy.

3.	 I	opened	a	small	flower	shop	in	the	market.

	 (a)	 I	will	open	a	small	flower	shop	in	the	market.

	 (b)	 I	will	opened	a	small	flower	shop	in	the	market.

	 (c)	 I	will	opening	a	small	flower	shop	in	the	market.

4. the president and his wife raised funds for charity.

 (a) the president and his wife will raising funds for charity.

 (b) the President and his wife will raised fund for charity.

 (c) the President and his wife will raise fund for charity.

5. i stuck to my resolution.

 (a) i will sticking to my resolution.

 (b) i will stick to my resolution.

 (c) i will stuck to my resolution.

6. i changed most of the furniture in my house before Diwali.

 (a) i will changed most of the furniture in my house before Diwali.

 (b) i will changing most of the furniture in my house before Diwali.

 (c) i will change most of the furniture in my house before Diwali.

7. i started going for driving classes on tuesdays.

 (a) i will started going for driving classes on tuesdays.

 (b) i will starting going for driving classes on tuesdays.

 (c) i will start going for driving classes on tuesdays.

8. team india won every match against Australia in the World Cup.

 (a) team india will won every match against Australia in the World Cup.
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 (b) team india will every match against Australia in the World Cup.

 (c) team india will waning every match against Australia in the World Cup.

9. i spoke in English with my friends.

 (a) i will speak in English with my friends.

 (b) i will speaking in English with my friends.

 (c) i will spoke in English with my friends.

10. i wore the seat belt while driving.

 (a) i will wore the seat belt while driving.

 (b) i will wearing the seat belt while driving.

 (c) i will wear the seat belt while driving.

SeSSioN 3: TALKiNg ABoUT CHANge 

relevant Knowledge
in this session, you will learn how to talk about change. Read aloud and try to understand from 
the examples given below.

1. Change for the better - to change so as to improve.

example: He does not watch junk movies anymore and it is a change for the better. He now 
enjoys serious cinema.

2. Change for the worse - to change but become worse.

example: She has started reading novels. But it is a change for the worse as she reads them 
more than her school books!

3. Change with the times - to accept and adapt to new developments.

example: Our school is changing with the times. We now have computer labs with free internet 
connection.

4. For a change - as something different.

example: Why don’t you wear a salwar suit for a change? You always wear sarees.

5. Time for a change - an expression used when it is time to make a change.

example: I	asked	her	if	she	wanted	a	cake	for	her	birthday,	and	she	said,	“It’s	time	for	a	change-	
let’s	have	pizza	instead!”
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6. Times are changing - a response made when you hear a surprising piece of news.

example:	Man:	“They	charged	me	500	Rupees	for	this	tie!”.	Woman:	“Well,	times	are	changing.	
Ties	do	not	cost	100	Rupees	anymore.”

7. Sea change - a major change.

example: there is a sea-change in the choice of careers. Many youngsters are more interested 
in MBA nowadays than in medicine or civil services.

8.   Times change - as time passes, different things become acceptable.

example: the old man scolded his grandson for not cutting his long hair. He said that when 
he	was	young,	he	had	to	keep	it	short	and	oiled.	His	grandson	said,	“Times	change,	
Grandpa!”

Active and Passive Voice

Read the examples given below:

Active : the hair stylist changed the color of my hair. 

Passive : the color of my hair was changed by the hair stylist. 

Passive : i was praised by the headmaster. 

Active :  the headmaster praised me.

in certain sentences in the passive voice, the subject may not be mentioned:

1. You should do the work - The work should be done.

2. We completed the marathon at last - The marathon was completed at last.

3.	 Has	she	finished	her	homework?	-	Has her homework been completed?

exerCiSe

now, identify and tick the sentences that are in Active Voice:

1. they have been scolded.

2. i bought some clothes yesterday.

3. the teacher is correcting the test papers.

4. the test papers have been submitted.

5. We went there last summer.

6. We were welcomed by the hotel owner.

7. She believed him but we did not.

8. He was trusted neither by us nor by her.
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ASSeSSmeNT
Select and tick the option that is in the passive voice.

1. Ravi had to revise the document.

 (a) Ravi had to be revised in the document.

 (b) the document had to be revised by Ravi.

2. Ram should learn how to adjust to change.

 (a) Adjusting to change is what Ram should learn.

 (b) How to adjust to change must be learned by Ram.

3. Seema has changed the curtains of the bedroom.

 (a) the curtains of the bedroom have been changed by Seema.

 (b) the curtains of Seema’s bedroom are changed.

4.	 Can	Nayan	update	this	file?

	 (a)	 Can	this	file	update	Nayan?

	 (b)	 Can	this	file	be	updated	by	Nayan?

5. the youth should change things for the better.

 (a) things should be changed for the better by the youth.

 (b) the youth have to change things for the better.

6. He made some changes to this document.

 (a) to this document some changes he made.

 (b) Some changes were made to this document by him.

7. You can change your future by learning English.

 (a) Your English can change your future.

 (b) Your future can be changed by learning English.

8. nothing can change his mind.

 (a) His mind can’t be changed by anything.

 (b) His mind can be changed by nothing.
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9. the party workers do not like the new policies.

 (a) the policies do not like the new workers.

 (b) the new policies are not liked by the party workers.

10. Change makes progress possible.

 (a) Progress is made possible by change

 (b) Change makes possible progress.

SeSSioN 4: PLANNiNg AN oUTiNg

relevant Knowledge
An outing can be going for a picnic, going for a movie, going out for lunch or dinner, or going out 
for shopping. All such outings require some preparation -the extent of the preparation may vary 
depending on the nature of the outing.

Imagine	that	you	have	to	plan	a	picnic	for	your	family	and	friends.	You	may	have	to	prepare	a	“To	
Do”	list	of	all	that	you	need	to	do	and	take	to	the	picnic.	What	would	you	do	to	prepare	for	the	
picnic? think!

making a suggestion for an outing:
1. Let us go for an outing!

2. Let us go for a picnic!

3. Let us go to the movies!

4. Let us go out for lunch!

5. Let us go shopping and have lunch outside.

6. How about going for a movie?

7. Shall we go for a picnic this Sunday?

8. How about a shopping trip and lunch afterwards?

Planning the outing:
1. i will book the cab and you can arrange for the food.

2. You can take care of the plates and glasses.

3. Bring bottles of water, napkins, and some plastic bags.
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4. Can you bring two mats or an old bedcover to spread on the grass?

5. Can you check till what time the park is open?

6. Can you book the movie tickets?

7. We can meet at 6 outside the theatre.

8. i will call up Meena and Rakesh and see if they want to come along. 

Pronouns

In this session, you will learn how to make use of pronouns. The reflexive pronouns 
discussed in this session are: myself, ourselves, themselves, yourself, yourselves, himself, 
herself, and itself.

Reflexive pronouns are used usually in 3 situations:

Situation 1: When the subject and object are the same.
For example:

1. i hurt myself.

2. the music group calls themselves	“Dire	Straits”.

3. He shot himself.

Situation 2: As the object of a preposition, when the subject and the object are the same.
For example:

1. i bought a present for myself.

2. She did it by herself. (She did it alone)

3. that man is talking to himself.

Situation 3:	When	you	want	to	emphasize	the	subject.	
For example:

1. i’ll do it myself (no one else will help me).

2. they ate all the food themselves (no one else had any).

exerCiSe

identify the incorrect use of the pronouns.

1. Mitali and i went to the cafe to buy us some snacks.

2. When i saw me	in	the	mirror,	I	was	horrified	to	see	red	spots	all	over	my face.

3. Did you learn typing yourself or you went to a school?

4. What he saw was so unexpected that he pinched him to see if it was for real.
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5. Please help yourselves to the food - there is plenty!

6. i hurt myself	while	fixing	the	broken	shelf.

7. i am busy...can’t you do the work yourself?

8. i bought a nice dress for me from the mall.

ASSeSSmeNT

Fill in the blanks with the correct pronouns.

1. Except Ruhi and _______________, everyone else arrived late at the movies.

 (a) i  (b) me

2. Ravi was very helpful to_______________when we went trekking in the mountains.

 (a) us (b) ourselves

3. We really enjoyed_______________on the trip to Manali last month.

 (a) us (b) ourselves

4. His friends did not appreciate_______________going to the fair alone.

 (a) his (b) himself

5. Please bring some cotton for your ears if you do not want to be bored by_______________
continuous chatter on the trip.

 (a) his (b) him

6. As our driver had fever, naman and_______________offered to drive the car for the rest of 
the journey.

 (a) mine (b) i

7. One of_______________will have to speak to the travel agent and make arrangements for 
the trip.

 (a) you (b) your

8.	 We	must	reach	the	airport	on	time,	or	else_______________will	miss	the	flight.

 (a) we (b) us

9. it was_______________who wanted to go to the mountains instead of the beach.

 (a) Himself (b) he
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10. two of the group members, including_______________, have offered to make food and 
travel arrangements for the trip.

 (a) he (b) him

SeSSioN 5: NArrATiNg A STorY 

relevant Knowledge
Have you ever been told a story before? Perhaps many times! What it is that you like the most 
about the narration of stories? Perhaps you like to know what happened to other people, or stories 
tell you what you could do in a similar situation, or maybe because it helps you to relieve tension 
and entertains you. You may have many other reasons. think about them.

You will soon see that narrating a story is similar to narrating an incident - only story narration is 
desirable because it is presented in an animated fashion with the right intonations, pauses and 
exclamations.

When we narrate an incident too, we could use voice modulation to express what is being said 
with	emotions.	That	would	definitely	make	it	interesting	for	the	listener.

Narrating a Story of “Two Wolves”

Read out the following story aloud. try to narrate the story as best as you can.

One evening, an old tribal told his grandson about a battle that goes on inside people. He said: “My 
son, the battle is between “two wolves” inside us all...One is Evil. It is anger, envy, jealousy, sorrow, 
regret, greed, arrogance, self-pity, guilt, resentment, inferiority, lies, false pride,... superiority, and 
ego. The other is good. It is joy, peace, love, hope, serenity, humility, kindness, benevolence, 
empathy, generosity, truth, compassion, and faith.”

The grandson thought about it for a minute, and then asked his grandfather: “Which wolf wins?”

The old tribal simply replied: “The one you feed.” 

Simple Past Tense

in this session, you W’ii learn how to make use of Simple Past tense. Read aloud the following 
sentences:

1. My grandmother loved to narrate the story of Ram and Ravan to me when i was young.

2. i used to listen eagerly to her.
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3. She always left off the	story	at	an	interesting	point,	and	said	“I	will	tell	you	what	happened	
after	that	tomorrow”.

4. i would eagerly wait for the next day to come.

5. the next day i would pester her to tell me what happens next.

6. i enjoyed the storytelling sessions with my grandmother very much.

7. i don’t know if i will be able to entertain my grandchild in the same way.

8. Most probably i will not have many stories to tell or my grandchild will not be interested in 
listening to stories.

9. But i can surely say that telling stories helps to expand a child’s imagination in a way that no 
other thing does.

10. i was exhausted.

11. it was a very tiring journey.

12. i had a tiring journey.

13. the journey exhausted me.

exerCiSe

Do you remember the difference in the tenses? now, identify the sentences that have been written 
in the present and future tense.

1. My grandmother loved to narrate the story of Ram and Ravan to me when i was young.

2. i used to listen eagerly to her.

3. i would eagerly wait for the next day to come.

4. i enjoyed the storytelling sessions with my grandmother very much.

5. i don’t know if i will be able to entertain my grandchild in the same way.

6. Most probably i will not have many stories to tell or my grandchild will not be interested in 
listening to stories.

7. i was exhausted.

8. it was a very tiring journey.

9. i had a tiring journey.
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ASSeSSmeNT

From the options, select and tick the sentence that is in simple past tense.

1. (a) Seema visiting aunt Rekha at her house near the beach last weekend.

 (b) Seema visited aunt Rekha at her house near the beach last weekend.

 (c) Seema visit aunt Rekha at her house near the beach last weekend.

2. (a) it were a beautiful summer day.

 (b) it was a beautiful summer day.

 (c) it is a beautiful summer day.

3. (a) Seema building a giant sand castle on the beach.

 (b) Seema build a giant sand castle on the beach.

 (c) Seema built a giant sand castle on the beach.

4. (a) Aunt Rekha took pictures of the castle.

 (b) Aunt Rekha take pictures of the castle.

 (c) Aunt Rekha taking pictures of the castle.

5. (a) Seema wanted to play on the beach and build another sand castle.

 (b) Seema want to play on the beach and build another sand castle.

 (c) Seema wanting to play on the beach and build another sand castle.

6. (a) But soon it has become very hot outside.

 (b) But soon it became very hot outside.

 (c) But soon it becomes very hot outside.

7. (a) Aunt Rekha advised Seema to wear a hat.

 (b) Aunt Rekha advising Seema to wear a hat.

 (c) Aunt Rekha advises Seema to wear a hat.

8. (a) But Seema does not have a hat.

 (b) But Seema did not have a hat.

 (c) But Seema didn’t had a hat
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9. (a) So Aunt Rekha gave Seema one of her hats.

 (b) So Aunt Rekha giving Seema one of her hats.

 (c) So Aunt Rekha gives Seema one of her hats.

10. (a) Seema wearing the hat and made another sand castle.

 (b) Seema wears the hat and made another sand castle.

 (c) Seema wore the hat and made another sand castle.

SeSSioN 6: DeSCriBiNg A KNoWN PLACe

relevant Knowledge

Descriptive writing is an art form. it is like painting a word picture so that the person who reads 
what	you	have	written	or	listens	to	what	you	have	said,	“sees”	exactly	what	you	meant	to	describe.	
to practice descriptive writing, think of a few sentences about the city you grew up in. You could 
start off as:

1. the city that i grew up in is __________________ (name of the state).

2. it is a large/small city in__________________(name of the state).

3. the weather there is quite __________________.

Adjectives and adverbs

1. i am ready to take the test. - adjective

2. i am readily taking the test. - adverb

3. She ran out of the room in a hasty manner. - adjective

4. She ran out of the room hastily. - adverb

5. i was happy	when	I	received	the	certificate.	-	adjective

6. i happily	received	the	certificate.	-	adverb

Here are some adjectives to describe a city:

•	 City: active, bustling, noisy, busy, clean, dirty, windy.

•	 Traffic: loud, congested, snarled.

•	 Buildings: old, shabby, rundown, crumbling,modern, futuristic, sleek, towering, squat.
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•	 Buildings (walls): brick,	stone,	marble,	glass,	steel,	graffiti-covered.

•	 monuments, statues:	stone,	copper,	carved,	ancient,	moss-covered,	faded,	green,	bronze.

•	 Sidewalk: concrete, cement, slick, cracked, tidy, littered, swept.

•	 Paint: fresh, weathered, peeling.

•	 Signs:	neon,	weathered,	worn,	bright,	welcoming,	flashing.

•	 Buses, cars, taxis: belching, crawling, speeding, honking, waiting, screeching.

•	 People: hurried, bundled, smiling, frowning, eager, rushed.

•	 Now,	try	to	describe	your	city	using	the	above	pointers.

exerCiSe

i.  Read aloud the following phrases on “Describing Nainital”. Combine the phrases so as to 
form a paragraph that describes nainital. For example:

Example: Nainital is a beautiful hill-station in Uttarakhand.

1. nainital is a beautiful hill-station...

2. it is surrounded by...

3. ...in Uttarakhand.

4. ...above sea-level.

5. ...high mountain peaks

6. nainital is a very...

7. ...especially during winter...

8. ...popular tourist spot,

9. ...when the snow falls.

10. it attracts a lot of tourists in...

11. ...during the British Raj.

12. the temperature varies between...

13. ...which were established...

14. 15°Cand -3 °C at that time.

15. ...and is situated at an altitude of 1, 938 meters.

16. Apart from its beautiful scenery...

17. ...its many schools,

18. nainital is also known for...
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ii. now read aloud and very carefully, the description given below:
 “Ladakh”.

1. Leh, Drass valley and Leh-Manali track are popular tourist spots.

2. Ladakh is a region situated in Jammu and Kashmir.

3.	 Tourists	come	for	fishing	and	trekking.

4. Ladakh has a population of about 2,60,000.

5. the Kunlun mountain range lies to the north and the Himalayas lies to the south.

6. the language is written in the tibetan script.

7. the people of Dha-Hanu follow tibetan Buddhism.

8. Ladakhi culture and tibetan culture share many similarities.

9. Popular sports include archery, ice hockey, and cricket.

10. Buses and taxis are available as means of transport.

11.	 The	dances	are	about	the	fight	between	good	and	evil.

12. the people speak Ladakhi which is also known as Western Archaic tibetan.

13. About 18,000 tourists visit Ladakh every year.

14. On the other hand, those living around Dras have converted to islam.

15. it is the highest plateau of Kashmir.

16. the Ladakhis celebrate masked dance festivals.

iii. Read carefully the following passages on “adjectives and adverbs” and identify whether 
the words in bold are adjectives or adverbs:

1. i went to Jaipur, also known as Pink City. Many people readily agree it is one of the best 
structured places in india. the town was carefully planned according to Vastu Shastra. it 
was built in the form of an eight-part Mandala known as Pithapada.

2. i have never seen as heavenly a place as Kerala’s backwaters. i took a ride in a kettuvallam 
(house boat) and what i saw was truly beautiful. Palm trees, pandanus shrubs, a variety of 
leafy plants and bushes attractively decorated the place.

3. My family went on a trip to Manipur. One of the many places we visited was the Keibul 
Lamjao national Park. it is the only floating national park in the world. the place is marked 
by	floating	plants	called	Phumdi. the park is the home of the Sangai or Brow Antlered Deer, 
an endangered species which cannot be found anywhere else on earth.
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ASSeSSmeNT

Fill in the blanks with the appropriate word from the given options:

1. i _____________________ moved to a new city.

 (a) recently  (b) daily

2. i now live _____________________ in the heart of Delhi.

 (a) comfortable  (b) comfortably

3.	 My	house	is	a	_____________________	two-bedroom	flat	in	Mayur	Lok.

 (a) spaceful  (b) spacious

4. i live here with my _____________________ friend, Manish.

 (a) best  (b) better

5. there is a _____________________ monument near our house.

 (a) history  (b) historical
 
6.	 When	I	first	moved	to	Delhi,	I	found	the	city	to	be	too	_________________and	crowded.

 (a) noisy  (b) noiseful

7. now that i have lived here for a couple of years, i can’t imagine moving back to my 
_____________________town.

 (a) small  (b) tiny

8. Delhi is the capital of india and is __________________ connected to all major cities of the 
country by road, rail, and air.

 (a) good  (b) well

9. Mayur Lok is one of the ___________________ localities in Delhi.

 (a) best  (b) good

10. the area is well-maintained and planned ___________________

 (a) prettily  (b) beautifully
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SeSSioN 7: giViNg DireCTioNS

relevant Knowledge

Look at the following map. How would you give the direction to City Mall?

Read the “Terms and phrases for giving directions” given below.

1. intersection -	Also	known	as	 “junction”	and	 “crossroad”,	 it	 is	a	place	where	 two	or	more	
roads meet.

 example: We kept driving till we came to an intersection. We did not know which road to 
follow,	so	we	asked	the	traffic	police	for	directions.

2. Fork - the point at which a road divides into branches.

 example: Keep walking left till you come to a fork; take the road on your right and keep 
walking. the shop is there at the end of the road.

3. U-turn - A U-shaped turn made by a vehicle so as to take a direction opposite to the original 
course.

 example: the market is on the other side of the road. You will have to take a U-turn to reach 
it.

4. Turn left/right - Go to your left/right.

 example: the man told me to walk down the street and at the end, turn left.

5. Signpost - A post bearing a sign that gives information.

 example: the signpost says that we have to take the road on the left for noida.

6. Landmark - An easily seen building or place that serves as a guide. 

 example: The	City	Mall	serves	as	a	landmark	for	their	office.
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7. Across the street - On the other side of the street. 

 example: the book store is just across the street.

8. Next  - Beside.

 example: Mohan Lal Grocery is next to the mobile shop.

9. go straight down - Keep walking along the road.

 example: Go	straight	down	this	road	and	turn	right.	You	will	find	the	hospital	there.

10. Take the first/second road on the left/right.

 example: to reach the school, go straight and then take the second road on the right.

11. Around the corner - near the corner.

 example: the market is just around the corner of the DESU residential complex.

12. At the end of - Last Part.

 example:	You	will	find	the	store	at	the	end	of	this	road.

exerCiSe

Study	the	flowchart	given	below:
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•	 route A : Fun	 Village,	 Pushpak	 Book	 Store,	 Traffic	 Point	 B,	 Traffic	 Point	 A,	 Oriental	
Restaurant.

•	 route B : Green	Park,	Khadi	House,	Traffic	Point	B,	Traffic	Point	A,	Oriental	Restaurant.

•	 route C : Green Park, Khadi House, Working Women’s Association, Little Angels School, 
Oriental Restaurant.

in short, there can be more than one route in which you can give directions to reach DMK 
Hospital.

Prepositions
A preposition is a word that links a noun and pronoun to other words in a sentence. For 
example:

1. We went to the market.

2. the market is just around the corner.

3. Many kinds of stores can be found at the market.

Prepositions are used as follows:

•	 Prepositions of time: at, on, in, during, since, until, by, etc. We reached the hostel at 9 pm. 
We reached the hostel on Monday. We will reach the airport in an hour. Note: Use at for 
specific	times,	on	for	days	and	dates,	and	in	for	non-specific	times.

•	 Prepositions of place: at, on, in, over, above, under, beside, behind, etc. We went to the 
library. the library is on Hudson Lane. Note: Use at	for	specific	places,	on for roads, streets, 
etc., and in for cities, countries, etc.

•	 Prepositions of direction: to, from, across, through, around, into, towards, etc. the 
electronics shop is across the street. the cricketers went in that direction.

•	 Prepositions indicating other relationships: by, with, of, for, etc. this sari is made of silk. 
A surprise is waiting for you.

ASSeSSmeNT

i. Fill in the blank with the correct preposition given in the bracket:

1.	 Go	straight	down	Kingsway	Street	and	you	will	find	the	shop	____________	your	right	(in,	
on).

2. the jeweler’s store is right next ____________ the bus-stop (for, to).

3.	 The	florist’s	stall	is	____________	Kamna’s	house	(below,	under).

4.	 You	can	find	her	house	____________	the	corner	of	the	main	street.	(around,	from)
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5.	 Walk	____________	you	reach	the	traffic	point	(till,	before).

6. the book store is just ____________ the street (across, under).

7.	 Walk	straight	____________this	road	and	you	will	come	to	a	traffic	point	(down,	beside).

ii. Fill in the blank with the correct preposition given in the bracket:

1. i’m very excited about meeting my friend today __________________ Dilli Haat in the 
evening at 4.

 (a) on             (b) at

2. My friend stays in inA colony near Dilli Haat, whereas my house is quite far __________ it.

 (a) across      (b) from

3. in the morning, my friend had given me the directions ____________ this place over the 
phone.

 (a) to              (b) about

4. i will take Bus no. 540 ____________ the Central terminal and get off the inA bus stand.

 (a) from, in     (b) from, at

5. My friend had said that Dilli Haat is right ____________ the road.

 (a) across      (b) over

6. She will be waiting for me ____________ the Sikkim food stall.

 (a) on             (b) at

7. the Sikkim food stall is located ____________ the Manipur and Rajasthan food stalls.

 (a) across      (b) between

8. the hot momos served there are so tasty - i can’t wait ____________ eat them!

 (a) for             (b) to

9. Oh! i think that’s my bus ____________ that red truck.

 (a) behind      (b) over

10. i must hurry up and get ____________ it or my plans for a great evening will be spoilt.

 (a) onto          (b) in
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SeSSioN 8: DeSCriBiNg AN eVeNT

relevant Knowledge

Have you attended any event recently? it may be a wedding, a birthday party, or any function - 
any event. try and form sentences about the event. Maybe answering the following questions 
might help you:

1. When was the event held?

2. Where was it held?

3. How many people came?

4. How was the food (if it was a party)?

5. Were there any special programs? if so, what were they?

Present Continuous Tense

the Present Continuous tense is used to describe an action that is continuing at the moment.

1. i am walking.

2. She is preparing lunch for everyone.

The	verb	will	always	take	the	form	“is/am/are+verb+ing”	depending	upon	the	subject.

1. He/she/it/Meena/Rajan is walking.

2. they/we/you/the people are walking.

3. i am walking.

read the following:

1. i describe an event. i am describing an event.

2. She/he/Reena/Karan/etc. describes an event. She/he/Reena/Karan/etc. is describing an 
event.

3. You/we/they/the students/etc. describe an event. You/we/they/the students/etc. are 
describing an event.

The	sentences	with	 “is/am/are	describing”	as	verb	describe	an	action	 that	 is	continuing	at	 the	
moment. therefore,

1. We are learning the Present Continuous tense.

2. We are learning how to describe an event.

3. We are learning English.
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exerCiSe

i. read the following sentences and identify whether they are in the present continuous 
tense or not.

1. Everyone is enjoying Sarita’s party.

2. Sarita is distributing cold drinks to her guests.

3. Devjit wants to play his guitar and sing a song for her.

4. All the guests encouraging him to do that.

5. Even Sarita herself is telling him to perform.

ii. read the sentences on “Smita’s Birthday” given below.

1. it was Smita’s birthday ____________.

2. We arranged a surprise birthday  ____________.

3. All her friends____________.

4. ____________as it is her favourite.

5. Everyone arrived ____________.

6 ____________at 12 p.m.

7.	 We	screamed	“____________“!

8. then, she blew the candles and ____________.

9. Asha and Sumeet____________. 

10 ____________sang a song and entertained everyone.

11. We played Antakshari ____________.

III. Using the following phrases fill in the blanks and complete the sentences.

1.	 “Surprise”

2. ...were invited.

3. Smita entered the room...

4. ...cut it for everyone

5. Smita even...

6. ...party for her.

7. ...on time.

8. ...distributed food and drinks
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9. We got a chocolate cake...

10. ...on Sunday.

11. ...and dumb charade.

ASSeSSmeNT

Choose and the tick the correct option, which is in the Present Continuous Tense.

1. a. We are gone to attend a friend’s wedding at Sainik Farms on Saturday evening.

 b. We are going to attend a friend’s wedding at Sainik Farms on Saturday evening.

 c. We went to attend a friend’s wedding at Sainik Farms Saturday evening.

2. a. Everybody will having a great time at the party.

 b. Everybody is having a great time at the party.

 c. Everybody have a great time at the party.

3. a. the bride is looking gorgeous in a traditional red silk saree.

 b. the bride looking gorgeous in a traditional red silk saree.

 c. the bride will looking gorgeous in a traditional red silk saree.

4. a. the waiters serving delicious snacks and drinks.

 b. the waiters serves delicious snacks and drinks.

 c. the waiters are serving delicious snacks and drinks.

5. a. the DJ is playing soft music while the guests have their dinner.

 b. the DJ is playing soft music while the guests are having their dinner.

 c. the DJ plays soft music while the guests are having their dinner.

6. a. He is going to play some popular Bollywood numbers.

 b. He has some popular Bollywood numbers to play.

 c. He going to play some popular Bollywood numbers.

7.	 a.	 Some	kids	have	running	around	while	some	will	be	dancing	on	the	dance	floor.

	 b.	 Some	kids	are	running	around	while	some	are	dancing	on	the	dance	floor.

	 c.	 Some	kids	are	running	around	while	some	dancing	on	the	dance	floor.
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8. a. We are planning to drink coffee to stay awake through the night.

 b. We are planning to drink coffee to be staying awake through the night.

 c. We drink coffee to be staying awake through the night.

9. a. Pandit Ji reciting mantras and performing various rituals.

 b. Pandit Ji is going to reciting mantras and performing various rituals.

 c. Pandit Ji is reciting mantras and performing various rituals.

10.	 a.	 Everybody	is	showering	flowers	on	the	newlyweds.

	 b.	 Everybody	are	showering	flowers	on	the	newlyweds.

	 c.	 Everybody	showering	flowers	on	the	newlyweds.

SeSSioN 9: reCoUNTiNg AN exPerieNCe

relevant Knowledge

the purpose of a recount is to list and describe past events by retelling the events in the sequence 
in which they occurred. A recount tells about something that happened in the past. Hence it is 
written in the past tense. (e.g. i run - i ran, i go - i went). the details in the recount can include 
what happened, who was involved, where it took place, when it happened and why it occurred.

A writer or speaker uses a recount to tell us about a story or an event. Recounts are usually given 
in the order that the event occurred. Recounts can be:

•	 Factual,	such	as	a	news	story

•	 Procedural,	such	as	telling	someone	how	you	build	or	make	something

•	 Personal,	such	as	a	family	holiday	or	your	opinion	on	a	subject

examples of a recount include:

•	 Biographies	and	autobiographies

•	 Newspapers	or	the	television	news

•	 Letters	and	postcards

•	 Textbooks

•	 Conversations	with	friends
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A well-structured recount includes details of the event or topic and personal opinions. Oral (spoken) 
recounts may have a title if you are giving a presentation. However if you are simply talking with 
friends you wouldn’t announce the title of your conversation!

Past continuous tense

the Past Continuous tense describes an action that was happening at a time in the past. A verb 
in this tense will always take the form: Was/were + verb (+ing)

•	 I/she/he/it/Meena/Rajan/the	man	was walking.

•	 They/we/you/the	people	were walking.

•	 She	was working on her painting.

•	 He	was rehearsing for his performance.

Some examples of Past Continuous Tense are given below:

•	 i am walking - Present Continuous tense

•	 i was walking - Past Continuous tense

•	 She/he/it/Tina	is walking - Present Continuous tense

•	 She/he/it/Tina	was walking - Past Continuous tense

•	 We/they/the	people	are working - Present Continuous tense

•	 We/they/the	people	were working - Past Continuous tense

Can you tell the difference between the two tenses?

the Present Continuous tense describes an action that is happening presently while the Past 
Continuous tense describes an action that was happening at a time in the past.

A verb in the Past Continuous tense will take the form: 
Was/were + verb (+ing)

now, from the following sentences, identify the sentences in the Past Continuous tense.

1. i was going to tell you a story.

2. they told me they playing a game.

3. She is making breakfast.

4. We were planning to	visit	the	zoo.

5.	 The	zoo	was closed.

6. Celebrations were happening all over the world.
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exerCiSe

read the points given below, very carefully. Now, construct them into a paragraph:

•	 Taking	a	walk	in	the	park.

•	 Saw	some	people	playing	badminton.

•	 Sat	down	and	watched.

•	 Realized	one	of	the	players	was	an	old	classmate.

•	 Called	out	to	her.

•	 She	came	to	me.

•	 Told	me	she	was	my	classmate’s	twin.

•	 I	apologized.

•	 She	asked	me	to	join	their	game.

•	 I	agreed.

•	 Enjoyed	a	nice	round	of	badminton	with	them.

Read the phrases in “Trip to A mall”. Fill in the blanks with appropriate phrases.

•	 ...we	decided	to	go.

•	 I	told	him...

•	 ...for	our	lunch!

•	 Then	we	went	looking...

•	 ...if	I	had	any	plans	this	Saturday.

•	 ...the	food	court	had	not	been	built...

•	 ...in	the	mall.

•	 ...where	it	was	located...

•	 ...for	a	while.

•	 ...to	search	the	huge	mall.

•	 We	were	already	hungry...

My friend called me up and asked me ____________ . ____________ i was free. So __________ 

to the new mall. there were many good stores _________________.      We ___________________ 

window-shopped.	____________	for			the			food-court.	But			we			couldn’t			find	it.	____________	and	

we were forced _________________ ! At last, we asked ____________ a guard ____________ 
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and he told us that ____________ as yet. We ____________ came out of the mall and had to go 

to a dhaba ____________.

ASSeSSmeNT

Fill in the blanks with the past continuous form of the verbs given in brackets. The first two 
have been done for you.

1. i was visiting my childhood friend Venkat yesterday.

2. We were going to watch the movie Don on DVD.

3. We ______________ (see) the movie for the second time.

4. We ______________ (enjoy) the popcorns more than the movie.

5. in the evening, we ______________ (plan) to make a chocolate cake.

6. Both of us ______________ (go) to the market to buy vegetables for dinner.

7. We ______________ (driving) to the supermarket.

8. the supermarket ______________ (offer) sale on all stocks.

9. Everybody ______________ (move) towards the entrance at the same time.

SeSSioN 10: FiNDiNg A PLACe To STAY

relevant Knowledge

imagine that you have just moved into a new city and are looking for a place to stay. How they 
would go about doing it? You can use the following pointers:

•	 What	kind	of	place	do	you	want?

•	 What	would	you	require	in	a	room?

•	 Would	you	take	the	help	of	a	broker?

•	 Would	you	negotiate	the	rent?

make appropriate sentences

Given below is a list of terms you will encounter when you want to rent a residence. Read aloud 
the “renting Terms”, understand its meaning and usage:

1. Broker: One that acts as an agent for others in negotiation, bargain, etc.
 e.g. The broker helped me find a room at a reasonable price.
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2. rent: Payment made by a person for staying in a place owned by others. 
 e.g. I and my three friends are living on rent now.

3. Pg (Paying guest): Someone who lives on rent in the owner’s house. 
 e.g. PG accommodations are easily available these days.

4. Apartment:	A	flat	
 e.g. Sheila and Renu have rented a two-room apartment in Pune.

5. Landlord/landlady: A man/woman who provides rooms for rent. 
 e.g. Our landlady allows us to stay out till 10 p.m. only.

6. Tenant: A person who lives on rent. 
 e.g. Mr. Gupta’s tenants always pay their rent on time.

7. Single-room flat: A	flat	with	only	one	room.	
 e.g. As I am planning to stay alone, I will look for a single-room flat.

8. Double-room flat: flat	with	two	rooms.	
 e.g. As we are planning to stay together, we will look for a double-room flat.

9. Commission: A fee that you have to pay to an agent/broker for their services. 
 e.g. We also have to pay the broker his commission.

10. Security:	Money	given	as	guarantee	that	you	will	pay	rent	as	due.	Also	known	as	“deposit”.	
 e.g. We have to pay 2500 Rupees as security.

11. Notice: A formal announcement that you have to make if you want to move out/ask a tenant 
to leave. 

 e.g. The landlord has a simple rule - every tenant must give a month’s notice if they want 
their security back.

Read the dialogue section below on “Finding a Place to Stay”. this is a conversation/dialogue 
between a broker and his client. the client is looking for a room.

You	have	to	fill	in	the	blanks	by	forming	complete	questions	using	the	points	given	in	brackets.	
two of them have been done to help them understand.

exerCiSe

Client : i am looking for a place to stay.

Broker : Ok. Do you want a single room or double room? (Single room or double room)

Client : Since i am going to stay alone, i would prefer a single room.

Broker : __________________________________ ? (just a single room, or with kitchen)
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Client : i want a single room with attached bathroom plus a separate kitchen. Broker: You have 
come right on time. A room which has all these has just been vacated.

Client : __________________________________? (how much the rent is)

Broker : 4500 Rupees.

Client : ______________________________? (whether includes electricity bill and water bill)

Broker : Yes, yes. it includes both.

Client : Do i have to pay security? (whether i have to pay security) Broker: Yes. You have to 
pay a security of 2000 Rupees.

Client : __________________________________? (how much your fee is)

Broker : i charge only 25% of the rent.

Client : __________________________________? (whether fee is negotiable)

Broker : i am afraid it isn’t. it is quite low. Most brokers charge around 50%. Client: Ok then.

Broker : ________________________________? (whether you want to see the room now

Client : Yes.

Future continuous tense.

the Future tense describes an action that will be ongoing in the future. A verb in the future 
continuous tense will always take the form: 

“will+be+verb+ing”. For example:

•	 I	will be reporting on the news channel tonight.

•	 He	will be coming home at around 10.

•	 They	will be working hard to win the match.

•	 You	will be doing your homework.

We can understand the Future Continuous tense with the help of the following examples:

•	 We	are looking for a new room. (Present Continuous tense). We will be looking for a new 
room. (Future Continuous tense)

•	 I	am looking for a new room. (Present Continuous tense). i will be looking for a new room. 
(Future Continuous tense)

•	 She	is looking for a new room. (Present Continuous tense). She will be looking for a new 
room. (Future Continuous tense)
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While in the Present Continuous tense, we describe an action that is ongoing, in the Future 
Continuous tense, we describe an action that will be ongoing in the future. the verb will always 
take the form: will / will not + be + verb (ing)

now, read the following sentences and identify the sentences that are in the Future Continuous 
tense:

1. the rent will be 4,000 Rupees.

2. i will be hiring a broker to search for the room.

3. She will not be taking the	flat.

4. the landlord will not returning the security.

5. they will be staying in	a	double	room	flat.

ASSeSSmeNT

Change the following sentences to the Future Continuous Tense.

1. Shantanu helped me locate a good room.
 ________________________________________________________________ .

2. the landlord charged me too much.
 ________________________________________________________________ .

3. i was negotiating with him to lower the rent.
 ________________________________________________________________ .

4. i also asked the landlord if he would provide me a cooler.
 ________________________________________________________________ .

5. if not, i am buying the cooler myself.
 ________________________________________________________________ .

6. i am staying here till December.
 ________________________________________________________________ .

7. next year, i am moving to Mumbai.
 ________________________________________________________________ .

8. i contacted my broker Vijay.
 ________________________________________________________________ .

9. Vijay is searching	for	a	two-room	flat	for	me.
 ________________________________________________________________ .

10. i reminded	him	that	the	flat	should	have	a	separate	kitchen.
 ________________________________________________________________ .
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SeSSioN 11: SAYiNg No

relevant Knowledge

Sometimes, in our lives, situations arise where you have to politely decline a person’s offer. this 
can	be	difficult;	especially	when	you	care	about	the	other	person.

Some	people	might	say	“Yes”	when	they	actually	mean	“No”.	As	a	result,	they	feel	bitterness	and	
anger	 towards	 the	person	 they	have	said	 “Yes”	 to,	even	 though	 the	person	has	done	nothing	
wrong.	People	who	cannot	say	“No”	often	become	annoyed	and	upset	with	 themselves	and	 if	
anyone continues this behavior for a long time, it affects their self-esteem and adds to stress. 
On	the	other	hand,	some	people	might	say	“No”	but,	in	an	impolite,	disrespectful	and	aggressive	
manner. this may result in others disliking them for being angry and rude. So what’s the way 
out?

How would you say “No” to the following?

1. A friend invites you to a party but you have to refuse.

2. A friend wants to borrow a book but you have to refuse.

3. A friend wants to go shopping with you but you have to refuse.

Think about it!

read aloud the following phrases (polite ways of refusing):

1. I am sorry but - i am sorry but i won’t be able to come.

2. Thanks for the offer but - thanks for the offer but i won’t be able to come.

3. I will have to say no - i really want to come but i will have to say no.

4. This is very kind of you. However... - this is very kind of you. However, i won’t be able to 
come.

5. I would love to...but can’t because of prior engagement - i would love to come but can’t 
because of prior engagement.

read aloud the following phrases

•	 You	can’t	work	against the law.

•	 I	can’t	abide	by the law if it is not fair.

•	 I	am	working	at the warehouse.

•	 You	are	working	for the manager.
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exerCiSe

Study	 the	 following	 situations	 in	 “Saying	No”.	Choose	what	would	 be	 the	 appropriate	way	 of	
saying no in each situation. Some situations may have more than one appropriate option. Fill in 
the blanks with the appropriate option(s).

Situation 1

Speaker 1: Can i borrow some money?

Speaker 2:___________________________________________________ .

(a) no, you cannot.

(b) i am sorry but i won’t be able to lend you.

(c) i am sorry but you can’t borrow right now.

Situation 2

Speaker 1: i am going to my aunt’s house. Would you like to come?

Speaker 2:___________________________________________________.

(a) i won’t be able to come, but thanks for the offer.

(b) i am sorry but i won’t be able to come.

(c) i am sorry but i won’t like to come at all.

Situation 3

Speaker 1: there is a party at my place on Friday. You have to come.

Speaker 2:___________________________________________________.

(a) thanks. But i can’t come as i have a prior engagement.

(b) Sounds great! But, no! i am not coming.

(c) i am sorry. i will not be able to make it. But thanks for the invitation.

Situation 4

Speaker 1: it is quite late now. Why don’t you stay at our place tonight?

Speaker 2:___________________________________________________.

(a) this is very kind of you. However, i can’t stay.

(b) thanks! But i really have to get back home.

(c) thanks a lot. But i can’t stay at your place tonight.
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Situation 5
Speaker 1: Would you like to join us for a drink?

Speaker 2:___________________________________________________.

(a) thanks! But i will have to say no.

(b) Sounds fun! But, no! i can’t join you.

(c) A drink? no. not now.

ASSeSSmeNT

i. Fill in the blanks using the correct preposition given in the bracket:

1. they invited me _______________ their party, but i had refuse (to, for)

2. they said they will meet _______________ 3 sharp. (in, at)

3. But i have to meet my grandparents _______________ Monday. (at, on)

4. So, i said no. _______________ now, i have never refused them. (till, before)

5. they were a little disappointed _______________ me. (on, with)

6. But i haven’t met my grandparents _______________ a long time. (for, from)

7. i haven’t seen them _______________ last July. (since, from)

ii. Fill in the blanks using the correct preposition given in the bracket:  
    with against for from by on at

1. Vikrant keeps borrowing money _______________me. the next time he asks me, i will say, 
“I	am	sorry,	Vikrant.	I	can’t	lend	you	anymore.”

2.	 My	 friends	wanted	 to	share	a	drink	_______________	me.	But	 I	 refused	saying	 “Thanks	
_______________	the	offer.	But	I	will	have	to	say	no.”

3.	 My	boss	makes	me	get	tea	_______________	him	every	day.	So,	yesterday,	I	finally	said	“I	
am	sorry,	Sir.	I	have	got	work	to	finish.”	At	that	moment,	I	really	did	not	care	if	it	would	have	
any effect _______________ my job.

4. My grandfather wants me to get up at 4 every morning and jog for an hour. i had to politely 
refuse	_______________	saying,	“Great	idea!	I	will	try	that	some	day.	Thank	you.”

5.	 Leena	asked	Rajul	to	do	her	homework	again.	It	seems	Rajul	replied,	“I	am	not	going	to	do	
whatever	you	ask	me	to.”	And	now,	they	are	not	talking	_______________	each	other.

6. the opposition candidate wanted the people to vote _______________ the ruling party, but 
they shouted _______________ him and told him to go back.

7. though it was raining hard yesterday, my tutor wanted me to buy a book _______________the 
market.	I	said,	“I	am	sorry,	Sir.	But	the	weather	is	really	bad.	Can	I	buy	the	book	tomorrow?”
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SeSSioN 12: DeSCriBiNg A LoST iTem

relevant Knowledge

Describing a lost item is a simple matter of stating the features of the item that may help in 
identifying it. For example to describe a book you have lost, you could describe its following 
attributes:

•	 Name	of	book

•	 Author’s	name

•	 Size	of	book

•	 Description	of	cover

•	 Publishers’	name

there are some words that are used to express the quantity of things that can be counted and 
some words that are used to express the quantity of things that cannot be counted. Study the 
following table:

For Countable Nouns For Uncountable Nouns For Both

Many Much Some

A few, few A little, little Any

Several A bit of All of the/most of the

A couple of A good/great deal of A lot of/lots of

none of the Plenty of

Some more examples are:

•	 Their	family	has	a lot of influence	over	the	local	government.

•	 I	bought	a lot of children’s books for my son.

•	 Some people don’t agree with the new bill.

•	 There	was	much disagreement over the new bill.

exerCiSe

Now,	read	the	details	given	below	and	fill	in	the	blanks	using	the	information	given:

•	 A	mobile	phone

•	 Nokia	0010
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•	 Black	color

•	 Lost	while	traveling	in	a	train

•	 15th May, 2009, 2:00 p.m. to 9:30 p.m.

•	 Train	from	Allahabad	to	Delhi

•	 Shiv	Ganga	Express

•	 Compartment	no.	S	14,	Berth	28,	Sleeper	Class

Policeman : Yes, may i help you?

Complainant : i lost _____________________ .

Policeman : Where?

Complainant : i was traveling from____________________to ___________________ .

Policeman : Which train was it?

Complainant : _____________________ .

Policeman : When was the journey taken?

Complainant : _____________________.

Policeman : What time approximately?

Complainant : _____________________.

Policeman : Where was your seat?

Complainant : _____________________

Policeman : Please describe the phone.

Complainant : it is a_____________________. the colour is_____________________.

Policeman : Okay.

ASSeSSmeNT

I. Choose the correct quantifier from the given choices and fill in the blank:

1. i lost ____________ books when i stayed at the hostel (several, much)

2. Hema asked ____________ students if they had seen her new leather wallet (some, a 
little)

3.	 The	warden	confirmed	 that	____________	 thefts	had	occurred	 in	 the	hostel,	 so	she	had	
every room checked (a few, any)

4. ____________ students, including Hema, put up posters describing the items that they had 
lost (A lot of, much)
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5. Finally, ____________ of the lost items were found in Hema’s room - she had nerve to 
pretend that her wallet too had been stolen! (much, many)

II. Fill in the blanks with the correct quantifier from the options given below:

1.	 I	was	having	____________	fun	with	my	family	at	the	airport	until	I	realized	that	two	of	my	
bags were missing.

 (a) a lots of (b) many (c) a lot of

2. the black bag contained ____________ valuable things that i had bought for my sister’s 
wedding.

 (a) many (b) more (c) much

3. it contained a diamond pendant, ____________ gold bangles, a diamond ring, etc.

 (a) a few (b) enough (c) a little

4. it also had silver jewellery.

 (a) many (b) a few (c) some

5. the brown bag had ____________ important documents such as my passport, pan card, 
driving license, etc.

 (a) many (b) more (c) much

6. the bag also contained clothes, ____________ silver coins, and a silver key.

 (a) enough (b) a few (c) a lot

7. though the black bag contained ____________ expensive items, its loss does not bother me 
as much as the loss of the brown bag does.

 (a) little (b) a little (c) plenty of

8.	 It	 is	more	 important	 to	 find	 the	 brown	 bag	 because	 it	 contains	 ____________	 important	
documents.

 (a) much (b) very (c) some

9. i do not have ____________ hope of getting back my bag. Still, i am going to lodge an FiR 
at the police station.

 (a) little (b) much (c) few

10. i will also post an advertisement about my bag in the ‘Lost and Found’ section of ____________ 
newspapers.

 (a) more (b) little (c) some
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SeSSioN 13: APPreCiATiNg SomeoNe

relevant Knowledge

How would you feel if someone you knew very well and you had helped comes up and says to you 
“Someday	I	hope	to	give	to	you	a	fraction	of	all	you’ve	given	me”?	For	employers	and	employees,	
businessmen and clients, family members close friends and associates, expressing appreciation 
for everything a person means to you is absolutely necessary. it lifts your heart and makes the day 
to	day	stresses	that	you	face	more	manageable.	Take	the	time	today	to	tell	someone	“I	appreciate	
you.”	To	do	so,	you	need	to	know	how	to	appreciate	and	that’s	what	you	will	learn	today.

Look at the following situation: A friend of yours has done a favor for you now, how would you 
express your appreciation for your friend? think about it.

We generally show our appreciation when:

1. Someone has done something for which they are grateful or thankful

2. Someone has done something praise-worthy.

therefore, appreciation may be shown not only when someone has done you a favor but also 
when a person has done something good or admirable.

Read the details given below:

“Appreciating Someone 1”
1. When someone has done you a favor:

•	 Thanks	a	lot!

•	 Thanks!	You	are	a	life-saver.

•	 Thanks!	I	really	appreciate	it.

•	 Thanks!	You	really	made	my	day.

2. When someone (e.g. a junior at work) has done his job well:

•	 Great	job!

•	 Well	done!

•	 Nice	work!

•	 Good	work!	Keep	it	up.

•	 You	did	very	well!

•	 Keep	up	the	good	work.

•	 I	appreciate	your	effort.
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3. When someone (e.g. a singer/dancer) has performed well:

•	 That	was	a	great/an	excellent/an	outstanding	performance!

•	 You	performed	very	well!

•	 I	enjoyed	your	performance.

4. When someone shows concern and support:

•	 I	appreciate	your	concern.

•	 Thank	you	for	your	concern.

•	 Thanks	for	the	support.	I	really	need	it.

•	 Thanks	for	standing	by	me.

5. Appreciating someone close to you (parents, friends, etc.):

•	 You	are	a	wonderful/an	amazing	person!

•	 Thank	you	for	being	who	you	are.

exerCiSe

Study the situations described here. Fill the blanks with how you would express your appreciation 
in the given situations. You can use the phrases and sentences you learnt earlier.

Situation 1: You want to buy a book but do not have enough money. Your friend lends it to you.

Situation 2: Your junior at work used to perform badly. Lately, his performance has improved.

Situation 3: it is Mother’s Day and you have bought a card for your mother. You want to write a 
line showing your appreciation.

Situation 4: Your younger brother has come top of his class.

Situation 5: You	are	organizing	a	campaign	for	the	adoption	of	stray	dogs.	A	man	donates	an	
amount (huge/small) for the cause.

ASSeSSmeNT

i. Fill in the blanks using the correct option given in the bracket:

1. You did me a ________________ favor (great, large)

2. i am so ________________ that you won! (happy, cheerful).

3. You are looking ________________ tonight (wonderful, brilliant)

4. You did a ________________ thing by helping that poor boy. (well, good)
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5. We thank you for being so ________________ (kind, gentle)

6. that was a ________________ performance! (fantasy, fantastic)

7. Your generosity is appreciated by ________________ (many, much)

8. You are doing your job________________ well (very, vary).

II. Choose the right word from the bracket to fill in the blanks:

1. Rama presented the show really well. i think she is very________________ (arrogant, 
confident).

2. Sheela is very ________________ (patient, lenient) while talking to clients. She tries to 
understand them.

3.	 I	 wonder	 how	 Nilanjana	 can	 be	 so	 ________________	 (relaxed,	 lazy)	 before	 any	 team	
meeting.

4.	 Priya	 is	 extremely	 ________________	 (dignified,	 grand),	 and	 that	 makes	 her	 the	 team	
favorite.

5. i like the fact that Ram is ________________ (inquiring, nosy), that way he gets his doubts 
cleared.

6. Raj spends his money ________________ (with a lot of care, like a miser), so he has no 
major debts.

7. it was because of Ram’s ________________ (hard work, overwork) that we got a new 
deal.

8. Raj uses ________________ (old-fashioned, outdated) ways to solve problems because he 
feels that it always works.

9. Ravi is always ________________ (up-to-date, modern) with his work.

SeSSioN 14: ATTeNDiNg A PHoNe CALL

relevant Knowledge
How do you answer the phone when it rings? this session is about taking phone calls, and 
that you will begin the lesson with a role play on the situation. now read aloud the following 
conversations:

role Play 1

Student 1 : Hello?

Student 2 : Hello!
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Student 1 : is this (name) speaking?

Student 2 : this is (name) speaking.

Student 1 : i am (student’s name). is this a good time to talk?

Student 2 : Ok. What is it about?

Student 1 : i am from Public Surveys. We would like to inquire if you are a regular user of the   
  internet.

Student 2 : Yes, i am.

Student 1 : that’s all. thank you for your co-operation. Have a nice day.

role Play 2

Student 1 : Hello? 

Student 2 : Hello!

Student 1 : is this (your name) speaking?

Student 2 : this is (your name) speaking. 

Student 1 : i am (student’s name). is this a good time to talk? 

Student 2 : no. i am afraid i am a little busy at the moment. 

Student 1 : Can i call you later? 

Student 2 : Ok.

Student 1 : thank you for your time. Have a nice day! 

Read the details below:

making a phone call 

Asking for the person you want to talk to:

•	 May	I	speak	to	(name	of	the	person)?

•	 Is	(name	of	the	person)	there?

•	 Am	I	speaking	to	(name	of	the	person)?
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Identifying yourself:

•	 I	am	(your	name).

•	 My	name	is	(your	name).

•	 I	am	(your	name)	from	(company	or	organization	on	whose	behalf	you	are	calling).

•	 My	name	is	(your	name).	I	am	calling	from	(company	or	organization	on	whose	behalf	you	
are calling).

Asking if the call-recipient is free to talk:

•	 Is	this	a	good	time	to	talk?

•	 Are	you	free	to	talk?

When the person you want to talk to is not in:

•	 I	would	like	to	leave	a	message.

•	 Could	you	take	a	message	for	him/her?

•	 I	will	call	later/	I	will	call	after	some	time.

While hanging up:

•	 Thank	you	for	your	time.	Have	a	nice	day!

•	 Thank	you.	Have	a	nice	day!

receiving a phone call

When the caller asks for you:

•	 This	is	(your	name)	speaking.

•	 You	are	speaking	to	(your	name).

When the caller asks for someone who is not in/cannot come to the phone:

•	 I	am	afraid	he/she	is	not	in	at	the	moment	Or He/she cannot come to the phone right now.

•	 Would	you	like	to	leave	message?	Or Can i take a message?

•	 Could	you	call	after	some	time?	Or Could you call later?

When the caller asks you if you are free to talk:

•	 Sure!	What	is	this	about?

•	 I	am	sorry.	I	am	a	little	busy	at	the	moment.

While hanging up:

•	 Thanks	for	calling.
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Study	the	details	below	and	fill	in	the	blanks:

1. “Attending to Phone Calls 1”
receiver : Hello?

Caller : Hello. _____________ (receiver’s name)?

receiver : this is (receiver’s name) speaking.

Caller : (receiver’s name),___________ (caller’s name) ___________ Life Care insurance.

receiver : Ok.

Caller : ____________________________________ ?

receiver : Sure, we can talk.

Caller : Are you availing any life insurance policy?

receiver : _____________ .

Caller : Ok. Would you like to buy another policy?

receiver : no, thanks.

Caller : Ok, Sir/Ma’am.______________________________.

2. “Attending to Phone Calls 2”

receiver : Hello?

Caller : Hello.  _____ (name)?

receiver : i am sorry. He/she is not in right now.

Caller : Oh!

receiver : _____ ?

Caller : Yes. _____ him/her that Rajeev Kumar called?

receiver : Ok.

Caller : _____ .

receiver : no problem. Anything else?

Caller : no, that’s all.

read the following examples:

•	 I	eat ice-cream daily - Simple Present Tense

•	 I	am eating ice-cream - Present Continuous Tense

•	 I	have eaten ice-cream - Present Perfect Tense
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In	the	first	example,	the	person	is	saying	that	he	eats	ice-cream	generally.	In	the	second,	he	is	
eating ice-cream right now. in the third, he ate ice-cream in the recent past.

the Present Perfect tense is thus used to describe an action which occurred recently.

it also used to describe an action which started in the past and is still continuing. For example:

•	 I	have worked here for 5 years.

•	 She	has lived there for 2 years.

Verbs in the Present Perfect Tense will take the following form:

•	 I/you	+	have	+	perfect	form	of	the	verb

•	 It/she/he/Reena/Akash	+	has	+perfect	form	of	the	verb

•	 We/they/the	people/the	sisters	+	have	+	perfect	form	of	the	verb.

read this before you attempt the exercise:

Present Perfect Tense is used to describe an action which occurred recently.

•	 I	have read the essay.

•	 She	has taken breakfast.

it also used to describe an action which started in the past and is still continuing. For example:

•	 I	have worked here for 5 years.

•	 She	has lived there for 2 years.

•	 Verbs	in	the	Present	Perfect	Tense	will	take	the	following	form:

•	 I/you	+	have + perfect form of the verb

•	 It/she/he/Reena/Akash	+ has +perfect form of the verb

•	 We/they/the	people/the	sisters	+ have + perfect form of the verb.

exerCiSe

identify the sentences in the Present Perfect Tense.

1. She has done her job well.

2. i have	a	file	here.

3. they have been upset.
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4. You have won the competition.

5. the man has a lot to say.

ASSeSSmeNT

I. Change the verbs in brackets to Present Perfect Tense and fill in the blanks:

two examples are given below.

•	 I	have driven a car.

•	 She	has driven a car.

A: Hello! My name is Akanksha from ABC Consultants. May i speak to Ms Kavya, please?

B: Kavya _______________ (leave) the	office.	May	I	take	a	message?

A: Well, our company _______________ (plan) a camp at Siri Fort this Saturday. Would she be 
interested in attending it?

B: Sure! in fact, i would also be interested. We _______________ (attend) such camps before. 
We found them useful.

A: that’s good. Can you give me your name and contact number as well?

B: My name is Manisha and my contact number is 9987654321. Some of my other friends 
_______________ (volunteer) at such camps before. Would you like me to ask them to come 
along?

A: that’s great! You can ask them to call me on the same number if they need more information 
in this regard.

B: Ok. i will tell Kavya you called. Bye!

A: Bye

SeSSioN 15: giViNg iNSTrUCTioNS

relevant Knowledge

Sentences that express an instruction are formed as an order or a direct command. it is always 
in the Simple Present tense. 

For example:

1. tell us your name - instruction.
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2. What is your name? not an instruction.

3. Sit on the last bench - instruction.

4. i am asking you to sit on the last bench - not an instruction.

5. Write down today’s date on the board - instruction.

6. You are writing down today’s date on the board - not an instruction.

Sentences expressing simple instructions begin with the main verb - tell, sit and write. the subject 
of	such	sentences	is	“you”	but	it	is	generally	omitted.

read the following words:

1. First

2. then

3. next

4. After that

5. this should be followed by

6. Finally

these words are commonly used while giving a series of instructions. Let’s, read the following 
example to understand the concept:

How to make an omelette

“First,	heat	oil	on	a	pan.	Beat	the	eggs	in	a	bowl	and	add	salt.	Fry	chopped	onions	and	green	
chili as soon as the oil is hot enough. then, pour the beaten egg on the pan. Wait till the eggs get 
properly	cooked	on	one	side.	Finally,	turn	the	eggs	over	on	the	other	side	with	the	help	of	a	flat	
spoon.	Cook	for	2	minutes.”

Your	facilitator	will	show	you	the	“Letter	Format”	Chart.	It	will	have	the	following	on	it:

Sender’s address                                           Date: 

Recipient’s name 

Recipient’s address

Salutation	{should	be	“Dear	(name	of	recipient)”}

Body of letter (main part of the letter)

Yours sincerely,

name of sender
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Attempt to write down a step-by-step set of instructions on how to write a letter.

Prepositions

•	 We	are	sitting	in	the	dining	room.

•	 We	are	inside	the	house.

•	 Put	the	mug	inside	the	cardboard	box.

•	 Pour	some	coffee	into	the	mug.

•	 We	sprinkled	water	on	his	head	to	wake	him	up.

exerCiSe

Choose the appropriate preposition:

1. Come to the shop ______________ 5 p.m. (at, in)

2. Finish the homework ______________ 15 minutes. (at, in)

3. turn this fan ______________. (of, off)

4. Walk ______________ a straight line. (in, with)

5. Get a kilo of sugar ______________ the grocery. (at, from)

6. Stand ______________ that chair and see if you can reach the shelf. (on, above)

7. take these vegetables ______________ the kitchen. (to, into)

8. Do not smoke ______________ this area. (in, around)

ASSeSSmeNT

Fill in the blanks with the correct options.

1.	 Do	not	honk	unnecessarily	_______________	traffic	signals.

 (a) at (b) from (c) under

2. Do not stand _______________ the glass door.

 (a) like (b) during    (c) near

3.	 The	 manager	 has	 given	 a	 new	 set	 of	 instructions	 _______________	 the	 staff	 on	 office	
attendance.

 (a) from (b) to (c) on
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4. As per the school rules, students will not be allowed to enter the school gates _______________ 
9:30 am.

 (a) during    (b) after (c) to

5. _________________ our stay at Khairi in Chamba, we were not allowed to go out in the 
evening without an armed guard.

 (a) During (b) Before    (c) After

6. tell the gate keeper to make sure that cigarettes or other tobacco products are not sold 
_______________ the school building.

 (a) near (b) on (c) through

7. Get me a cup of coffee and a sandwich _______________ the shop across the street.

 (a) for (b) of (c) from

8. You cannot park your car anywhere _______________ this building for security reasons.

 (a) from (b) around   (c) like

9. Park your car _______________ the parking lot behind that mall.

 (a) in (b) on (c) for

10. the shop is not far, it is just _______________ the road.

 (a) across (b) on (c) at

SeSSioN 16: regiSTeriNg A ComPLAiNT

relevant Knowledge

What would be your response to the following situation?

“Your	neighbors	have	been	partying	for	the	last	three	nights.	They	play	loud	music	and	you	can’t	
sleep. You had requested them to keep the volume low but they haven’t done anything about it. 
So you went to the police and complained. A friend of yours does not know why you went to the 
police	station.	How	would	you	tell	her?”

Study the details given here.

“registering a Complaint - 1”
1. to register a complaint: to make a complaint before an authority.
 e.g. We registered a complaint to the Principal regarding the bad canteen food.
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2. to lodge a complaint: to make a complaint before an authority. 

 e.g. She lodged a complaint against her supervisor to the CEO.

3.	 To	file	a	complaint:	To	make	a	complaint	before	an	authority.

 e.g. They are filing a complaint against their neighbors to the police.

4.	 To	press	charges:	To	make	an	official	complaint	in	a	court	of	law.

 e.g. The actor is pressing charges against the newspaper for printing rumors about her.

5. Object: to protest against something.

 e.g. We objected to the serving of alcohol at the camp site.

6. Protest: Complain.

 e.g. The students are planning to protest against the teachers.

the Past Perfect tense is used to describe an action which occurred before another action in the 
past.

Verbs in the Past Perfect Tense will take the following form:

I/you/It/she/he/we/they/the	people/the	sisters	+	had	+	past	participle	form	of	the	verb.

read the following examples:

•	 I	did my homework - Simple Past Tense

•	 I	went out to play - Simple Past Tense

•	 I	went	out	to	play	as	I	had done my homework - Past Perfect Tense

exAmPLeS

1. i went out to play as i had done my homework.

2. they had already left by the time we reached the place.

3. i had had my breakfast before the alarm woke you.

identify which sentence belongs to the Past Perfect Tense.

1. i had my dinner.

2. i had had my lunch.

3. He had gone to Paris.

4. Have you understood the theory?

5. i had understood the theory.

6. the dog had gone away somewhere.
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7. it had been abandoned.

8. it had a collar on its neck

exerCiSe

Rearrange the sentences to form a conversation between A and B.	The	first	two	have	been	done	
for you.

•	 Because	the	canteen	owner	allows	them	to	smoke.

•	 They	should	smoke	somewhere	else	as	it	harms	non-smokers	too.

•	 So	the	problem	is	with	him!

•	 Then	why	at	the	canteen?

•	 Too	many	people	at	our	college	smoke	in	the	canteen.

•	 Alright!

•	 Actually,	they	don’t	smoke	anywhere	else	because	of	the	signs.

•	 That’s	true.

•	 Who	else?	Let	us	write	a	 letter	stating	our	 formal	complaint	and	drop	 it	 in	 the	“Complaint	
Box”.

•	 Exactly!	Why	should	they	make	us	unhealthy	too?

•	 To	the	Principal?

•	 But	how	do	we	make	them	stop	smoking	at	the	canteen?

•	 I	think	we	should	lodge	a	complaint	against	him.

•	 Hmmm...those	No Smoking signboards at the gate are not helping much.

•	 Yes.	What	do	we	do?

A: too many people at our college smoke in the canteen. 

B: that’s true.

A: _________________________________________________________

B: _________________________________________________________

A: _________________________________________________________

B: _________________________________________________________

A: _________________________________________________________

B: _________________________________________________________
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A: _________________________________________________________

B: _________________________________________________________

A: _________________________________________________________

B: _________________________________________________________

A: _________________________________________________________

B: _________________________________________________________

A: _________________________________________________________

ASSeSSmeNT

Change	the	verbs	in	brackets	to	Past	Perfect	Tense	and	fill	in	the	blanks.	An	example	is	given	
below to help you understand this tense.

Simple Past tense: i did my homework.

Past Perfect tense: i had done my homework.

1.   Rahul __________________ (lose) cell phone on his way to Delhi from Lucknow. He 

__________________	(travel)	in	the	first	class	of	the	Lucknow	Shatabdi.	He	had	no	idea	how	

to	get	his	cell	phone	back.	He	knew	he	had	to	lodge	an	FIR	first.	He	knew	he	would	have	to	

go to the police station but he was not   sure if he would go. He _____________ (hear) stories 

of how taking the help of the police took a lot of time and effort.. then he remembered what 

his friend _________________ (tell) him. if his phone was used for some bad purposes, he 

would have to take responsibility for it. So, Rahul decided it was better to go and deal with 

the police than end up in some problem later on.

2.	 I	_________________	(drop)	a	complaint	in	the	complaint-box	about	the	lazy	watchman	as	

many people _________________ (complain) against him.

3.	 Shilpa_________________	(file)	an	FIR	as	soon	as	she	found	out	about	the	theft.

4. We_________________ (protest) against the use of animal fur in fashion.

5. they_________________ (object) to the use of animal fur in fashion.
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SeSSioN 17: CALLiNg UP To FiND ABoUT A JoB VACANCY

relevant Knowledge

Making calls to inquire about vacancies is a skill you need to acquire, as, sometimes in real life 
you	may	need	to	call	up	and	find	out	about	job	vacancies.

Read the following phrases and sentences:

1. i saw your advertisement in the newspaper...

2. i am calling with reference to your advertisement in...

3.	 Could	you	tell	me	if	there	is	a	job	vacancy	in	your	organization?

4. Could you tell me if there is any vacancy for the post of...?

5. Do you have a vacancy for the post of...?

modals are helping verbs. they help to express the mood of the main verb.

the various modals are can, could, may, might, shall, should, will, and would. They have various 
uses:

•	 Asking for permission: may i come in? Can/Could i use your pen? Can i go?

•	 making a request: Can/Could you pass me the book? Will you be my partner?

•	 expressing obligation: You should do the work yourself. i shall be responsible for your                     
safety.

•	 expressing determination: i will	finish	the	project,	come	what	may.

•	 expressing ability: i can solve the riddle. We could jump over the bench when we were 
kids.

•	 expressing probability: i may be able to help you out. it might rain tomorrow.

•	 expressing willingness: i will meet you tomorrow.

exerCiSe

Read	the	jumbled	up	conversation	in	the	“Job	Vacancy”.	The	italicized	sentences	have	jumbled	
words. You need to rearrange the words in order to make meaningful sentences.

A: Hello!

B: Hello! JobBazaar this Consultancy is? _____________________________________

A: Yes. What can i do for you?

B: Your in Sunday’s I Times of India saw issue advertisement.
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A: Okay.

B: Is wanted to if find out I a vacancy job there.

A: Could you tell me what kind of a job you are looking for? 

B: i am a high-school English teacher.

 Looking for am I for a vacancy job same the post.

A: Okay. You would have to consult our agent for jobs in education. 

B: Do that I do how?

A:	 You	would	have	to	come	to	our	office	with	your	resume.	An appointment you like would now 
to make?

B: Sure.

A: Okay. Monday at 11 a.m.

B: Okay. I will be there. Thanks a lot!

ASSeSSmeNT

Fill in the blanks with the correct words from the given table: might, ought, have to, can, shall, 
may, should, could, would, will.

Kavita : Hello, this is Cure Pharmaceuticals. How ______________ i help you?

gargi : Hi Kavita. this is Gargi here. ______________ i speak to anyone from the HR 
department?

Kavita : Of course, ______________ i connect you to the HR manager?

gargi : that ______________ be great. thanks a lot.

Kavita : Please hold on for a minute. nilesh: nilesh speaking.

gargi : Hi nilesh, this is Gargi speaking. ______________ you tell me if you have any vacancy 
in your company?

Nilesh : We are a large company Gargi, which department ___________ you be interested in?

gargi : that _____________ be the HR department itself, as i have an MBA in HR from Amity.

Nilesh : MBA in HR from Amity? that  ______________ to be useful. Let me have a look...You’re 
in luck. ______________ you come down here tomorrow for an interview?

gargi : that ______________ be a problem. ______________ i come in day after?

Nilesh : Let me see...that ______________ be possible. Can you come by 9 am?

gargi :	 Yes	that’s	fine.	I	______________	be	there	by	9.	Thanks	a	lot.
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SeSSioN 18: WriTiNg A reSUme

relevant Knowledge

What is a resume and why spend time writing one? Resume writing is a crucial part of the job 
application process. if you rush a job application and send your resume without thinking it could 
damage	your	chances	of	finding	a	job.	Considering	the	current	economic	climate,	there	is	fierce	
competition in most industries so spending time to make your resume stand out from the rest is 
very worthwhile.

A resume - sometimes called a ‘Curriculum Vitae’ or ‘CV - is a summary of your skills, education 
and work experience. A good resume demonstrates how your skills and abilities match up with 
the requirements of a job.

Here are a few reasons why writing a good resume is very important:

•	 It	 promotes	 you!	A	 resume	 is	 a	 self-promotional	 document	 that	 presents	 you	 in	 the	 best	
possible light for the purpose of getting selected for a job interview.

•	 A	good	resume	will	compliment	your	cover	letter	writing	and	make	your	overall	application	
stronger.

•	 You	can	achieve	your	dream	job.	By	spending	time	perfecting	your	resume	you	stand	a	better	
chance of landing your dream job, especially if you include all relevant work experience.

•	 Networking	can	be	boosted	with	a	good	resume.	If	your	resume	stands	out	from	the	rest	an	
employer is more likely to speak to people in their industry about you.

•	 It	opens	up	referral	job	applications.	If	an	employer	likes	your	resume	but	doesn’t	have	any	
suitable vacancies they are likely to recommend you for other job openings.

Read the following list, and tick the ones you think should be included in a resume or Curriculum 
Vitae (CV).

1. Email address

2.	 Favorite	films	and	actors

3. nationality

4. Phone number

5. Computer skills

6. Gender

7. Address

8. Date of birth

9. the newspaper you subscribe to
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10. Marital Status

11. Awards and achievements

12. Place of birth

13. Your height and weight

14. Details of education

15. Skills and interests

16. Languages

17. the festivals you celebrate

18. Details of previous employments

19. Your religion

“CV Terms”: Study the terms given below.

1. Contact details: Your name, address, phone number, and email address

2. objective: A statement of what you intend to achieve and contribute through your service to 
the	organization.	E.g.,	To use my skill and work to the best of my ability for the development 
of the organization.

3. Personal information: You may include your gender, date of birth, place of birth, nationality, 
marital status, and languages known to you under this heading. Optional information includes 
spouse’s name and number of children.

4. Area of expertise: the work skills that you have

5. employment history:	This	states	your	work	history.	It	should	include	the	different	organizations	
where you were employed previously, the length of each employment, and the positions you 
held.

6. Educational qualification: Details of the education that you have received -details of 
degrees and training

7. Skills and interests: You can state here other skills and interests that you have

8. other enhancements/Awards and achievements: Any other achievement or work that you 
want to make special mention of

9. About me/Biography: this is an optional section where you give a short account of 
yourself.

Connectors and conjunctions

Connectors are words used to express relationship between ideas and combine paragraphs and 
sentences.	For	example:	but,	also,	however,	moreover,	firstly,	next,	then,	therefore,	in	brief,	still,	
for example, thus, of course, certainly, hence, at the same time, on the contrary, etc.
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Conjunctions are words used to connect phrases and words. For example: but, so, as, and, nor, 
yet, so, although, though, because, either...or, neither...nor, as soon as, and or.

Note: Conjunctions can also be used as connectors.

exerCiSe

Look at the format given below and develop your CV:

“CV Format”

name: 

Address: 

Email address: 

telephone number:

Objective:

Personal information

Date of birth: 

Place of birth: 

nationality: 

Marital status: 

Languages known: 

Employed: Yes/no

Area of expertise: E.g. Direct sales, customer help, and visual merchandizing.

Employment history (if any)

E.g. Worked as sales representative for SellWell for 2 years.

1. __________________________________________________________________________

2. __________________________________________________________________________

3. __________________________________________________________________________

Educational qualification

E.g. 1. HSC from Amravati High School (CBSE), Chandigarh, in 2003;
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2. Diploma course in Basic Computer Education from All, Chandigarh, in 2004

1. __________________________________________________________________________

2. __________________________________________________________________________

3. __________________________________________________________________________

Computer Skills 

1. __________________________________________________________________________

2. __________________________________________________________________________

Skills and interests
E.g. 1. Possess good communication skills 
       2. Reading books

1. __________________________________________________________________________

2. __________________________________________________________________________

3. __________________________________________________________________________

Awards and achievements

E.g.  1. Won “Sales Representative of the Year” Award at SellWell 

         2. Captain of the college cricket team for 2 years

1. __________________________________________________________________________

2. __________________________________________________________________________

3. __________________________________________________________________________

Fill in the details to make your own CV. Examples have been given to show how some information 
may	be	filled	in.

Note: there is a small difference between a resume and a curriculum vitae (CV) i.e., the length 
of the document. While a resume is brief and concise summary of your skills, experience and 
education - less than a page or two, a curriculum vitae is a longer (at least two page) and more 
detailed synopsis.

Covering Letter
improve the following covering letter by changing some sentence structures. the sentences that 
can be changed (or linked) have been underlined.
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to
the HR Manager 
Healthy Pharmaceuticals 
Healthpur 
Healthy Pradesh

Dear Madam,

i’m writing to you regarding sales positions at Healthy Pharmaceuticals. i’m also writing to you 
about marketing positions.

i’m a fresh graduate. i have a B.Com degree in marketing. i would like to work in a sector that 
improves our society. i want to improve people’s lives. i have a keen interest in working with a 
pharmaceutical company. i am interested in working with Healthy Pharmaceuticals.

Though	I	have	no	experience	in	sales	and	marketing	so	far,	I’m	confident	that	I	will	be	a	successful	
salesperson. i have good people skills. i am disciplined. i am a hard worker. Also, at my college i 
participated in many activities. i participated in awareness campaigns for youth.______________, 
i think i’m suited for a job that requires communicating with customers.

i hope you w’ll consider my job application positively. Please consider me for an interview.

Do you require any additional information? Please let me know.

Sincerely,

ASSeSSmeNT

Fill in the blanks with suitable connectors/conjunctions

1. i went to see her ____________ she wasn’t at home. (and, but)

2. it started raining ____________ we went out. (as soon as, because)

3. We came back ____________ she was not at home. (as, yet)

4. She was not at home ____________ we came back. (so, however)

5.	 ____________,	boil	the	water.	____________	add	the	sugar.	(First-then)	(Then-first)

6. _______ we missed her _______ she never received our message. (Either-or, neither-nor)

7.	 We	drove	 fast.	 ________	we	 could	 not	 reach	on	 time	____________	of	 the	 traffic	 jams.	
(However-because, Because-however)

8. He told you that he gave me the book?___________, the book is still with him. (thus, On the 
contrary)

9. i came to see you ___________ you are not well. (because, so)

10. ____________ i had messaged them, they still were not ready on time. (Although, And)
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SeSSioN 19: WriTiNg A CoVeriNg LeTTer

relevant Knowledge

A covering letter written by Mr. A of Arjun nagar in response to an advertisement placed by 
Welcome travels, Sarojini nagar is given below. there are four errors in the format and you have 
to spot them.

 Arjun nagar.
 Email: a@hotmail.com
 Ph no: 09891989198
Dated: 22 Dec, 2008

Subject: Application for the post of sales executive

 Welcome travels, 
 the HR Manager, 
 Sarojini nagar

Dear Sir,

With reference to your advertisement in times Ascent, dated 21 Dec, 2008, i wish to apply for the 
post under concern.

i have just graduated in Commerce (with Honours) from Delhi University. i am a dedicated 
individual who possesses good communication skills and i am eager to join your company.

My CV is enclosed herewith.

thanking you,

Mr. A.,
Yours faithfully.

Read the “Lines for Covering Letters” given below.

The lines with which a covering letter begins when it is written in response to a vacancy 
advertisement:

1) i am writing in response to your advertisement............. for the post of............

2) With reference to your advertisement in............ i wish to apply for the post of............

The lines written to show that you have the ability to handle the job:

1) i will be able to handle responsibilities well.

2) i have the skills that are required for the concerned job.
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The lines written before the last paragraph:

1)	 Please	find	attached	a	copy	of	my	resume.

2) My CV is enclosed herewith.

3) My resume is enclosed for your review.

The lines written in the last paragraph:

1) thank you for your consideration.

2) i would appreciate it if my application is considered for the post. 

The lines written in the last paragraph, following the lines given above:

1) Looking forward to your response.................

2) i look forward to hearing from you soon.

exerCiSe

read the details given below.

“Siddhesh Sharma’s Covering Letter”

Siddhesh Sharma’s contact details
•	 B-12,Manak	Chand	Basti,	Arjun	Nagar,	Delhi	-11003.
•	 Email:	siddhesh.sharma@gmail.com
•	 Phone:	09891223314

Contact details of recipient
•	 HR	Manager
•	 SellWell	Organization,	Maurice	Road,	Delhi	-	110007	

Subject: Application for the post of Sales Manager

Body of the letter (you have to rearrange the sentences):
•	 I	would	appreciate	it	if	my	application	is	considered	for	the	post.
•	 My	resume	is	enclosed	for	your	review.
•	 Thus,	I	have	the	skills	as	well	as	experience	required	for	the	concerned	job.
•	 I	also	have	a	MBA	in	Retail	from	AIBM,	Hyderabad.
•	 I	am	writing	in	response	to	your	advertisement	in	The	Times	of	India	for	the	post	of	Sales	

Manager.
•	 I	look	forward	to	hearing	from	you	soon.
•	 I	was	hired	by	GoShop,	a	reputed	supermarket	chain,	as	Sales	Manager	for	two	years.
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You have to write Siddhesh Sharma’s covering letter in the correct format. the details of the letter 
have been given. the sentences that make up the body of the letter have also been provided. 
However, you have to rearrange them so that they are presented in the correct order. the salutation 
and leave-taking have to be inserted by you.

reported speech

Let’s understand Reported Speech with the help of the following examples and explanations:

1.	 He	said,	“I	am	thirsty”	-	Direct Speech

2. He said he was thirsty - Reported Speech.

3.	 She	said,	“What	are	you	doing?”	-	Direct Speech.

4. She asked me what i was doing - Reported Speech.

5.	 They	said,	“We	have	won	the	match”	-	Direct Speech.

6. they said they had won the match - Reported Speech.

Reported speech (or indirect speech) is used to tell what people say or think. While changing a 
sentence from direct speech to reported speech, the verb will change into its past form.

For example:
•	 am/is	-	was
•	 are	-	were
•	 has/have	-	had
•	 do	-	did
•	 am	doing	-	was	doing
•	 have	done	-	had	done
•	 will	-	would
•	 can	-	could
•	 shall	-	should
•	 may	-	might

But these remain the same:
•	 had	-	had
•	 would	-	would
•	 could	-	could
•	 should	-	should
•	 might	-	might
•	 ought	to	-	ought	to
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other standard changes include:

•	 yesterday	-	previous	day/the	day	before

•	 this	-	that

•	 these	-	those

•	 now	-	then

•	 here	-	there

•	 tomorrow	-	the	following	day

•	 next	(day/week/etc.)	-	the	following	(day/week/etc.)

Note: the following remain the same: that - that, those - those, then - then, and there - there.

ASSeSSmeNT

read the following and identify the correct options:

1.	 Meena	said	to	me,	“I	can’t	go	tomorrow.”

 (a) Meena told me that she couldn’t go tomorrow.

 (b) Meena told me that she can’t go the following day.

 (c) Meena told me that she couldn’t go the following day.

2.	 I	asked,	“Why	aren’t	you	going	tomorrow?”

 (a) i asked Meena why she wasn’t going tomorrow.

 (b) i asked Meena why she were not going tomorrow.

 (c) i asked Meena why she wasn’t going the following day.

3.	 She	said,	“I	have	to	go	to	the	post	office	to	mail	a	covering	letter.”

	 (a)	 Meena	said	that	she	had	to	go	to	the	post	office	to	mail	a	covering	letter.

	 (b)	 Meena	said	that	she	will	go	to	the	post	office	to	mail	a	covering	letter.

	 (c)	 Meena	said	that	she	have	to	go	to	the	post	office	to	mail	a	covering	letter.

4.	 I	said,	“Can	I	go	with	you?”	

 (a) i asked if i could go with her.

 (b) i asked if i can go with her.

 (c) i said i could go with her.
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5.	 Meena	said,	“That	would	be	great!”

 (a) Meena told me that would be great. 

 (b) Meena told me this would be great.

 (c) Meena told me that will be great.

the following is a conversation between a boy and a girl. You have to turn the direct speech to 
reported	speech.	The	first	three	have	been	done	for	you.

1. Boy:	“I	have	never	written	a	covering	letter.”

 Reported speech: the boy said that he had never written a covering letter.

2. girl:	“Would	you	like	to	learn	how	to	write	one?”

 Reported speech: the girl asked him if he would like to learn how to write one.

3. Boy:	“Yes,	I	would	like	to	learn	to	write	one.”

 Reported speech: the boy replied that he would like to learn to write one.

4. Boy:	“Who	can	teach	me	how	to	write	a	covering	letter?”

 Reported speech:_______________________________________________________.

5. girl:	“I	have	written	a	lot	of	them	so	I	can	teach	you.”

 Reported speech:_______________________________________________________.

6. Boy:	“Are	there	a	lot	of	rules?”

 Reported speech:_______________________________________________________.

7. girl:	“Yes.	Even	something	like	writing	a	covering	letter	has	a	lot	of	rules.”

 Reported speech:_______________________________________________________.

8. girl:	“Often	people	write	these	letters	in	any	way	they	want.”

 Reported speech:_______________________________________________________.

9. Boy:	“Have	you	sent	any	covering	letter	recently?”

 Reported speech:_______________________________________________________.

10. girl:	“I	sent	one	to	a	company	just	yesterday.”

 Reported speech: _______________________________________________________ .
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SeSSioN 20: FACiNg AN iNTerVieW

relevant Knowledge

read carefully the “Common interview questions” given below:

1. Please introduce yourself/ Could you tell us a little about yourself?

 interviews usually start with this question. You have to introduce yourself by stating some 
basic personal information (Refer to session 6 of Level 1 textbook).

2. Why have you applied for this job?

 For this question, you may need to do some background research on the company. You may 
also add that the skills and experience you have makes you suitable for the job.

 For example: “I am interested in this job as I will get to work for a well-known and successful 
organization. I also believe that the skills and experience I have makes me suitable for the 
job.”

 OR “I am interested in this job because I like the work profile. I also believe that the skills and 
experience I have makes me suitable for the job.”

3. What are your key areas of expertise?

 For this question, you will state the skills that you have which are related to your job. For 
example, the key areas of expertise of a sales representative may be direct sales, customer 
help, visual merchandising, etc.

4. Why do you think you are suited for this job?

 For this question, you should talk about your qualities as well as skills that would make you 
suitable for the job.

 For example, a sales representative should have good communication skills as well as 
knowledge of current trends. if the candidate is experienced (i.e. not a fresher), then he must 
also talk about how the skills he has acquired from a previous job can contribute to the new 
one.

 For example: “I have been working as sales representative for a year and I am skilled in 
direct sales as well as marketing. Therefore, I can easily adapt myself to the new job.”

5. Why did you leave your last job?

 While answering this question, you should never give any negative comments about your 
previous	employers.	Instead	of	saying,	“I	was	not	happy	with	my	last	job	as	it	was	boring”	say	
“I	was	not	unhappy	with	my	last	job.	But	I	am	eager	to	take	on	more	challenges.”
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6. What are your career objectives?

	 While	answering	this	question,	talk	about	the	job	first	and	then	about	what	you	can	do	for	the	
company.	For	example,	“My	career	objectives	are	to	do	my	job	well	and	to	contribute	to	the	
overall	development	of	the	company.”

7. What are your salary expectations?

 if you are a fresher, then it is better to ask the interviewer the salary range of the position you 
have	applied	for.	For	example,	“As	this	is	my	first	job,	I	have	no	idea	of	the	salary	range	of	
this	position.	I	would	be	happy	with	your	decision.”

 if you have experience, then you must have already quoted your current income in your 
resume. it is safe to quote around 10-15% more than your current salary if you are applying 
for the same post. if you are applying for a higher post, you can quote 20-25% more. While 
negotiating, you must mention your skills and the advantage of your experience. 

	 For	example,	“I	am	already	earning	_____________	and	I	have	my	experience	and	skills.	
Therefore,	I	would	expect	a	salary	of_______________.”

8. Can you tell me what your strengths and weaknesses are?

 While discussing your strengths in an interview, focus on those skills which are related to 
the	job.	For	example,	“I	have	the	ability	to	work	well	in	a	team	and	to	communicate	well	with	
people.”

	 While	discussing	your	weaknesses,	do	not	mention	personal	ones,	such	as,	“I	have	a	short	
temper”	 or	 “I	 am	 very	 lazy”.	 Instead,	 talk	 about	 those	 weaknesses	 which	 can	 be	 easily	
overcome.	For	example,	“I	have	not	handled	such	a	big	team	before.	But	I	am	confident	that	
I	will	learn	on	the	job.”

exerCiSe

You need to imagine that you are having a conversation with your facilitator. He/she will say the 
answers and you have to frame the questions to them.

1. the train leaves at 10:20 a.m.

2. i am reading a book.

3. Yes, you can borrow the book.

4. no, i don’t think the train will be late today.

5. i know because i always take that train and it has never been late.

6. the interview went very well.

7. no, they said they will inform me of the outcome next week.



69information technology

Unit-1

ASSeSSmeNT

Choose the correct option and fill in the blank:

1. Nishi:__________ i come in, Ma’am? (may, might)

2. interviewer: Come in, come in. Have a seat. 

 nishi: thank you, Ma’am.

3. interviewer: it is nishi,__________? (is it, isn’t it)

 Nishi: Yes, Ma’am.

4. interviewer:__________are you? (where, how)

 Nishi:	I	am	fine,	thank	you.

5. interviewer: Ok.So tell us, nishi__________have you applied to SellWell?(why, how)

 Nishi:	SellWell	is	one	of	the	largest	supermarket	chains	in	India.	It	is	a	successful	organization	
that	has	been	popular	ever	since	it	started	five	years	ago.

6. interviewer:__________you have any experience as a sales executive? (do, did)

 Nishi: Yes, Ma’am. i have worked as sales executive at Shopper’s Haven for a year.

7. interviewer: that’s good. We take only experienced people here.__________departments 
were you in? (which, whose)

 Nishi:	I	worked	at	food	section	for	the	first	six	months	and	clothing	for	the	next	six	months.

8. interviewer:__________salary are you expecting? (what, how much)

 Nishi: My previous salary was 10,000 Rupees per month. So, i am expecting around 13, 000 
Rupees at SellWell.

9. interviewer: Okay. that is reasonable.__________will you be able to join?

 (when, where)

 Nishi: i can join this Monday.

10. interviewer: Great! We are one member short in our shoes and bags department.__________
you comfortable with this post? (have, are)

 Nishi: Yes, Ma’am.

11. interviewer: Good. __________there any question you would like to ask? (are, is)

 Nishi: no, Ma’am.
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SeSSioN 21: TAKiNg A TeLePHoNiC iNTerVieW

relevant Knowledge

read the statements below:

“Telephonic interview”
1. I am a little busy right now. Can we reschedule the interview?

•	 Used	when	the	interview	call	is	unexpected	and	you	are	not	prepared,	or	when	you	are	
busy in some work.

2. I am sorry. I will not be able to join on Monday as I have some urgent work. Is it okay if I join 
on Tuesday?

•	 Used	when	you	are	unable	to	join	work	on	the	day	that	the	caller/interviewer	suggests.

3. I was looking forward to your call.

•	 Used	when	the	interview	is	pre-scheduled.

4. I hope you can hear me ...

•	 Used	if	the	phone	line	is	not	clear.	Avoid	sentences	like	“Speak	louder!”	and	“I	can’t	hear	
you.”

5. When am I likely to hear from you?

•	 Used	while	hanging	up,	when	the	caller/interviewer	has	not	specified	when	he/she	is	going	
to call you back.

these are some standard lines that can be used during a telephonic interview. 

Note: The	questions	discussed	in	the	previous	session	under	the	“Common	Interview	Questions”	
are equally relevant to a telephonic interview.

You will again have a role play like in the last session, but this time, it will be a telephonic 
interview.

exerCiSe

identify the sentences in the Present Perfect Tense.

1. i have had my telephonic interview.

2. She had tried to call you.

3. Did you get selected?

4. She has told me that i can join on the 22nd.
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5. i haven’t received the call as yet.

6. i have been asked to bring all documents on the day i join.

7. i have read the contract and have agreed to sign.

8. i have had my dinner.

9. Have you done the job?

10. they have not come yet.

reLeVANT KNoWLeDge

Change the italicized sentences to present perfect tense.

Caller : Hello! this is Ranjita Mehta calling from SellWell. 

Sarthak : Hello.

Caller : May i speak to Mr. Sarthak Gupta?

Sarthak : this is Sarthak Gupta speaking.

Caller : i received the job application email that you sent me.

  (1) ____________________________________________.

Sarthak : Okay.

Caller : i just read your resume.

  (2) ____________________________________________ .

Sarthak : Ok.

Caller : i am pleased to inform you that we have a vacancy at the moment. 

Sarthak : that’s great news.

Caller : Sarthak, did you ever take a telephonic interviewer?

  (3) ____________________________________________.

Sarthak : no, i did not.

  (4) ____________________________________________.

Caller :	Well,	we	need	to	take	your	interview	this	way.	We	need	to	fill	in	the	vacancy	urgently.	

Sarthak : Okay then.

Caller : So, Sarthak. We need someone who can keep an account of the stocks. Are you doing 
anything similar to this?

  (5)____________________________________________.
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Sarthak : Yes, Ma’am. i was also in charge of the daily stock count apart from sales.

  (6)____________________________________________.

Caller : Okay. You will be doing something related to that. You will be placed in charge of 
receiving stocks, stacking shelves and daily stock count.

Sarthak : i am familiar with the work.

Caller : And Sarthak, did you ever read planograms?

  (7)____________________________________________.

Sarthak : Yes, i read them.

  (8)____________________________________________.

Caller : Good. this is all we require from you. When can you join us? 

Sarthak : i can join this coming Monday. 

Caller : Ok. What are your salary expectations?

Sarthak : i earned an annual income of 1,20,000 Rupees at my previous company. i would 
therefore like a higher pay.

Caller : Ok Sarthak. We are offering a monthly salary of 10, 500 Rupees presently. that is what 
we wrote informed at our website.

  (9)____________________________________________.

Sarthak : Yes, i am aware of that.

Caller : But on account of your experience and excellent resume, we decided to offer you 
13,500 Rupees. is that agreeable?

  (10)____________________________________________.

Sarthak : that sounds agreeable.

Caller : So Sarthak, can we expect you on Monday? 

Sarthak : Yes, i will be there. thanks for the opportunity.

SeSSioN 22: ACCePTiNg A JoB oFFer

relevant Knowledge

Writing a job acceptance letter when you have received a job offer is one of the best and most 
pleasurable things to do as it represents the culmination of all your efforts in searching for a new 
job.
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A job acceptance letter is a letter that you write to a company which has offered you a job. in such 
a letter, the following points are included in the given sequence:

•	 Written	acceptance	of	the	job	offer.

•	 The	terms	and	conditions	of	employment	(salary,	benefits,	etc.).

•	 Starting	date	of	employment.

•	 Thanks	and	appreciation	for	the	opportunity.

•	 Request	for	notification	of	any	changes	or	if	the	candidate	is	required	to	do	anything	before	
starting employment.

Note: You don’t have to write the subject line of the letter.

Read the details given below: “Accepting a Job offer”

Written acceptance of a job

•	 It	is	with	great	enthusiasm	that	I	accept	your	offer	of	the	post	of	Sales	Executive	at	Sell/Well	
Org. Please consider this letter as my formal acceptance of it.

•	 I	would	like	to	express	my	pleasure	at	your	offer	of	the	post	of	Sales	Executive	at	Sell/Well	
Org. Please consider this letter as formal acceptance of it.

•	 I	am	writing	this	letter	as	an	acceptance	of	your	offer	of	the	post	of	Sales	Executive	at	Sell/
Well Org.

Terms and conditions of employment

•	 I	understand	that	I	will	be	receiving	a	starting	salary	of	Rs	12,000	per	month.	I	also	understand	
that	I	will	get	full	pay	and	benefits	during	the	3	months’	probationary	period.

•	 As	discussed,	my	starting	salary	will	be	Rs.	12,000	per	month.	I	also	understand	that	I	will	
receive	full	pay	and	benefits	during	the	3	months’	probationary	period.

Starting date of employment

•	 As	agreed,	my	joining	date	will	be	the	1st	of	June,	2009.

•	 As	discussed,	I	will	be	starting	work	from	the	1st	of	June,	2009.

Thanks and appreciation for the opportunity

•	 Thank	you	once	again	 for	 this	wonderful	opportunity.	 I	 look	 forward	 to	 joining	your	 team/
organization/company	 and	 becoming	 a	 part	 of	 the	 continued	 success	 that	 the	 team/
organization/company	represents.

•	 Thank	 you	 for	 the	opportunity.	 It	 is	 an	 honour	 to	 be	 selected	 for	 your	 team/organization/
company.
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•	 Thank	 you	 for	 this	wonderful	 opportunity.	 I	will	 put	 in	my	 best	 efforts	 to	make	 a	 positive	
contribution	to	your	team/organization/company.

Request for notification if the candidate is required to do anything before starting 
employment.

•	 Do	let	me	know	if	I	need	to	do	anything	prior	to	joining	the	company.

•	 If	there	is	anything	I	need	to	do	before	my	starting	date,	please	let	me	know.

Find out the meaning of the following words and phrases that have been taken from the 
“Accepting a Job offer”.

•	 Prior	to	-	before/after/during

•	 Enthusiasm	-	laziness/eagerness/happiness

•	 Positive	-	useful/useless/unhelpful

•	 Per	-	one/each/first

•	 Opportunity	-	offer/order/chance

•	 Probationary	-	on	trial/sample/training
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SeSSioN 1: WorKiNg WiTH ACCeSSiBiLiTY oPTioNS

relevant Knowledge

Computer Accessibility refers to the user friendliness of a computer system for all, regardless of 
their disability. this is mainly a software issue. However, when a combination of hardware and 
software, it enables a person with a disability or impairment to use a computer. it is known as 
Assistive technology. in this session, you will learn about the basic accessibility options available 
on your computer.

there are numerous types of impairment that impact computer usage. these include:

•	 Cognitive	impairments	and	learning	disabilities,	such	as	dyslexia,	attention	deficit-hyperactivity	
disorder (ADHD) or autism. 

•	 Visual	impairment	such	as	low-vision,	complete	or	partial	blindness,	and	color	blindness.	

•	 Hearing	impairment	including	deafness.	

•	 Motor	or	dexterity	impairment	such	as	paralysis,	cerebral	palsy,	or	carpal	tunnel	syndrome	
and repetitive strain injury. 

Accessibility Options in Control Panel are used 
to	customize	 the	way	your	keyboard,	display,	or	
mouse function. Many of these features are useful 
for people with disabilities as discussed earlier. 
in this session, you will learn to use accessibility 
options in Windows XP.

Launching accessibility options
•	 To	launch	accessibility	options	in	Windows	XP,	

Click Start > Control Panel > Accessibility 
options. the Accessibility Options window 
appears.

Keyboard Tab

StickyKeys

StickyKeys is an accessibility feature to help 
computer users with physical disabilities, but 
it is also used by others as a means to reduce 
repetitive strain. StickyKeys allows the user to 
press	and	release	a	modifier	key,	such	as	Shift,	Ctrl,	Alt,	or	the	Windows	key,	and	have	it	remain	
active until any other key is pressed.

Figure 1
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•	 To	enable	StickyKeys,	select	Use StickyKeys.

•	 Click	Apply.

•	 Click	OK.

The	StickyKeys	icon	appears	in	the	system	tray	(figure	2).

After having enabled StickyKeys, you W’ii now practice and see its effect.

•	 Start	Notepad.	To	do	so,	click Start > All Programs > Accessories > Notepad.

•	 Type	some	text	(3	-	4	lines	at	least)	and	place	the	cursor	at	the	beginning	of	the	text.

•	 Press	CTRL	key	on	your	keyboard.

•	 Press	letter	A	on	your	keyboard.

Notice	 the	 entire	 text	 gets	 selected.	 This	 action	 is	 equivalent	 to	 pressing	 CTRL+A	
simultaneously!

to disable StickyKeys, uncheck Use StickyKeys and then click on Apply > OK. 

FilterKeys

FilterKeys is a feature of Microsoft Windows. it is an accessibility function that tells the keyboard 
to ignore brief or repeated keystrokes, making typing easier for people with hand tremors.

•	 To	enable	FilterKeys,	check	Use FilterKeys.

•	 Click	Settings under FilterKeys and check “Ignore Repeated Keystrokes”.

•	 Click	Apply.

•	 Click	OK.

The	FilterKeys	icon	appears	in	the	system	tray	(figure	3).

After having enabled FilterKeys, you will now practice and see its effect.

•	 Start	Notepad	and	type	some	repeated	characters.

notice that the repeated characters are ignored.

Figure 2

Figure 3
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to disable FilterKeys, uncheck Use FilterKeys and then click on Apply > OK. 

ToggleKeys

toggleKeys is also a feature of Microsoft Windows. it is an accessibility function which is designed 
for people who have vision impairment or cognitive disabilities. When toggleKeys is turned on, 
computer emits sound cues when the locking keys (Caps Lock, num Lock, or Scroll Lock) are 
pressed. A high sound is emitted when the keys are switched on and a low sound is emitted when 
they are switched off.

•	 To	enable	ToggleKeys,	Check	Use ToggleKeys.

•	 Click	Settings under toggleKeys.

•	 Click	Apply.

•	 Click	OK.

Having enabled toggleKeys, you can see its effect 
by any one of the following keys nUM LOCK, CAPS 
LOCK or SCROLL LOCK. notice that on doing so, 
you hear a beep.

to disable toggleKeys, uncheck Use ToggleKeys 
and then click on Apply > OK.

Sound Tab

Select the Sound tab. A window with options to 
configure	accessibility	options	for	sound	is	displayed	
(figure	4).

SoundSentry

SoundSentry is designed to help users with auditory impairments. SoundSentry generates visual 
warnings,	such	as	a	blinking	title	bar	or	a	flashing	border,	whenever	the	computer	generates	a	
sound.

•	 To	enable	SoundSentry,	Check	Use SoundSentry under Sound tab. Doing so activates a 
drop down list wherefrom you can choose the type of visual warning desired.

•	 Click	Apply.

•	 Click	OK.

For understanding SoundSentry, you need to create an error!

•	 Click	Start> Run. type note instead of notepad and press Enter.

Figure 4
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•	 Type	some	repeated	characters	in	the	notepad.	Notice	that	the	desktop	will	flash	for	a	fraction	
of second along with visual error sound code.

to disable SoundSentry, uncheck Use SoundSentry and then click on Apply > OK.

ShowSounds

ShowSounds instructs applications that convey information by sound, to also provide information 
visually, through text captions or informative icons.

•	 To	enable	ShowSounds,	Check	Use ShowSounds under Sound tab.

•	 Click	Apply.

•	 Click	OK.

Display Tab

Select the Display tab. A window with options 
to	 configure	 accessibility	 options	 for	 display	 is	
displayed.

High Contrast

High Contrast is an accessibility feature to assist 
people with vision impairment. You can change the 
size	and	color	of	fonts	and	the	background	for	ease	
of viewing.

•	 To	 enable	 HighContrast,	 Check	 Use 
HighContrast Under	Display	Tab	(figure	5).

•	 Click	Apply.

•	 Click	OK.

notice the difference on your monitor as the High Contrast option is enabled. 

to disable High Contrast, uncheck Use High Contrast > Apply > OK.

Cursor options

Cursor Options is also an accessibility feature that assists people with vision impairment by 
changing the blink rate and width of the cursor.

•	 To	change	the	speed	of	the	cursor	blink,	move	the	Blink Rate slider back and forth. notice the 
cursor blinking at various speeds.

•	 To	change	the	width	of	the	cursor,	move	the	Width slider back and forth. notice the with of 
the cursor changing.

Figure 5
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mouse Tab

mouseKeys

MouseKeys	is	an	accessibility	feature	that	assists	people	who	have	difficulty	using	a	mouse.	This	
option uses the keyboard (especially numeric keypad) as a pointing device instead of a mouse.

Select	 the	Mouse	Tab,	a	window	to	configure	accessibility	options	for	mouse	will	be	displayed	
(Figure 6). 

•	 To	enable	MouseKeys,	Check	Use MouseKeys. 

•	 Click	Apply. 

•	 Click	OK.

Notice	the	MouseKey	icon	in	the	System	Tray	(figure	7).	

Use	number	 pad	 keys	 for	moving	mouse	pointer	 instead	of	 using	mouse	after	 enabling	 “Use	
MouseKeys”.	Use	number	key	4	to	move	left,	6	to	move	right,	2	to	move	down	and	8	to	move	
up. 

to disable MouseKeys, uncheck Use MouseKeys and then click on Apply > OK. 

general Tab

This	tab	enables	you	to	configure	accessibility	options	for	all	users.	

Select	the	General	Tab,	a	window	to	configure	additional	accessibility	options	will	be	displayed	
(figure	8).	

“Turn off accessibility features after idle for”, “Give warning message when turning a feature on” 
and “Make a sound when turning a feature on or off”. 

now check these features one by one and see what happens. 

Figure 6

Figure 7
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SerialKeys 

SerialKeys	is	an	accessibility	feature	that	assists	people	that	have	difficulty	using	a	keyboard	or	a	
mouse (or both). they can use special devices such as Sip, Puff and Breath Switches to provide 
input to the computer through Serial Ports. 

For	example,	sipping	on	the	tube	activates	one	device,	while	puffing	on	the	same	tube	activates	
another. 

• Apply all settings to logon desktop	can	be	used	to	apply	configured	accessibility	options	to	
this user at logon. 

•	 Apply all settings to defaults for new users	 can	be	used	 to	apply	configured	accessibility	
options to all users using a particular computer. 

Figure 8 

Figure 9
A user controlling a device using a sip and puff switch
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exerCiSe 

Perform	the	following	activities	till	you	are	confident:	

S.No. Activities 

1. Use StickyKeys option 

2. Use SoundSentry option 

3. Use High Contrast option 

4. Use SerialKeys option 

ASSeSSmeNT  

Fill in the blanks

1. the option in Microsoft Windows XP used for helping users with physical disabilities and to 
reduce repetitive strain is ____________________.

2. Sound Sentry is designed to help users with ______________________ impairments. 

3. the High Contrast option in Microsoft Windows XP is designed to assist people with 
________________ impairments. 

4.	 ___________________	is	designed	to	assist	people	that	have	difficulty	using	a	keyboard	or	
a mouse.

SeSSioN 2: NeTWorKiNg FUNDAmeNTALS 

relevant Knowledge
A computer network is a collection of computers and other hardware components interconnected 
by communication channels (cables or satellites) that allow sharing of resources and information. 
this session introduces you to the basic fundamental concepts of networking and internet and 
using different types of internet connection. 

Networks are designed using the following architecture: 

Peer-to-peer (P2P) Architecture:
networks in which all computers have an equal status are called peer to peer networks. Generally 
in such a network each terminal has an equally competent CPU. 
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Client-Server Architecture:
networks in which certain computers have special dedicated tasks, providing services to other 
computers (in the network) are called client server networks. the computer(s) which provide 
services are called servers and the ones that use these services are called clients. 

Types of networks
there are two major types of network Local Area network (LAn) and Wide Area network 
(WAn). 

Local Area Network
A local area network (LAn) is one which connects computers and devices in a limited geographical 
area	such	as	home,	school,	computer	laboratory,	office	building,	or	closely	positioned	group	of	
buildings. 

Usually local area networks offer very high speeds and are used for connecting computers and 
peripherals such as printers, scanners, etc. 

Wide Area Network
A wide area network (WAn) is one which covers a broad area (i.e., any network that links across 
metropolitan, regional, or national boundaries). the internet is the most popular WAn, and is used 
by	businesses,	governments,	non-profit	organizations,	individual	consumers,	artists,	entertainers,	
and many others.  

internet 
the internet is a global system of interconnected computer networks that use the standard internet 
protocol suite to serve billions of users worldwide. it is a network of networks that consists of 
millions of private, public, academic, business, and government networks. 

internet is one of the most useful technologies of modern times which help us in our daily, personal 
and professional life. internet is widely used by students, educational institutes; scientist and 
professionals to gather information for research and general information. Businesses use the 
Internet	 to	 access	 complex	databases	 such	as	 financial	 database.	The	 Internet	 is	 the	 largest	
encyclopaedia for all age groups. the internet helps in maintaining contact with friends and 
relatives who live across different locations via internet chatting systems and email software. 
internet is also becoming a major source of entertainment for the general public. 

World Wide Web

World Wide Web (abbreviated as WWW or W3, commonly known as the Web), is a system of 
interlinked hypertext documents accessed via the internet. With a web browser, one can view web 
pages that may contain text, images, videos, and other multimedia, and navigate between them 
via hyperlinks. 
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information is stored on web servers referred to as web pages are retrieved by using a web 
browser such as Firefox on the local computer. A Web Browser is a software used to view Web 
sites and acts as an interface between the user and the World Wide Web. A Web server is a 
computer	that	stores	web	sites	and	their	related	files	for	viewing	on	the	Internet.	

Some of the advantages associated with networking are: 

•	 Data Sharing: One of the most important uses of networking is to allow the sharing of data. 
Users	can	send	text	files,	spread	sheets,	documents,	presentations,	audio	files,	video	files,	
etc. to other users. 

•	 Hardware Sharing: Hardware components such as printers, scanners, etc. can also be 
shared. For example, instead of purchasing 10 printers for each user, one printer can be 
purchased and shared among multiple users thus saving cost. 

•	 internet Access Sharing: You can purchase a single internet connection and share it 
among other computers in a network instead of purchasing multiple internet connection for 
each computer. this is very commonly found in internet café (browsing centres), schools, 
colleges, companies, etc. 

•	 Usage of network based applications: Such as web browsers, email clients, chat application, 
audio & video calling, etc is another advantage. 

getting access to the internet

to use the internet, you need an internet connection. internet connections are provided by internet 
Service Providers such as Bharat Sanchar nigam Limited (BSnL), Airtel, MtS, Vodafone, tata 
Docomo, etc. 

internet Service Provider

An	Internet	service	provider	(ISP)	is	an	organization	which	provides	you	with	access	to	the	Internet	
via a dial-up (using modem) or direct (hard wired) or wireless connection. 

Choosing connectivity depends on the availability of a particular technology, speed and connection 
type in your area. Usually small and medium business users, home users use connectivity types 
such as DSL, cable modem, dial-up, broadband wireless, WiMAX or 3G. Medium to large business 
users or customers with more demanding requirements may use high speed connectivity such as 
DSL (High Speed), iSDn, etc. 

modem

Á modem is a device that converts digital computer signals into a form (analog signals) that can 
travel over phone lines. it also re-converts the analog signals back into digital signals. the word 
modem is derived from its function MOdulator/DEModulator. 
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Types of Common internet Connectivity 
There	are	different	types	of	Internet	Connectivity	available	today;	it	can	be	widely	categorized	into	
wired and wireless access. Following table is a summary of different types of internet connectivity 
categorized	into	wired	and	wireless:	

Technology Type of Connectivity 

Dial-Up Wired 

DSL Wired 

Cable internet Access Wired 

3G Wireless 

WiMAX Wireless 

Wi-Fi Wireless 

Some of the commonly used internet connectivity are: 

Dial-up: Dial-up internet access is a form of internet access that uses the facilities of the public 
switched telephone network (PStn) to establish a connection to an internet service provider 
(iSP) via telephone lines using a device called MODEM. Users dial a particular number provided 
by the iSP and gain access to the internet. 

Dial-up connections are extremely slow and in most cases, it is replaced by a high speed connection 
such as DSL or Cable Modem. 

DSL: Digital subscriber line(DSL) provide internet access by transmitting digital data over wires 
of a local telephone network. DSL service is delivered along with wired telephone service on 
the	same	 telephone	 line.	On	 the	customer	premises,	a	DSL	filter	 removes	 the	high	 frequency	
interference, enabling simultaneous use of the telephone and data transmission. For using a DSL 
connection, you need a DSL modem and a subscription. 

Cable internet Access: Cable internet Access is a form of broadband internet access that uses 
the cable television infrastructure. Cable internet Access is provided through existing cable tV 
networks; this is similar to DSL that is provided over existing telephone lines. 

3g: 3G, short for 3rd Generation is a set of standards used for mobile devices and mobile 
telecommunication services and networks. High-Speed Downlink Packet Access (HSDPA) is 3G 
mobile telephony communications protocol that allows higher data transfer speeds and capacity. 
if support for 3G is available on your mobile phone, you can subscribe to the 3G connectivity with 
your iSP in order to get high speed internet connection on your phone. 

WimAx: WiMAX (Worldwide interoperability for Microwave Access) is a wireless communications 
standard designed to provide mobile broadband connectivity across cities and countries through 
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a variety of devices. WiMAX is a long range system, covering many kilometres and is typically 
used	where	DSL	or	Cable	Internet	Access	cannot	be	used;	this	could	be	difficulty	in	laying	out	
cables	for	home	or	offices	located	in	remote	locations	but	need	access	to	the	Internet.	

Wi-Fi: Wi-Fi is a popular technology that allows an electronic device such as computers or mobile 
phones to exchange data wirelessly over a network, including high-speed internet connections. 
Wi-Fi devices such as personal computer, smartphones, video game console, etc. can connect to 
a network resource such as internet through a device called the Wireless Access Point (WAP). Wi-
Fi is used where cables cannot be run (such as old buildings, outdoor areas) to provide network 
and internet access. Wi-Fi can also be used where users require mobile connectivity. 

Wi-Fi	connectivity	is	used	in	home	&	offices,	hotels,	college	&	school	campus	typically	for	Internet	
Access. Shopping malls, coffee shops, resorts mostly offer free or paid Wi-Fi access to the internet 
for their customers.

Data transfer on the internet 

Having talked of data transfer and the internet, have you ever wondered how sitting in one corner 
of the world, you get information from another distant area in a few seconds? 

in very simple language, let’s see what happens to a piece of data, say a Web page, when it is 
transferred over the internet: 

•	 The	data	is	broken	up	into	bits	of	same	sized	pieces	called	packets. 

•	 A	header is added to each packet explaining where the data has come from, where it should 
end	up	and	where	it	fits	in	with	the	rest	of	the	packets.	

•	 Each	packet	is	sent	from	computer	to	computer	until	it	finds	its	destination. Each computer 
on the way decides where next to send the packet. All packets may not take the same 
route. 

•	 At	 the	destination,	 the	packets	are	examined. if any packets are missing or damaged, a 
message is sent asking for them to be re-sent. this continues until all packets have been 
received intact. 

•	 The	packets	are	now	reassembled into their original form. All this done in seconds! 

to access the internet, you need an active internet connection. You need to gather and understand 
your requirement carefully before subscribing to an internet connection plan. in this exercise, you 
will learn how to choose an internet connection. 

Some of the common questions that help you in your decision are: 

•	 What	is	the	purpose	of	getting	this	connection?	

•	 Will	you	use	the	connection	regularly?	

•	 How	much	data	will	be	downloaded	on	an	average	per	month?	



88

Unit-2

•	 How	much	speed	do	you	need?	

•	 What	technology	is	available	in	your	particular	area?	

•	 What	are	the	different	plans	available	from	the	ISP?	

•	 Is	there	any	limitation	or	catch	for	the	selected	plan?	

Use the following table to compare different subscription plans to get an estimate and 
analyse if that would suit your requirement.

3g 
iSP Plan name Download Speed Download Limit Free Modem 

DSL
iSP Plan name Download Speed Download Limit Free Modem 

Cable internet Access 
iSP Plan name Download Speed Download Limit Free Modem 

WimAx 
iSP Plan name Download Speed Download Limit Free Modem 

to access Wi-Fi, you need an access point with an active internet connection. Usually when you 
subscribe to an internet connection, the iSP provides options to purchase or rent a Wi-Fi router that 
can act as both an internet connectivity device and an access point for Wi-Fi connectivity. Setting 
up a Wi-Fi network requires technical expertise; however, you can access the Wi-Fi network by 
connecting to an access point that is already setup for use. On computers that run Windows XP, 
you can view the list of wireless networks available by using the following procedure: 

•	 Right-Click	 on	 the	Wireless	 Icon	 in	 the	 system	 tray	 and	 Click	View Available Wireless 
Networks (figure	10)	

Figure 10 
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Windows XP will display the list of available Wi-Fi networks; you can choose any of the connection 
from the list. Select by Double-clicking on the name displayed in the list. 

Note: You may be prompted to enter a password if the selected network is secure. You will 
receive a confirmation that you are connected to a wireless network. Now the system is ready to 
be used for network related applications such as Firefox, Chrome, Skype, etc. 

exerCiSe 

Perform the following activity till you are confident:

S.No. Activities 
1. List any 3 iSP’s available in your city. After collecting information such as connectivity 

type, speed and charges, compare them and state which is the best iSP and why? 
 

ASSeSSmeNT 

i. Fill in the blanks: 

1. the acronym for LAn is _________________. 

2. three types of Wired internet Connectivity are ___________ , _________ & ___________. 

3. three types of Wireless internet Connectivity are _________ , ___________ & _________. 

ii.  Answer the following: 

1.	 What	is	the	definition	of	networking?	

Figure 11
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2. What are the advantages of networking? 

3. What are the different types of networking? 

4. Explain LAn and WAn. 

SeSSioN 3: iNTroDUCTioN To iNSTANT meSSAgiNg

relevant Knowledge 

instant messaging (iM) is a form of communication over the internet that offers an instantaneous 
transmission of text-based messages from sender to receiver. Most instant messaging software 
include	the	option	for	performing	file	transfers,	audio	chat,	video	calling	and	conferencing,	sharing	
desktops, etc. apart from standard text chat. instant messaging software is widely used for personal 
and commercial use. in this session, you will be introduced to the concept of instant messaging, the 
steps to create an instant messaging account and also work with instant messaging software. 

Unlike email, instant messaging happens in real-time and the response from participants can be 
spontaneous. Some instant messaging software allows users to view messages received when 
they	are	not	logged	on.	These	are	called	“Offline	Messages”.	

For	utilizing	audio	and	video	chat	or	conferencing,	you	need	to	have	microphones	and	headsets	
or speakers and web cameras so that users can talk or see each other. 

Key Features of an instant messaging are as follows: 

•	 Text	Messages	can	be	sent	to	one	or	more	person	(Similar	to	SMS)	

•	 Audio	calling	and	conferencing.	

•	 Video	calling	and	conferencing.	

•	 File	transfers	(Not	limited	to	documents,	spread	sheets,	audio	files,	video	files,	etc.)	

•	 Message	history	(Save	messages	for	future	reference).	

instant messaging Account

Participants messaging to each other need to be signed in to the same instant messaging software. 
to use instant messaging software, a user must have a valid instant messaging account. 

instant messaging accounts differ in formats; some instant messaging software such as Yahoo! 
Messenger, Windows Live Messenger use email addresses for managing the account and 
software such as Skype use standard names. 
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instant messaging Services 

there are two kinds of instant messaging software – application based and Web based. 

•	 Application	 based	 instant	 messaging	 software	 is	 downloaded	 and	 installed	 on	 user’s	
computer. Some of the popular instant messaging software are: 

	 •		Google	Talk

	 •		Yahoo!	Messenger	

	 •		Skype	

	 •		Windows	Live	Messenger	

	 •		Rediff	Bol,	etc.	

•	 Web	based	instant	messaging	software	is	accessed	using	browsers	such	as	Internet	Explorer,	
Mozilla	Firefox,	Google	Chrome,	etc.	Some	of	 the	popular	web	based	 instant	messaging	
software are: 

	 •		Meebo	

	 •		Yahoo!	Messenger	for	the	Web	

	 •		MSN	Web	Messenger	

	 •		IMO,	etc.	

Creating an instant messaging account 

in this exercise, you will learn to create an instant messaging account for using Google talk. 

Google talk is an instant messaging service that provides both text and voice communication 
developed by Google inc. Google talk can also be used for making video calls and to view 
updates from GMAiL mailbox. 

Google talk is free and is available as application based (users need to download and install 
Google talk application to their desktops, mobiles or laptops) and web based (users can use 
Google talk through a browser after signing into their Gmail account). 

Before you start using Google talk, a Gmail account is required. You have learned how to create 
a Gmail account earlier. in this exercise, you will learn how to use Google talk. 

Note: You need to download and install Google Talk application from www.google.com/talk prior 
to this exercise. 

Launching google Talk 
•	 To	launch	Google	Talk,	Click	Start >  Programs >google Talk>google Talk. 
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•	 You	can	also	double-click	on	the	Google	Talk	icon	on	
the desktop if available. 

You need to have a list of contacts that are available for 
chat. if you don’t have any contacts, you can add their Gmail 
account to your contact list by sending an invite. 

if you don’t have a Gmail account already you can create a 
new Gmail account.

Signing in into your google Talk Account

to use Google talk, you need to sign in with your account 
details. 

After signing in into your Google talk account, you should see a window similar to the one displayed 
below. now the Google talk application is ready for use. 

 exerCiSe

Perform	the	following	activity	till	you	are	confident:	

S.No. Activities 
1. You have learnt to sign-in into Google talk. now try Signing Out and Signing back in 

using Google talk. 

ASSeSSmeNT

i. Fill in the blanks: 

1. _______________ is a form of communication over the internet that offers an instantaneous 
transmission of text-based messages from sender to receiver. 

Figure 12

Figure 13
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2. ____________ , ____________ & _______________& Web Camera are required for audio 

and video conferencing. 

ii. Answer the following: 

1.	 List	any	five	application	based	instant	messaging	software.

2. What do you mean by instant messages?

 SeSSioN 4: CHATTiNg WiTH A CoNTACT – googLe TALK 

relevant Knowledge 

in this session, you will learn to chat with a contact that is already added to your contact list. 

•	 Whenever	your	friend	in	the	contact	list	is	online	you	can	see	the	person	along	with	a	green	
dot	as	in	the	figure	14:	

•	 You	can	start	sending	text	chat	message	instantly	by	double-clicking	on	a	contact.	A	window	
will	pop	up	as	displayed	in	the	figure	below.	You	can	type	the	text	in	the	text	box	and	press	
enter; the other person will see the text message and respond to your message. 

•	 Go	ahead	and	get	the	contacts	of	a	couple	of	your	classmates	and	chat	with	them.	

Figure 14
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there are some general rules and etiquettes to be followed while chatting. they are almost the 
same as those that apply for emails. 

•	 Messages	should	be	short	and	to	the	point.	

•	 Always	introduce	yourself	by	name	if	your	screen	name	doesn’t	reflect	it.	

•	 Always	ask	if	the	other	person	has	time	to	chat	first	-	regardless	of	how	important	you	think	
what you have to say is, it’s not going to be well received if the recipient is busy. 

•	 In	a	business	environment,	know	exactly	what	you	want	to	discuss.	

•	 Typing	your	messages	in	uppercase	is	extremely	rude	-	 it’s	considered	shouting	and	very	
aggressive. 

•	 Give	people	 time	 to	 respond	-	Multiple	questions	sent	 to	a	 recipient	before	 they’ve	had	a	
chance to answer can seem more like an interrogation rather than a conversation. 

•	 Wherever	possible,	give	the	person	you	are	communicating	with	your	undivided	attention.	It’s	
not just a sign of respect, but if you have multiple conversations happening or are allowing 
other issues to distract you, you may miss an important point in the other person’s messages 
or lose the gist of the conversation. 

•	 It’s	 important	to	properly	end	an	IM	conversation	-	you	may	think	the	chat	is	over,	but	the	
other person may not. While you’re off doing other things, they may be sitting there staring at 
the screen waiting for further communication from you!! 

Chatting on gmail

in this exercise, you will learn to chat with a contact using the Gmail account through a web 
browser. 

Figure 15
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You can also use the chatting services after signing into their Gmail Account. the same procedure 
will be followed while making voice chats, text chats etc. using the Gmail Account. 

Once you sign into your Gmail account, a contact window will be displayed either on the left side 
or the right side within the browser as displayed below. 

if you would like to chat with a contact, double click on the contact’s name. You will see a pop-up 
similar to the one displayed below. 

now you can start typing the message you want to send and the other contact should be able to 
respond to your chat message.

Chatting on Yahoo 

Having learnt to use one iM software, you will experiment with another. in this exercise, you will 
create an instant messaging account for using Yahoo! Messenger. 

Figure 16

Figure 17

Figure 18
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Note: You may need to download and install Yahoo! Messenger application from http://
in.messenger.yahoo.com/download/ prior to this exercise. 

Before you start using Yahoo! Messenger, a Yahoo Mail account is required. if you don’t have 
a Yahoo! Mail Account already you can use the built in optionfor creating a new Yahoo! Mail 
Account. 

You should a list of contacts that are available for chat. if you don’t have any contacts, you can 
add their Yahoo Mail account to your contact list by sending an invite. 

Note: If you would like to import your contacts from other sources such as Microsoft Outlook, 
Gmail, Hotmail, etc., you can use the import option. 

Having used Yahoo! Messenger, now go ahead and chat with your classmates using a Yahoo mail 
account through a web browser. 

You can also try using other chat services such as MSn, Rediff, Sify, etc. Refer to respective 
websites for further instructions to download and using the software.

exerCiSe

Perform the following activities till you are confident: 

S.No. Activities 

1. Add more contacts to your contact list and chat with multiple contacts. 

2. Download, install and use Windows Live Messenger, Rediff, Sify messengers. Create 
respective accounts to practice.  

ASSeSSmeNT

Answer the following: 

1. State any 03 rules and etiquettes to be followed while chatting on the internet.

2. What are the basic needs to use instant messaging (chat) softwares.

SeSSioN 5: CreATiNg AND PUBLiSHiNg WeB PAgeS - BLog

relevant Knowledge 

A blog is a discussion style site used by non-technical (or technical users) users for creating 
personal web pages. Blogs are similar to an online personal diary and simple to use. 
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You can use a blog to convey messages about events, announcements, news, reviews, etc. Blogs 
are usually managed using a web browser and this requires active internet connection. You can 
also	use	offline	blog	software	to	create	content	first	and	later	publish	the	content	when	an	active	
internet connection is available. 

there are hundreds of websites that offer blog service for free. Some of the popular blogs 
include: 

•	 www.WordPress.com	

•	 www.blogger.com	

•	 www.blog.com	

•	 www.weebly.com	

•	 www.blogsome.com	

Creating a Blog Account

in this session, you will learn how to create a blog account in WordPress. 

WordPress is free web service that you can use to create a beautiful website or blog. WordPress 
has	support	for	“themes”	for	customizing	the	design	of	a	blog.	Themes	can	make	the	blog	or	the	
webpage look attractive. 

•	 Before	you	start	using	a	blog,	a	blog	account	 is	required.	To	create	one,	you	need	a	web	
browser and an internet connection. 

•	 Open	the	Web	Browser.	

•	 On	 the	address	bar	 type	https://signup.WordPress.com/signup/. You should now get to a 
page	with	the	fields	Blog	address,	Username,	Password,	Email	Address	and	Language.	

•	 Blog Address: You must provide a unique address to your WordPress Blog. this is the 
address which others will use to view your blog. 

•	 Username: You should choose a username for managing this blog. 
•	 Password: Securing your WordPress blog account with a strong password is important. A combination 

of uppercase and lowercase letters with some digits along with symbols would be a strong enough 
password. You need to enter the password twice. 

•	 Email Address: You must provide your Email Address here. An activation link will be send to 
you from WordPress after you click “Create Blog”. 

•	 Language: You can choose your own language for blogging from the list given. 

•	 Click	Create Blog. 

On doing so, you will be sent an email for activating your blog account. Open your email and click 
on the activation link. Once you click Activate Blog, you will be redirected to your WordPress Blog 
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Account and you should see a web page similar to the one displayed below. 

now the blog is ready for use. You will be presented with the address of your blog as displayed in 
the web page above; you can either double click on the link or type the address manually in the 
web browser. Either action takes you to the homepage of your blog. 

Once you have created a blog, you need to submit content that you want others to view. this 
process ids called posting content. 

•	 To	create	a	post,	click	New Post. A Window similar to the one displayed below appears.

•	 Title: You must provide a title for your post; choose a tile that this post will focus on. For 
example, “School Annual Day Function 2012”. 

 Using the rich text box, you can type content that you want others to read. 

	 Once	you	have	finished	typing	the	content,	you	need	to	publish	the	post	for	others	to	see.	
Click Publish Post to publish your content. to view the post, you can type the blog address in 

Figure 19

Figure 20
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the address bar of the web browser, you should see your blog along with the post (displayed 
below).  

You can also add photos, videos, etc. to the blog using the options available in WordPress.You 
can comment on posts published by others. Usually, the comment option is available towards 
the end of the post. Look for options such as Leave a comment, Leave a reply, etc. in the blog to 
comment. For example, in WordPress the comment box is located below the post and labelled as 
Leave a reply. 

•	 In	the	Enter your comment here… text box, type your comments about the post. 

•	 In	the	Email (required) field, type your email address. 

•	 In	the	Name (required) field, type your name. 

•	 In	the	Website	filed,	you	may	type	your	blog	address	(Optional).	

•	 Once	 you	 have	 typed	 the	 content	 in	 the	 comment	 area,	 review	 carefully	 and	Click	 Post	
Comment. 

Figure 21 

Figure 22
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Once you click the Post Comment, you will see the blog along with your comment. (displayed 
below) 

exerCiSe

Perform the following activities till you are confident: 

S.No. Activities 

1. You have learnt to create and work with blogs using WordPress. now create and work 
with other blog websites such as blogger, weebly, 

2. Create blogs for: 
•		Announcing	School	Annual	Day	Function	
•		Blood	Donation	Camp	

ASSeSSmeNT

Answer the following: 

1. Explain the purpose of a blog. 

2. List any 5 websites that provide blog service.

3. Difference between web page and website.

SeSSioN 6: USiNg oFFLiNe BLog eDiTorS

relevant Knowledge 

if you do not have an active internet connection, you can create blogs using a blog application and 
publish the blog whenever internet connectivity is available. 

There	are	several	free	offline	blog	editors	available	that	can	be	downloaded	and	installed	on	the	
local computer such as: 

Figure 23
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•	 Qumana	

•	 Windows	Live	Writer	

•	 Blogdesk	

In	 this	 exercise,	 you	 will	 learn	 to	 use	 an	 offline	 blog	 editor	 Qumana.	 Qumana	 is	 a	 free	
blog application that is simple and easy to use. in this exercise, you will learn about using 
Qumana.	

Note: You need to download and Install Qumana. Qumana can be downloaded from www.qumana.
com. Once installed, you can use the program to manage blogs. 

Launching Qumana
•	 To	launch	Qumana, Click Start > Programs > Qumana > Qumana. 

•	 You	can	also	Double-click	on	the	Qumana icon on the desktop if available. 

You	need	an	existing	blog	account	 to	use	with	Qumana.	 In	 this	exercise,	 you	will	 learn	 to	
use	your	existing	WordPress	account	with	Qumana.	Enter	your	WordPress	blog	address	and	
Click Next. 

•	 A	login	window	appears.	You	need	to	provide	details	of	your	WordPress	account.	However,	
if you wish to use it for other blog services, you need to enter appropriate details. Give the 
WordPress	blog	address	in	the	Web	address	field.	Enter	the	Username	and	password	of	the	
WordPress account. 

•	 Click Next > Finish. 

A window similar to the one below appears.

Figure 24
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If	posts	are	already	available	in	your	blog,	Qumana	will	download	and	display	the	existing	blogs	
as well. 

to create a post, 

•	 Click	New Post. 

•	 A	window	similar	to	the	one	below	will	be	displayed	(figure	below).	

 Note: Enter the title for the post in the Title field and the post content in the area given below 
the page title. 

•	 Click	Publish Post. 

Once you click Publish Post, the post will get automatically updated to your WordPress blog. 

Figure 25

Figure 26
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to view the published content, open the web browser and type your blog address. 

You can include photos or pictures in your blog to make it attractive. to insert a picture, 

•	 Click	on	the	image	icon	on	the	right	hand	side	of	the	application.	

•	 Once	you	click	the	image	icon,	the	following	window	will	be	displayed.	

•	 Click	Browse to locate the image that you want to publish in the blog. 

•	 Once	you	click	“Browse”,	the	OS	browse	window	appears,	enabling	you	to	locate	the	image	
to be loaded. When you have chosen the image click Upload & insert. 

•	 Click	Publish Post. 

to view the published content along with the picture, open the web browser and type in your blog 
address. 

now try using other blog applications such as Windows Live Writer, Blogdesk, etc. using different 
blog accounts. 

exerCiSe  

Perform the following activity till you are confident:

S.No. Activity 

1. Download	and	use	different	offline	blog	editors	

Figure 28

Figure 27
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ASSeSSmeNT  

Answer the following:  

1.	 Explain	the	purpose	of	an	offline	blog	editor.	

2.	 List	any	five	offline	blog	editors.	

SeSSioN 7: oNLiNe TrANSACTioNS 

relevant Knowledge 

Online shopping is a form of electronic commerce where customers can buy or sell goods over 
the internet. Customers need to have an active internet connection for viewing goods or services 
offered by a seller; customers can pay online using a credit, debit card or by internet banking.

online shopping could be useful in situations when: 

•	 A	customer	does	not	have	sufficient	time	to	visit	stores.	

•	 Visiting	a	store	is	more	expensive	than	purchasing	a	product	online.	

•	 A	product	or	service	that	is	not	available	in	the	local	market	is	available	online.	

Some of the popular online transaction websites are: 

•	 IRCTC,	an	online	portal	for	booking	flight	and	train	tickets.	

•	 Flipkart,	an	online	shopping	portal	for	buying	consumer	products.	

•	 EBay,	an	online	portal	for	buying	and	selling	goods.	

•	 Redbus,	an	online	portal	for	booking	bus	tickets.	

to perform an online transaction, all you need is a web browser and an active internet connection. 
in some cases where purchasing is involved, you will need a valid credit card, debit card or online 
banking support referred to as net Banking Subscription. Some websites even allow COD (Cash 
on delivery) where the users can pay once they receive the product or service. 

online Transaction Using Flipkart 

in this section, you will learn to perform an online transaction using Flipkart. 

Flipkart is an online store where you can purchase a variety of electronic goods, books, accessories, 
digital cameras, mobile phones and peripherals such as printers, etc. 
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Flipkart offers multiple payment methods like credit card, debit card, net banking, e-gift voucher, 
and Cash on Delivery. 

to work with Flipkart, you need to use a web browser and an active internet connection. 

•	 Open	any	Browser	such	as	Firefox,	Chrome	or	Internet	Explorer	

•	 Type	www.flipkart.com	in	the	address	bar	and	Press	Enter.	

A web page similar to the one below will be displayed. 

•	 To	perform	transactions	using	Flipkart,	you	need	to	sign	up	for	a	Flipkart	account.	

•	 Locate	and	click	on	the	Sign	Up	link	at	the	top	of	the	web	page,	a	window	similar	to	the	one	
below will be displayed for signing up with Flipkart. 

•	 Email	Address:	You	must	provide	your	Email	Address.	The	Email	Address	is	also	used	for	
sending offer mails, promotional mails to you. the Email Address will be used as the login 
name for your Flipkart Account. 

Figure 29

Figure 30
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•	 Password:	You	must	secure	your	Flipkart	Account	by	giving	a	strong	password.	You	need	to	
enter the password twice. 

•	 Click	Sign Up Now! 

 Once you have signed up successfully, a window similar to the one below will be displayed. 

Flipkart	 has	a	 variety	 of	 products	organized	as	 categories.	You	 can	either	 look	 for	 respective	
product in appropriate category or you can use the search feature to locate a particular item. For 
example, if you would like to buy a digital camera, you can Digital Camera in the search box and 
choose a model from the search results window. You can select a model of your choice by clicking 
on the product image. You can browse the catalog of products available in Flipkart; once you have 
decided to purchase a product, you can use purchase the product by using the option Buy this 
now. You can select one or more products before you proceed to payment. Products added to 
your shopping cart will be available for review prior to payments.

Figure 31

Figure 32
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Flipkart allows a variety of methods for online payment. You can use credit card, debit card, 
net Banking, Cash on Delivery or e-gift voucher to complete the payment; you need to enter 
appropriate	 details	 as	 required	 in	 the	mentioned	 fields	 and	Click	Pay	 to	 initiate	 the	 payment.	
Depending on the method select, additional windows may be displayed and procedures will vary 
to complete the online transaction. 

Some vendors (websites) also offer payment to be made in installments thus making it a 
convenient option for the customers. Refer to the website payment terms for information on 
payment procedures and practices. 

online Transaction for Booking rail Tickets 

in this section you will learn how to perform online transactions for booking train tickets using 
iRCtC. 

indian Railway Catering and tourism Corporation (iRCtC) is an online portal that can be used for 
booking travel tickets. 

to work with iRCtC, you need to use a web browser and an active internet connection. 

•	 Open	any	Browser	such	as	Firefox,	Chrome	or	Internet	Explorer	

•	 Type	www.irctc.co.in	in	the	address	bar	and	Press	Enter.	

A web page similar to the one below will be displayed. 

•	 To	perform	transactions	using	IRCTC,	you	need	to	sign	up	for	an	IRCTC	account.

Figure 33
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•	 Locate	and	Click	Signup	link	at	the	top	of	the	web	page,	a	window	similar	to	the	one	below	
will be displayed for signing up with iRCtC. 

•	 You	will	be	redirected	 to	a	web	page	 for	signing	up	with	 IRCTC	similar	 to	 the	one	below.	
Follow	the	onscreen	procedures	for	filling	up	the	details	to	complete	the	registration.	

Once you logon to iRCtC, you can use the website for booking tickets. By now, you are quite 
familiar	with	what	each	field	represents.	Go	ahead	and	fill	in	the	details.	The	ones	marked	with	an	
star	(*)	are	mandatory	fields.

Figure 34
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Once	you	click	“Find	Trains”,	list	of	available	trains	with	ticket	availability	will	be	displayed	(Figure	
below).  

You can view the status of available tickets sorted by day (displayed above); once you have 
fixed	a	date	 that	 is	convenient	 for	 travel,	you	can	proceed	to	book	the	tickets	by	 following	the	
instructions provided in the website. 

Once you book the ticket, an electronic copy of the ticket will be displayed on the screen. 
Additionally,	the	ticket	will	be	mailed	to	the	email	address	specified	during	registration.	

Figure 35

Figure 36
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exerCiSe  

Perform the following activity till you are confident: 

S.No. Activity 

1. Register with Junglee (www.junglee.com), Yatra (www.yatra.com) and practice online 
transactions. 

 

ASSeSSmeNT  

Answer the following: 

1. Explain the purpose of Online transactions. 

2.	 List	any	five	websites	that	allow	online	transactions.

3. List any three payment tools to use online transactions.

SeSSioN 8: iNTerNeT SeCUriTY 

relevant Knowledge 

Internet	 security	 is	 a	 branch	 of	 computer	 security	 specifically	 related	 to	 the	 Internet,	 often	
involving browser security but also network security. its objective is to establish rules and 
measures to use against attacks over the internet. the internet represents an insecure channel 
for exchanging information leading to a high risk of intrusion or fraud, such as phishing. this 
session introduces you to internet security concepts and how to secure online and network 
transactions. 

though internet provides valuable information and entertainment, it may leave your computer 
unsecure due to many online threats. You need to ensure that your usernames, passwords, 
credit card or online banking information secure as they are prone to be tracked and used by 
unauthorized	 users.	 Some	websites	 can	 also	 install	Malware	 on	 the	 computer	without	 user	
consent thereby leaving the computer damaged or insecure. 

Online	threats	such	as	Phishing,	email	spoofing,	chat	spoofing,	etc.	can	increase	the	chances	of	
users getting compromised. 
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You can reduce the risks by using best practices such as using Antivirus Software, Antispyware 
Software, Firewalls, strong passwords, etc. in addition to spreading awareness of the best 
practices. 

Best Practices for Security 

Use strong passwords, a combination of alphanumeric and special characters could be used 
for creating a password that is not so easy to crack or guessed by other users. Do not keep 
passwords such as your favorite color, friends or relatives name, bike number, mobile number 
either as single or combined option. these passwords are easy to guess if a user knows 
you personally. Change your password frequently at least 2 or 3 weeks so that your account 
information remains secure. 

Using strong passwords can lower the risk of a security breach; effectiveness of a password 
depends on the security mechanism of the software and users involvement in generating a strong 
password. 

Most	websites	check	for	password	effectiveness	when	a	user	attempts	to	register	for	the	first	
time or when they change password. For example, when you register with Gmail, you may 
notice a password meter displaying the strength of your password similar to the one displayed 
below. 

Following is a general guideline for managing strong passwords. 

•	 Keep	the	length	of	the	password	at	least	12-14	characters	if	permitted.	

•	 Avoid	keeping	passwords	based	on	repetition,	dictionary	words,	letter	or	number	sequences,	
usernames, relative or pet names, etc. 

•	 Including	numbers,	and	symbols	in	passwords	if	allowed.	

•	 Use	capital	and	lower-case	letters.	

•	 Avoid	using	the	same	password	for	multiple	sites	or	purposes.	

Figure 37
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•	 Avoid	using	something	that	the	public	or	workmates	know	you	strongly	like	or	dislike.	

•	 Use	random	password	generators	if	possible.	

Example of a strong password: u1vx:,4Hd{]$

You may also use websites such as www.strongpasswordgenerator.com that can generate 
random strong passwords. to generate a strong password using www.strongpasswordgenerator.
com do the following: 

•	 Open	any	web	browser.	Type	www.strongpasswordgenerator.com	 in	 the	address	bar	and	
press Enter. 

•	 Click	Generate	strong	password.	Notice	the	password	displayed	under	your	new	password.	

Backup your data: Always keep copies of personal data in additional media such as compact 
discs, pen drives, etc. this could be helpful in situation when there is a loss of data. Keep the data 
away	from	unauthorized	users.	

Use encryption software: (Usually available within the operating system) to protect your data 
from	unauthorized	users.	If	encryption	software	is	not	available	within	the	operating	system,	use	
a 3rd party software. 

Keeping your username and password private: never save your username or password on 
computers that are used in shared environments such as internet café. Browsers may save 
your personal data on the local computer that can be used by another user using the same 
computer. 

registering with websites: Read the privacy statement or policy whenever you register with 
a website, the statement or policy will include information about how the website use personal 
data. 

Do not share personal information: Websites	require	you	to	fill	out	 forms	containing	fields	
such	 as	 name,	 gender,	 age,	 email	 address,	 school,	 etc.	 Be	 cautious	 when	 filling	 out	 such	
forms; research and verify if it’s a trustable website . Your email addressed could be used by 
unauthorized	users	to	send	you	fake	or	unwanted	emails;	think	twice	or	thrice	before	providing	
information to any website and decide if it is really necessary. 

Secure transactions: if you are using online shopping or transactions, websites even store 
your credit card or online banking personal information such as your credit card number, account 
details,	etc.	This	information	can	be	tracked	and	used	by	un-authorized	users	often	known	as	
hackers to misuse this information. Again, ensure the website is legitimate and uses secure 
practices for performing and maintaining online transactions. Since information such as credit 
card details or personal information is sent over the network, it is always recommended to 
use only secure websites for such transactions. Verify if the website uses secure transaction; 
usually	 it	 is	 indicated	 through	 a	 digital	 certificate	 represented	 as	 a	 golden	 lock	 in	 the	 web	
browser’s address bar. 
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Use antivirus and antispyware software: Computers are prone to attacks from software known 
as Malware that could harm your computer. Malware track browsing behavior or transmit personal 
data from your computer; programs such as keyloggers could be installed on your computer 
track	and	transmit	every	key	that	is	pressed	on	a	keyboard	(keystrokes)	to	unauthorized	users.	
Antivirus and Antispyware programs also offer real-time protection monitoring your computer for 
any changes by malware software. Keep your Antivirus and Antispyware software always up to 
date, this can help in protecting your computer from recent threats. 

Do not immediately respond to mails from unknown users: it may be a fake mail trying to 
gather personal information such as your bank account details, home address, etc. Some mails 
could promise you jobs or announce lottery results which in turn could compromise the user. 
And in some cases, virus or scripts that are dangerous could be attached to the mail; nEVER 
open the attachment from an unknown source. 

Clear browser cookies frequently: Cookies are programs that are created on your local 
computer when you visit websites. though cookies are meant for storing data based on your 
activity performed during your earlier visit such as logon details, details of a shopping cart, 
visited	pages	in	a	website,	etc.	they	could	also	be	tracked	by	unauthorized	users	and	possibly	
gain access to your personal information. 

Keep the operating system and software applications up to date, though operating systems and 
applications are designed, tested and distributed, sometimes they may have security holes through 
which a hacker can take advantage; they may track and gather information or even damage the 
whole	computer.	In	general,	most	vendors	notify	the	users	whenever	a	security	hole	is	identified	
and an update is available to address that particular issue. You can also visit respective vendor’s 
website to check if there are any updates available, download and keep your operating system 
and software applications up to date, free from security holes. 

Install firewalls: Firewalls could be software or hardware and can assist in keeping a computer 
and	a	network	secure.	Firewalls	analyze	the	network	traffic	and	determine	if	the	traffic	should	be	
allowed	or	not.	In	most	cases,	operating	systems	such	as	Linux,	Windows	or	Mac	include	firewall	
software as a part of operating system thus keeping the computer secure. in rare cases, you may 
need	to	configure	your	firewall	for	additional	security.	

Never install software from unknown sources: As they might not be trustworthy; download 
only from well-known or reputed websites. Verify the source if it is legitimate by searching the 
internet or referring to comments from other users before downloading them; understand the 
nature and the purpose of the software before attempting to download and install them. 

remove unwanted or unknown software applications: these might have got installed without 
your knowledge when you have visited some websites. Unwanted software could get installed as 
they might have been bundled along with necessary software. Some programs such as toolbars 
get installed usually through bundled software and are programmed to send personal data without 
your consent. 
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Clearing Data Stored in Browsers 

Web browsers have built-in password management designed to store passwords used in forms 
on websites. Browsers often prompt to save usernames and passwords when users attempt to 
logon to websites. 

this facility is offered to users, so that they can logon to their frequently used websites without 
having to type the usernames or passwords. However it is not advisable to leave the web browser 
store this data particularly on public or shared computers. 

To	clear	personal	data	from	a	web	browser	such	as	Mozilla	Firefox,	launch	the	browser.	

•	 Click	Tools Menu, click Options. 

•	 Click	Security tab. the following window will be displayed: 

notice that under Passwords section, Remember password for sites is checked. this means 
the	 browser	 is	 configured	 to	 save	 passwords	 for	 websites	 automatically.	 You	 can	 uncheck	
Remember password for sites option, if you prefer nOt to store passwords. 

Mozilla	Firefox	can	also	store	data	such	as	cookies,	visited	websites	or	webpages	data,	browsing	
history, etc. to clear this stored data, click General tab > Option. the following window will be 
displayed: 

Figure 38

Figure 39
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•	 Click	Privacy tab. the following window will be displayed: 

•	 Under	History section, click the drop down menu next to Firefox will:. 

•	 Select	Use custom settings for history from the drop down list. the following window will 
be displayed: 

Figure 40

Figure 41

Figure 42
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Notice	 the	 preferences;	 Firefox	 is	 configured	 to	 remember	 browsing	 and	 downloading	 history	
search and form history and cookies. if you do not wish store the above mentioned data, select 
Never remember history from the drop down list. if you are in a public environment such as a 
cyber café, you may select the option Clear all current history. On selecting this option, the 
following window will be displayed: 

•	 Click	Clear Now and then click OK.	From	now	on,	Mozilla	Firefox	will	not	 remember	any	
history	as	you	have	configured	it	that	way.	

•	 There	are	several	online	threats	such	as	Phishing,	email	spoofing,	chat	spoofing,	etc.	

•	 You	can	reduce	the	risks	by	using	best	practices	such	as	using	Antivirus	Software,	Antispyware	
Software, Firewalls, strong passwords, etc. in addition to spreading awareness of the best 
practices.

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 

1. You	have	learnt	to	work	with	Mozilla	Firefox.	Now	perform	tasks	outlined	earlier	using	
Mozilla	Firefox	with	other	browsers	such	as	Internet	Explorer,	Google	Chrome.	Use	the	
help	file	or	online	help	to	find	procedures.	

ASSeSSmeNT  

Answer the following: 
1. Explain the purpose of internet Security. 
2. Explain different kinds of online threats.

Figure 43
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SeSSioN 1: moDiFYiNg LAYoUT oF A PArAgrAPH

relevant Knowledge
You have already learnt the basics of word processing. Now consider a situation when 
you write a lengthy article that spans several pages, and you need to make it easier for the 
readers to read it? Look at the following example: 

What	is	Culture	and	Gender	Sensitization?	Culture	in	simple	terms	refers	to	our	values,	the	
way we speak, behave, think, dress, religious beliefs, the music we like, our interactions, 
and	the	food	we	eat.	Diversity	is	a	commitment	to	recognizing	and	appreciating	the	variety	of	
characteristics that make individuals unique in an atmosphere that promotes and celebrates 
individual	and	collective	achievement.	Many	people	mistakenly	use	such	phrases	as	“Indian	
culture,”	“white/black	culture,”	or	“Western/Eastern	culture,”	to	describe	a	particular	culture	
but these people fail to acknowledge the presence of cultural diversity, or the presence of 
multiple cultures and cultural differences within a society. in reality, many different cultural 
groups exist today in india and most developing and developed countries. Diversity in the 
workforce means employing people without discrimination on the basis of gender, age and 
ethnic	or	racial	background.	Since	globalization	is	the	current	overwhelming	trend	in	business,	
diversity in the workplace is a better accepted and applied concept now more than ever. 
there are different kinds of diversity that one encounters at the workplace. these include 
diversity of gender, age, psychology, education, language and culture. 

is the content presented above easy to read? Now, look at the formatted sample below: 

What	is	Culture	and	Gender	Sensitization?	

Culture in simple terms refers to our values, the way we speak, behave, think, dress, religious 
beliefs, the music we like, our interactions, and the food we eat. Diversity is a commitment to 
recognizing	and	appreciating	the	variety	of	characteristics	that	make	individuals	unique	in	an	
atmosphere that promotes and celebrates individual and collective achievement. 

Many	 people	 mistakenly	 use	 such	 phrases	 as	 “Indian	 culture,”	 “white/black	 culture,”	 or	
“Western/Eastern	culture,”	to	describe	a	particular	culture	but	these	people	fail	to	acknowledge	
the presence of cultural diversity, or the presence of multiple cultures and cultural differences 
within a society. in reality, many different cultural groups exist today in india and most 
developing and developed countries. 

Diversity in the workforce means employing people without discrimination on the basis of 
gender,	age	and	ethnic	or	racial	background.	Since	globalization	is	the	current	overwhelming	
trend in business, diversity in the workplace is a better accepted and applied concept now 
more than ever. there are different kinds of diversity that one encounters at the workplace. 
these include diversity of gender, age, psychology, education, language and culture.
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Using paragraphs you can break continuous text to one or more sentences. this way, it is lot 
easier for the readers to understand and enjoy the content. in this exercise, you will learn to work 
with paragraphs and layouts. 

Have you tried to make a professional looking resume? One important part of working with a 
resume involves alignment. For the sake of both professional appearance and accessibility, it is 
conventional for similar parts of a resume to all line up along the same vertical axis. So that all the 
bullet points are aligned, and so are the headers, and sections. You may come across situations 
where some bullet points don’t line up, or where there are many empty spaces that complicate 
editing and revising. So now what do you do? 

1. Open a new document in word processor. Click on the Page Layout tab on the Ribbon. 

2. Click on the  icon under Paragraph group, as shown below. 

3. the Paragraph dialog box appears. You can see the options for automatic alignment, spacing, 
etc. that you can setup while composing the document itself instead of doing the alignment 
towards the end. 

4. Click on Tabs... button, tabs dialog box appears. 

5. You can specify the tab stop position by mentioning the stopping position in the Tab stop 
position box. After specifying the tab stop position click on Set button and the Tabs window 
appears. 

	 Note:	You	can	also	the	set	the	initial	tab	stop	position	value	from	the	default	value	(0.5”)	by	
specifying the new value under Default tab stops. You may specify the value at which the 
tab	stops	by	giving	the	value	specified	along	with	the	unit	(like	7cm,	etc.)	

6. Click OK.	The	ruler	of	the	document	will	be	marked	with	a	L	shaped	symbol	at	2”,	meaning	
that the tab stop position has been set at that position. now when you press the tab key, the 
cursor will automatically jump from its initial position to the next tab stop position. And this 
solves your problem too!

Figure 1
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Note: You can also set the tab stop position by clicking at the required point on the ruler. 

now open a new document, type some text and press Enter. notice that the continuous text is 
automatically	formatted	as	paragraphs,	with	the	size	that	you	have	specified	in	the	Tabs	Dialog	
box. 

exerCiSe 

Perform	the	following	activities	till	you	are	confident:

S.No. Activities 
1. Create the details given below (the tab descriptions are provided as a hint for you): 

Figure 2
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2 Create the one page of table of Contents of this book using a word processor. Save this 
document	with	the	name	TOC_{your	name}.	You	will	use	it	in	the	next	exercise	

ASSeSSmeNT 

Fill in the blanks:

1. _______________ can be used to break continuous text to one or more sentences.

2. Paragraph group is available under _____________. 

3. Default tab stop position is __________ . 

SeSSioN 2: mANAgiNg HeADerS 

Headers are text or images included at the top of the page. they usually contain important 
information such as company or department name, logo, page numbers, name of the author, etc. 
separated from the work or actual document area. 

Look at the following example: 

Notice	the	header	in	the	above	document;	the	title	“Application	From,	June	2012”	will	be	included	
on all pages of this document. 

in this exercise, you will learn to include a header to a document. 

to understand and work with headers, open a new document in word processor

Figure 3
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1. Click on the Insert tab on the Ribbon. 

2. Click on the option Header in the Header & Footer group, as shown below. 

3.	 A	drop	down	list	appears	which	lists	predefined	header	options	(Figure	below).

Now	 try	 inserting	any	of	 the	predefined	options	 from	 the	 list	 and	observe	 the	 changes	at	 the	
header area of the document. 

You can insert the page number at any position within the header area by selecting the alignment 
option under Page Number. You can also change the number format for page numbers by clicking 
Format Page Numbers... under Page Number options. the Page Number Format dialog box 
appears as shown below. 

Figure 4

Figure 5
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You can insert date and time by clicking the Date & Time option available under Insert Group. 
You can choose the date and time format from the available formats. 

You can also insert a picture or clipart within the header. this option can be useful in situations 
when you need to insert company’s or an event’s logo. try inserting a picture or a clipart into the 
header using the Picture and Clip Art option under Insert Group; observe the changes made to 
the document. 

exerCiSe 

Perform the following activity till you are confident:

S.No. Activities 

1. Open	 the	 file	 saved	 in	 the	 last	 exercise	 (saved	 as	 TOC_{your	 name}).	 Give	 an	
appropriate name in the center of the header section with your School name on the left 
hand side. Download a logo from the internet or use a picture (insert>Picture) on the 
right	hand	side.	Save	the	file.	

ASSeSSmeNT 

Fill in the blanks: 

1. ______________ can be used for inserting information at the top of each page 
automatically. 

2. Header option is available under ____________ group in insert tab. 

Answer the following: 

1.	 List	any	five	items	that	can	be	added	to	the	header	area.	

Figure 6
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SeSSioN 3: mANAgiNg FooTerS

relevant Knowledge

Footers are text or image included at the bottom of the page and may repeat in all pages of the 
document. the procedure for creating a footer is similar to that of headers. 

For example, if you wanted to create a text book, you can include the name of the text book using 
the headers and the page numbers using the footer option. this makes the document look neat 
and	organized.	

to insert footer to a document, open a new document in Word processor 

1. Click on the Insert tab on the Ribbon. 

2. Click on the option Footer in the Header & Footer group, as shown below.

3.		 A	drop	down	list	appears	which	lists	collection	of	predefined	Footer	options	

now try inserting date and time, page numbers, pictures and clip arts in the footer area and 
observe the changes.

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. Create	a	one	page	article	on	“Influence	of	Gandhiji	on	Youth	Today”.	Insert	a	picture	of	
Gandhiji and the title of the article in the header. insert your name, class and date in the 
footer.	Save	as	Gandhiji_{your	Name},	print	and	submit	this	article	to	your	facilitator	for	
evaluation. You may try the same in Google docs too. 

Figure 7
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ASSeSSmeNT 

Fill in the blanks 

1. ______________ can be used for inserting information at the bottom of each page 

automatically. 

2. the Footer option is available under ____________ group in the insert tab. 

SeSSioN 4: mANAgiNg STYLeS

relevant Knowledge 

Styles	 or	 Style	 sets	 are	 pre-defined	 or	 customized	 options	 used	 for	 creating	 good	 looking	
professional	documents	with	least	efforts.	You	can	find	a	number	of	styles	available	within	word	
processor that can be applied to a document. in this exercise, you will learn to apply and manage 
styles. 

to work with styles, open a new word document in word processor, 

1. to view list of styles, locate the Style group under Home tab (Figure below) 

2. if you would like to view the list of style sets available, point to Style Set under Change 
Styles option. A drop-down with different styles will be displayed (Figure below). 

Figure 8
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Select	any	of	the	styles	listed	by	clicking	it.	The	entire	document	will	change	to	the	specified	font	
or color automatically.

exerCiSe  

Perform the following activity till you are confident: 

S.No. Activities 

1. Open	the	article	on	“Influence	of	Gandhi	 ji	on	Youth	Today”	created	 in	 the	previous	
session and try using elegant, formal, fancy and manuscript style sets on different 
sections of the document and observe the changes. 

 

ASSeSSmeNT  

Fill in the blanks: 

1.	 __________	are	customized	options	 for	creating	professional	 looking	documents	with	 the	
minimum efforts.

2. You can change styles by using the ____________ group under the Home tab.

Figure 9
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SeSSioN 5: DoCUmeNT TemPLATe

relevant Knowledge

Templates	or	document	 templates	refer	 to	a	sample	fill-in-the-blank	document	 that	can	help	 in	
saving	time.	Usually	templates	are	customized	documents	that	may	have	sample	content,	themes,	
etc. For example, if you want to create a resume you can use a resume template and modify only 
the sections that require changes. 

in this exercise, you will learn to work with document templates. 

to view sample templates available with your word processor, 

1. Go to File > New. You will be displayed with different types of templates (Figure below). 
For example, if you would like to create a letter, you can select the Letters option under  
Office.com Templates section. 

Suppose	 you	 need	 to	 create	 certificates	 for	 a	 recently	 held	 competition,	 you	 can	 select	 the	
Certificates	option.	You	will	be	displayed	with	a	list	of	Certificate	templates.

now select any of the templates by double-clicking on it. 

A	sample	certificate	window	similar	to	the	one	below	appears.	Now	you	can	use	this	template	and	
customize	the	contents	by	replacing	the	school	name,	student	name,	etc.	

Figure 10
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You can also download other types of templates from websites. Some of the websites that offer 
free templates are: 

•	 office.microsoft.com/templates	

•	 www.thepapermillstore.com	

•	 openoffice.blogs.com/openoffice/templates/	

•	 www.docstoc.com	

You can visit the above mentioned websites to search, download and use a template that suits 
your needs. 

Creating a new document based on a template can save you time and effort because all the 
work it takes to design the document has already been done. You may use the templates that 
come with word processing software, or downloading templates created by other people, or you 
can also create and save your own templates for future use. First of all, you need to create a 
document that will serve as the template. 

Note: You create the template as a normal document, but the magic step is where you save it. 
Click on File >Save As, and give the template a name. Select Word Template from the Save as 
type: drop down list. 

notice that there is a Templates folder within Microsoft Word. if you save your template there, then 
we’ll be able to see the template in the My templates category. So select that and click Save. 

now to use the template, click on the File > New. Go to My templates, and as you scroll down, you 
will	find	the	file	{your	name}_Invoice	,	the	template	you	just	created.	Select	that	and	click	OK. 

notice that this is a new document and it’s not the template. So, we’ve just created a new document 
based on one of your own templates. now when you save this document, it gets saved as a 
normal	.docx	file.

Figure 11
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exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 
1. Download and use templates from the internet 
2. You will now create a template of an invoice. An invoice is just the kind of document 

that needs to have a set format and one that will be created over and over again. 
Save	the	file	with	the	name	–	{your	name}_Invoice.	

Hint on how to create an invoice: You can divide the invoice into 3 main parts: the Header, 
Body and Footer. 

the invoice header may contain Your letterhead : (Your business name, address, telephone 
&	email	and	web	address	if	available);	the	word	“Invoice”	or	“Bill”	clearly	written	towards	the	top	
of the page; an invoice number (this a running serial number that you maintain and should be 
unique for every invoice); an invoice date; Your payment terms or how soon you expect to be 
paid	e.g.	“COD”,	“Cash”,	”30	days”	etc.;	your	customer	or	client name and address; “our ref#” 
or	“Our	Reference”	(here	you	can	enter	your	quotation	number	if	you	issued	a	quotation	prior	to	
the invoice) ; “Your ref#”	or	“Customer	Ref”	(if	you	were	given	a	Purchase	order	or	Work	Order	
by your customer, here you should enter the PO or WO number so the customer can match your 
invoice with their own paper work). 

the invoice body could have a description of the goods you are supplying, quantity, unit of 
measure, price per unit and total amount for individual items. in the case of services, your brief 
scope of work and amount for individual items. You may specify information in a tabular form. 
You	are	creating	a	template,	so	you	need	to	just	create	the	skeleton,	the	details	will	be	filled	in	
when you use the template and make multiple invoices. the invoice footer could have a Total 
Amount of all individual items; Payment instructions (only if necessary! this tells recipients 
how to make their cheque payment, whom to address it to etc. if you expect payments by bank 
transfer, you should provide your bank account number and details here.); other comments 
(delivery instructions, goods return policy, overdue payment policy etc). 

ASSeSSmeNT  

Fill in the blanks: 

1. templates or document templates refer to a __________________ document. 

2. Creating a new document based on a _____________ can save you ____________ because 
_____________________________.
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SeSSioN 6: WorKiNg WiTH PAge AND SeCTioN BreAKS

relevant Knowledge
Page and Section breaks can be used to separate a document into sections. 

if you would like to start a new page in a document, you can use a page break. 

to separate a section in a document, you can use the section break. For example, you can lay out 
part of a single-column page as two columns. You can separate the chapters as separate sections 
in your document so that the page numbering for each chapter begins at 1. You can also create 
a different header or footer for a section of your document. For example, if you are creating a 
textbook and you can create different sections for digital literacy, word processing, spread sheets, 
etc. 

to work with breaks, open a new document in the word processor and type some contents. if you 
need another fresh page, choose the page break option in the Page Layout tab. 

a) Click on the Page Layout tab on the Ribbon. 

b) Click on the option Breaks in the Page Setup group (Figure below).

c) A dropdown list with options for different types of breaks appears. An explanation is given for 
each type of page or section break. 

A page break can be inserted anywhere in a document to force the end of a page and the beginning 
of a new one. 

to create a new page, you can keep pressing enter and the cursor moves from line to line till a 
new page starts. But if you add content to the previous page, the content of the new page will 
automatically shift! 

to avoid such problems, there is an easier method – use a page break and start a fresh page! 
You may also use a page break when you want to be sure that a new chapter or sub-heading 
automatically starts at the top of its own page. 

Figure 12
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Section	breaks	add	flexibility	to	formatting	your	document.	Using	them,	you	can	create	different	
headers and footers, different footnote numbering, change the layout of columns, change page 
borders for different pages, and even change page layouts in the same document! Using section 
breaks is like having mini-documents in one large document. 

A section break controls the formatting of the document content that precedes it, until it reaches 
another section break. For example, if you have a 10 page document, with a section breaks on 
page 3 and on page 8, the section break on page 3 controls the formatting of pages 1, 2, and 3 
while the section break on page 8 controls the formatting for pages 4 to 8. 

You need to be able to see where your section breaks or page breaks are inserted in order to 
see where the formatting stops and ends or to delete them. to see a section/page break, click 
the Show/Hide button on the Home tab in the Paragraph section. the section/page breaks are 
displayed in your document. 

1. Click on the section/page break. 

2. Press Delete on your keyboard and the section/page break is removed. 

Anytime you need to add a page border to a single page or have a table in Landscape orientation 
with the rest of the document in Portrait orientation, try using section breaks to make the task 
easier!

Figure 13
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exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. Create Page and Section breaks 

2. Delete Page and Section breaks 

3. Open a new document. Divide your page into two columns. (Page Layout>Columns). 
Pick up an article from a newspaper and key it in. try using column break and page 
break anywhere in the text. 

4. Open a new document. type in the heading of your Local newspaper. Use section break 
and	divide	the	next	section	into	columns	and	key	in	an	article.	Save	the	document	file	
as	Newspaper_{your	name}	and	print	your	document.	

ASSeSSmeNT   

Fill in the blanks 

1. _____________ & _________ breaks can be used to separate a document into sections. 

2. Using page breaks, you can create different ____________________________. 

3. A section break controls the __________ of the document content that ________ it, until it 
reaches another section break. 

4. to see a section/page break, click the ________ button.

SeSSioN 7: APPLYiNg CHArACTer FormATS 

relevant Knowledge 

If	you	are	creating	a	textbook	with	scientific	content,	you	need	to	use	special	formatting	for	some	
characters. Character formatting can be applied to a single character or word. 

in this session, you will learn to perform character formatting. 

Working with Character Formatting 

to work with character formatting, 
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a. Open a new document in word processor and type the following paragraph: 

now to make changes, you may need to format the characters as shown below. You will notice 
that some words of this paragraph are in bold, some are in italics, some are underlined, some are 
in colour and some are changed in its position (superscript & subscript). 

b. in order to apply formatting to the contents in the document you must select the concerned 
word or group of words. 

Use the following options to make changes to a character or word: 

Font Face: After selecting the text you need to click Font name in the Font group to select the 
particular font style from the fonts listed. 

Font Size: After	selecting	 the	 text	you	need	 to	click	Font	Size	 in	 the	Font	group	 to	select	 the	
particular	font	size	from	the	values	given.

grow Font: After selecting the text you need to click the  icon in the Font group to make the 
font	size	larger	than	the	current	font	size	by	the	specified	point.	

Shrink Font: After selecting the text you need to click the  icon in the Font group to make the 
font	size	smaller	than	the	current	font	size	by	the	specified	point.	

Strikethrough: After selecting the text you need to click the  icon in the Font group to make a 
strike through the middle of the selected text. 

Subscript: After selecting the text you need to click the  icon in the Font group to make the 
selected text lower than the normal text position. 

Superscript: After selecting the text you need to click the  icon in the Font group to make the 
selected text higher than the normal text position. 

Water is a chemical substance with the chemical formula H2O. A water molecule contains one 
oxygen and two hydrogen atoms connected by covalent bonds. Water is a liquid at ambient 
conditions, but it often co-exists on Earth with its solid state, ice, and gaseous state (water 
vapor or steam). WAtER also exists in a liquid crystal state near hydrophilic surfaces. the 
density of water is 1,000 kg/m3.

Water is a chemical substance with the chemical formula H2O. A water molecule contains one 
oxygen and two hydrogen atoms connected by covalent bonds. Water is a liquid at ambient 
conditions, but it often co-exists on Earth with its solid state, ice, and gaseous state (water 
vapor or steam). Water also exists in a liquid crystal state near hydrophilic surfaces. the 
density of water is 1,000 kg/m3. 
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Clear Formatting: Clear Formatting is used to clear the character formatting (such as Bold, 
Italics	,Underline,	font	face	&	size,	superscript	&	subscript	etc.)	of	the	selected	text.	To	remove	the	
character formatting, select the text and click on  icon in the Font group. 

Text Highlight Colour:  Use this option to change the background colour. to do so, select the 
text and click on  icon in the Font group. You can choose the background colour by clicking 
on the down arrow on the icon. 

Font Colour: Use this option to change the colour of the text. to do so, select the text and click 
on  icon in the Font group. You can choose the text colour by clicking on the down arrow on 
the icon.

Change Case: Word processor helps us to change the text case to capital letters or small letters. 
You	can	also	capitalize	each	word	in	the	sentence	and	capitalize	the	starting	word	of	the	sentence	
using Change Case under Font Group. to do so, after selecting the text you need to click the  
icon in the Font group 

Sentence Case: On	selecting	this	option	from	the	dropdown	list,	 the	first	character	 in	 the	first	
word of the selected sentence will be converted to Capital Letter (Uppercase). 

Lowercase: On selecting this option from the dropdown list, the selected text will be converted to 
Small Letters (lowercase). 

UPPERCASE: On selecting this option from the dropdown list, the selected text will be converted 
to Capital Letters (UPPERCASE). 

Capitalize Each Word: On	selecting	this	option	from	the	dropdown	list,	the	first	character	in	all	
the words of the selected sentence will be converted to Capital Letter (Uppercase). 

Figure 14

Figure 15
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tOGGLE cASE: On selecting this option from the dropdown list, the small letters in the 
selected text will be converted into capital letters and capital letters will be converted into 
small letters. 

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. Change font face 

2. Change	font	size	

3. Change font color 

4. Highlight text 

5. Change text case 

6. Reopen	 the	 document	 created	 in	 the	 previous	 exercise	 Newspaper_{your	 name}.	
Decorate	the	first	page	of	your	article	using	each	one	of	 the	character	 formats	you	
have learnt in this exercise. take a printout of page 1 of the document and compare it 
with the printout taken in the previous session.

ASSeSSmeNT  

Fill in the blanks: 

1.	 After	selecting	the	text	you	need	to	click	the	_______	in	the	Font	group	to	make	the	font	size	
larger	than	the	current	font	size.	

2. to remove the character formatting, select the text and click on ______in the Font group. 

3.	 On	selecting	_______________________,	the	first	character	in	the	first	word	of	the	selected	
sentence will be converted to Capital Letter. 

4.	 On	selecting	_______________________,	the	first	character	in	all	the	words	of	the	selected	
sentence will be converted to Capital Letter. 
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SeSSioN 8: iNSerT grAPHiCAL oBJeCTS AND iLLUSTrATioNS

relevant Knowledge 

Often when you write a technical report, or a newsletter or even letter to friends, including some 
form of graphics makes the document more interesting! 

in a technical report, you may want to incorporate a graph of corporate performance or a technical 
illustration. While in a newsletter or letter to family and friends, you enjoy sharing memorable 
events that are represented by photos or maybe even cartoons. the facility to blend these graphics 
into the document is part of the charm and power of every major word processing program. 

But	not	only	can	we	blend	graphic	images	into	our	message,	but	Word,	WordPerfect	and	OpenOffice	
also	allow	us	to	blend	in	other	special	features.	These	features	are	generally	known	as	“objects”.	
These	objects	can	be	almost	any	form	that	can	begenerated	as	a	computer	file.	Sounds,	Music,	
drawings, documents spreadsheets, etc. are all examples of possible objects that you can include 
in a document, or link to a document. 

note: Embedding an object makes it part of the document while linking an object does not include 
the	object	file	into	the	document	files.	Readers	trying	to	access	the	linked	object	must	also	have	
direct	access	to	the	separate	file	that	forms	that	object.	That	may	mean	they	have	to	have	access	
to your hard drive in order to see the linked object. 

Most Word processors has support for inserting illustrations in the form of Clip Arts, Shapes, 
pictures, charts, etc. 

Clip	Art	can	help	in	making	a	document	look	colourful	and	presentable.	Clip	arts	are	pre-defined	
images available for use in documents. For example, if you would like to create a greeting card for 
your	friend,	you	can	use	clip	arts	such	as	balloon,	flowers,	etc.	along	with	text	message.	

You can use the clip art gallery built-in within the word processor; you can also download clipart 
from websites. Some of the websites that have free clip arts are: 

•	 www.openclipart.org	

•	 www.pdclipart.org	

•	 www.clker.com	

•	 www.freeclipartnow.com	

•	 www.wpclipart.com	

in this exercise, you will learn to use Clip Arts. 

a) To insert a clip art in a document, 

1. Open a new document in word processor
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2. Click on the insert tab on the Ribbon. 

3. Click on the option Clip Art in the illustrations group (Figure below). 

4. the Clip Art task Pane appears. Enter the clipart category name in the search box and Click 
Go.	For	example,	if	you	want	to	insert	a	logo,	type	logo	in	the	search	box	and	Click	“Go”.	

5. Once you click Go (Figure 17), a window appears along with list of clip arts matching the 
search keyword (Figure 18). 

Figure 16

Figure 17
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Figure 18

Select the clipart that you want to use, double-click on it and it will be inserted into your document. 
Sometimes, you may need clip arts that may not be available within the word processor application. 
in such cases, you can visit websites that offer clip arts such as OpenClipart.org. 

now, you will learn to download a clip art from a website and use it in your document. 
b) To download a clip art from www.openclipart.org, 
1. Open the web browser, type www.openclipart.org in the address bar and press Enter 

You can use the search box available on the website for viewing the list of clip arts to suit your 
needs. For example, type School Bag in the search box and Click Search. 

You will be displayed with list of clip arts matching the keyword School bag, similar to the one 
below.

now you can select the clip art you like, download it to your computer and insert it using the photo 
option in the word processor. 

Figure 19



140

Unit-3

exerCiSe 
Perform the following activities till you are confident: 

S.No. Activities 

1. insert pictures and Clip art in a document 

2. Open	a	new	document.	Search	 for	 “Birthday	Balloons”	 in	Clip	Art.	Select	one	 from	
what is made available and make a one page birthday card for a family member

3. 
Download a few clip arts from the net and design a poster on Earth Day. in this exercise, 
you will only insert the appropriate pictures. You will insert relevant text in the next 
exercise. 

ASSeSSmeNT  

Fill in the blanks:

1. Embedding an object _____________ the document while linking an object does 
____________	into	the	document	files.	

2.	 Readers	trying	to	access	the	linked	object	must	also	have	__________	file	that	forms	that	
object. 

3. Clip Art can help in making a document look ___________and_______________. 

4. Clip Art is available under ___________ illustrations group in insert tab 

Answer the following: 

1. List any two websites that offers free clip arts. 

2. What are Objects in a Word processing software?

SeSSioN 9: TexT WrAPPiNg

relevant Knowledge 
You have learnt to insert graphics and illustrations in the last exercise. How do you want the text 
to	fit	to	the	picture?	Do	you	want	a	graphics	to	stand	alone	with	text	above	it	and	below	it?	Do	you	
want the text to be along one side of the graphics? Do you want to have the text message split so 
that part of the text is on the left side and then continue on the right side of the graphics? Do you 
want the text to run right across the graphics? All these options are possible depending on the 
text wrap options you choose. 
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What if the graphic image is too large, or too small? this is a problem you may face when placing 
graphic images into a document. in all word processing software, if you select the image (left 
mouse click on it) control handles will appear on the sides and on the corners of the graphics. 
When you place your mouse on these handles, the cursor changes to a double headed arrow and 
you	can	click	and	drag	the	handle	in	or	out	to	decrease	or	increase	the	size	of	the	picture.	In	this	
exercise, you will learn to use text wrapping. 

open a new word document and type the following: 

You	 can	 either	 include	 a	 screenshot	 of	 the	OpenOffice	Writer	 or	 search	 for	 a	 picture	 in	 your	
computer. 

to take a screen shot, simultaneously press <Shift> and <Print Screen> keys. Place the cursor 
on the right of the text and simultaneously press <Ctrl> and <V> keys. 

to search for a picture, place the cursor before the text, click insert tab, and click Picture under 
illustrations. Browse for the picture and click insert. 

Apache	OpenOffice	Writer	is	the	word	processor	component	of	the	OpenOffice	package.	It	is	
free and is available for a variety of Operating Systems including Windows, Linux, FreeBSD 
and Solaris. it is capable of opening and saving documents in a variety of formats.

Figure 20

•	 Once	you	have	inserted	the	picture,	you	can	wrap	the	text	by	using	the	Wrap Text option 
under Text section of the insert tab after double-clicking on the picture (Figure below). if you 
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now try selecting different Wrap text options such as Square, Tight, Through, etc. and observe 
the changes made to the wrapping. A screen shot when the Square option was used is shown 
below: 

Figure 21 

Figure 22

are working on Word, select the picture then select the Text Wrapping dropdown arrow in 
the Arrange group under the Format tab. 



143information technology 

Unit-3

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. Wrap text around a picture 

2. Reopen	the	document	you	had	created	in	Exercise	1,	Gandhiji_{your	Name}.	Search	
for an appropriate picture of Gandhiji and try all the text wrapping options. Select 
the	one	you	feel	suits	the	best	and	take	a	printout	of	your	modified	article.	Save	your	
document	with	a	different	name	Gandhiji2_{your	Name}.	

 

ASSeSSmeNT  

Fill in the blanks: 

1. to search for a picture, place the cursor _______ the text, click insert tab, and  click _______ 
under illustrations. 

2. After you have inserted the picture, you can wrap the text by using the _______ option. 

Answer the following: 

1. List any three word wrapping options available in a word processing software. 

SeSSioN 10: iNSerTiNg oBJeCTS

relevant Knowledge

in addition to graphic images, to add a personal touch to a special message or to illustrate a 
special	feature,	you	may	want	to	embed	sound	files	or	maybe	even	actual	files	from	other	software	
applications	in	your	document.	For	example,	you	can	insert	a	PDF	file	or	a	spread	sheet	within	
the word processor. 

in this exercise, you will learn about inserting objects in a document. 

to insert an object, 

•	 Open	a	new	word	document	

•	 Select	Insert	Tab	

•	 Click	Object	under	Text	section.	A	dialog	box	will	be	displayed,	as	shown	in	figure	23.
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•	 Select	Create from File tab 

•	 Click	Browse	and	select	a	file	such	as	a	spread	sheet	or	a	PDF	document	that	is	available	
on your computer, Click Open and Click OK 

•	 Notice	the	document	is	available	embedded	within	your	word	document.	

Note: if you would like to edit the embedded document, double-click on it. it will automatically 
open it for editing using respective application. 

now try inserting different types of document using the procedure mentioned above. 

Note: 1. the embedded objects cannot be printed.

2. the person opening your document must have the relevant software loaded on their computer 
to	operate	the	embedded	file.	

3.	 If	you	embed	an	object,	the	size	of	your	document	increases	significantly	and	this	may	cause	
problems in emailing the document as an attachment. 

4. if you link an object, the person opening that document must have a direct connection to the 
original	file	location	of	the	object.

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. insert objects in the text

Figure 23
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ASSeSSmeNT  

Fill in the blanks: 

1. to open an embedded document, ___________ it. 

2. Embedded objects ______ be printed. 

3. When you embed objects in a document, you may have trouble emailing it because ______
______________________________________________.

SeSSioN 11: iNSerT SHAPeS, SYmBoLS AND SPeCiAL CHArACTerS 

relevant Knowledge

You can insert objects that have different shapes such as lines, basic geometric shapes, arrows, 
equation	shapes,	flowchart	shapes,	stars,	banners,	and	callouts	using	the	shape	option.	

in this exercise, you will learn to work with shapes in a word document. 

a) To work with shapes, open a new document in word processor, 

1. Click on the Insert tab on the Ribbon. 

2. Click on the option Shapes in the Illustrations group,	as	shown	in	figure	24.	

3.	 Once	you	click	the	Shapes	option	a	dropdown	list	with	pre-defined	shape	such	as	box,	circle,	
etc. appears. 

4. You can select the shape from the list of shapes available and draw the shape by dragging 
the mouse with the left button clicked. For example, if would like to insert a square, select the 
box shaped item from the list, click and drag the shape to draw a square. 

Figure 24
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now try inserting other shapes from the list available and work with them by changing colors or 
adding content inside them. 

in some cases, you may need to insert special characters or symbols in documents such as 
currency sign of a different country, copyright or trademark symbols, etc. in this exercise, you will 
learn to insert symbols or special characters. 

b) To work with symbols or special characters, open a new document in word processor. 

1. Click on the Insert tab on the Ribbon. 

2. Click on the option Symbol in the Symbols	group,	as	shown	in	figure	25.

3.	 A	dropdown	list	appears	(figure	26).	

Select a symbol from the list and double-click on to insert the symbol into the document. 

if you would like to view more symbols and special characters for inserting into a document, click 
on the more Symbols… option in the Symbols Dropdown list. 

Figure 25

Figure 26
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exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Use different shapes, symbols and special characters in a document. 

2. Create a two page brochure for nainital or any other tourist spot near your town. the 
brochure must include pictures. Wrap the text around the pictures. it must also include 
a places to see, hotels to stay in and details of how to reach the place. 

3. Open	a	new	document.	Create	the	basic	flowchart	diagram	as	shown	below	

ASSeSSmeNT  

Fill in the blanks: 

1.	 You	can	insert	 lines,	basic	geometric	shapes,	arrows,	equation	shapes,	flowchart	shapes,	
stars, banners, and callouts using the ___________ option. 

2. Symbol option is available under _________________ group in the insert tab. 

Figure 27
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SeSSioN 1: USe AUToSUm iN CeLLS 

relevant Knowledge

You have learnt to navigate in a spreadsheet, populate cells, and perform calculations. As you 
know, a spread sheet offers various mathematical functions to perform the calculations. Sum is 
one of the functions available in the spread sheet to perform addition of selected numbers in the 
sheet. in this exercise, you will learn how to use autosum function to perform addition in a spread 
sheet. 

Autosum is used for adding the values given in cells automatically without writing the formula to 
perform the operation. 

Open a new spread sheet and enter the following data. 

Now to total the marks of each of the students, do the following: 

•	 Go	to	cell	G2.	While	 the	cell	G2	 is	selected,	click	on	the	AutoSum	option	available	under	
Editing Group in the Home tab. 

•	 The	values	in	the	cells	from	c2	to	f2	will	be	automatically	selected	as	shown	below.	

Figure 1

Figure 2
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•	 Press	Enter. 
o the total marks of Abhas appears in cell G3. 
o Similarly, calculate the total marks of the rest of the students. 

Note: Autosum	automatically	selects	the	values	around	the	cells	either	horizontally	or	vertically.	In	
the	above	example	you	want	to	perform	addition	of	numbers	listed	from	left	to	right,	after	finding	
the total of two persons when you try to perform autosum for another person the values on top 
of the current cell get selected. in that case, you have to select the cell values that you want to 
perform addition. 

now change the marks of one of the students in one or more subjects. the total marks of that 
student will get calculated automatically. Automatic calculation of formulas is one of the most 
powerful features of electronic spreadsheets.

 exerCiSe  

Perform the following activities till you are confident:
S.No. Activities

1. Calculate without writing the formulae using the Autosum function
2. Create a list of all your personal expenses made during the month and calculate the 

total expenses using the autosum function 
3. Create a list of names of the month and holidays in that month. Add and calculate the 

total number of holidays in a year using the autosum function 

Figure 3

Figure 4
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ASSeSSmeNT  

Fill in the blanks:

1. _____________________________of formulas is one of the most powerful features of 
electronic spreadsheets. 

2. ________________ is used for adding the values given in cells automatically without writing 
the formula. 

3. AutoSum option is available in _________________ group under the Home tab. 

4. Autosum automatically selects the values around the cells either _____________ or 
______________. 

SeSSioN 2: CoNDiTioNAL FormATTiNg 

relevant Knowledge

Conditional formatting allows you to change the formatting (font color, border, shading) of the cells 
based on the values in it. Yes, you can do that manually, but it can be a tiresome task if you have 
a huge amount of data. So, you specify a condition for the values in the cell, and if the condition is 
satisfied	then	automatically	the	formatting	of	the	cell	changes.	This	feature	would	be	very	useful	
if	you	were	working	on	a	profit	and	loss	spreadsheet,	or	a	temperature	variance	spreadsheet,	or	
a	marksheet.	You	could	highlight	cells	that	have	values	are	greater	than	a	defined	rule	with	one	
color and those less than another with a different color. 

Basically, you can select one or more cells, and create rules (conditions) for when and how those 
cells are formatted. the conditions can be, based on the selected cell’s contents, or based on the 
contents of another cell. 

You can control the following formats: 

•	 Number	format	

•	 Font,	font	style,	and	font	colour	(but	not	font	size)	

•	 Fill	colour	and	fill	pattern	

•	 Border	colour	and	border	style	(but	not	border	thickness)	
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open a new spreadsheet and enter the following data. 

Now to apply conditional formatting for the data do the following. 

•	 Select	all	the	cells	you	want	to	format	conditionally.	

•	 Click	on	Conditional Formatting option available under Styles group in the Home tab. A 
drop down list appears. 

Click on Highlight Cells Rules option, a submenu appears. 

•	 Note: you can select the condition listed according to your needs. in this example if you want 
to	highlight	the	values	that	are	greater	than	75,	select	“Greater	Than...”	available	under	the	

Figure 5

Figure 6

Figure 7
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submenu. A dialog box appears. 

•	 Specify	the	value	in	the	box	and	click	on	the	down	arrow	next	to	the	with	field	and	select	a	
predefined	format	for	the	condition	from	the	drop	down	list.	If	you	want	to	highlight	the	cell	
contents with your own formatting style click Custom Format option in the dropdown list. 

•	 A	Format Cells dialog box appears. You can select a different font color under Font tab, 
border	style	and	color	under	Border	tab	and	fill	color	under	Fill	tab.	

•	 Go	ahead	and	create	the	data	below	and	format	it	in	the	manner	displayed.	

Note: Similarly you can set various conditions for the selected value like less than, equal to, 
between etc. 

Optionally, you can also specify the cell address where the value is stored. this can be very 
helpful as simply changing the value in one place can change the conditional formatting all over 
the	previously	selected	range.	An	example	is	shown	in	the	figure	below.	

Figure 8

Figure 9

Figure 10 
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The result is displayed below. 

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1. Perform conditional formatting on a data subset 

2. Create	a	student	mark	list	of	at	least	10	students	and	five	subjects.	Highlight	the	marks	
of	 the	students	who	got	marks	greater	 than	80	with	green	colored	 text	with	blue	fill.	
Save	the	worksheet	as	Marks_{your	name}.	

ASSeSSmeNT  

Fill in the blanks:

1. _________________conditional formatting allows you to change the formatting (font color, 
border, shading) of the cells based on the values in it. 

2. Conditional formatting is available under _______________ Styles group in Home tab. 

Answer the following: 

1.	 List	any	five	conditions/formats/items	that	can	be	used	for	conditional	formatting.	

 

Figure 11 
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SeSSioN 3: HiDe / UNHiDe / FreeZe roWS AND CoLUmNS 

relevant Knowledge 
Sometimes you have data in rows and columns which are needed for formulas or charts, but you 
do not want the data to be visible. A very handy feature of a spreadsheet is the ability to hide a 
row/column that is not to be shown to the end user. the data in hidden row/column is available for 
calculations though not visible! 

Freezing	rows	and	columns	is	another	helpful	feature	in	a	spreadsheet.	When	you	are	dealing	
with a huge amount of data that spans several rows or columns, you may want the headers to 
remain	constant	 (frozen)	while	you	scroll	 through	 the	data	so	 that	you	can	see	 the	 identifying	
names of the rows/columns. 

open a new spreadsheet. To hide a row or column, do the following: 

•	 In	order	to	hide	any	row	or	column	you	can	either	select	the	particular	row	or	column	that	is	
to hidden or just one cell in the corresponding row or column (for example B3). 

•	 Click	on	Format option available under Cells group in the Home tab. 

•	 A	dropdown	list	appears	as	shown	below.	

Figure 12

Figure 13 
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•	 Click	on	Hide & Unhide > Hide Rows. the spread sheet will be displayed as shown below. 

Note: Alternatively, you can select the row/column, right click and select Hide. 

Note: in this example the cell in the 3rd row of the spread sheet was selected and then Hide Rows 
option was selected. So, the 3rd row is hidden. What would have happened if you had selected 
Hide Columns instead? 

•	 In	order	to	unhide	the	row	or	column	that	is	hidden	you	have	to	select	any	cells	before	and	
after the cell that is hidden then click Unhide Rows in the Format option available under 
Home tab. 

To freeze the rows or columns do the following. 

•	 Open	a	new	spread	sheet.	

•	 In	order	to	freeze	rows	or	columns	click	on	Freeze Panes option available under Window 
group in View tab. 

•	 A	drop	down	list	appears	as	shown	below.	Click	on	Freeze	Panes.	Doing	so	will	freeze	all	
the rows above and all the columns to the left of the selected cell. Scroll your mouse in the 
spreadsheet	the	frozen	rows	and	columns	remain	constant.	

Note: the panes are formed where your cursor is placed. Select the option again and notice the 
change	in	the	available	options!	Go	ahead	and	try	the	other	options	too.	You	can	also	freeze	the	
entire	row	or	column	by	selecting	the	entire	row	or	column	and	click	“Freeze	Panes”	to	freeze	the	
entire row or column.  

Figure 15

Figure 14
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exerCiSe 

Perform the following activities till you are confident:

S.No. Activities 

1. Hide/unhide rows/columns 

2. Freeze/unfreeze	rows/columns	

3. Create the worksheet given below, keeping your cursor on B2, try all the options 
of	 freezing	 cells	 and	 observe	 the	 effect.	 Take	 specific	 note	 of	 column	 and	 row	
movements.	Save	the	worksheet	as	expenses_{your	name}.	

ASSeSSmeNT  

Fill in the blanks: 

1.	 When	you	freeze	a	row,	____________	remains	constant.	

2.	 Freeze	Panes	option	is	available	under	_________	group	in	________	tab.	

3. the panes are formed where your __________ is placed.

SeSSioN 4: SeT PAge BreAKS

relevant Knowledge 

to print a worksheet with the exact number of pages that you want, you can adjust the page 
breaks in the worksheet before printing it. this feature is very useful especially when printing huge 
sheets. You can use the Page Break view to see how other changes (e.g. changing row height / 
column width) affect the automatic page breaks. 
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in this exercise you will learn how to set page breaks in the spreadsheet. 

Open a new spread sheet and create the sheet below. On the View tab, in the Workbook Views 
group, click Page Break Preview.  

Now to set the page break do the following. 

•	 To	insert	a	vertical	page	break,	select	the	row	below	where	you	want	to	insert	the	page	break.	
To	insert	a	horizontal	page	break,	select	the	column	to	the	right	of	where	you	want	to	insert	
the page break. 

•	 Click	on	Breaks down arrow under Page Setup group in the Page Layout tab. A dropdown 
appears as shown below. 

•	 Click	on	Insert Page Break option. the spread sheet will be displayed as shown below. the 
content	you	have	typed	comes	in	the	first	page	and	you	can	print	it.	

•	 To	move	a	page	break,	simply	drag	the	page	break	to	the	desired	location.	

Figure 16

Figure 17
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note: You can also remove the page breaks by clicking the Remove Page Break option in Breaks 
drop down list. 

To	 return	 to	 Normal	 view	 after	 you	 finish	 working	 with	 the	 page	 breaks,	 click	Normal in the 
Workbook Views group under the View tab.

exerCiSe  
Perform the following activities till you are confident:

S.No. Activities 
1. Set, move and delete page breaks 

2. Create the worksheet given below. Calculate the closing balance. Add 10 more items 
to	the	list	and	set	page	breaks	for	printing.	Move	page	breaks	if	contents	do	not	fit	
onto	 one	 page.	 Save	 this	 file	 to	 be	 used	 in	 the	 following	 exercise	with	 the	 name	
items_{your	name}.	

Figure 18
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ASSeSSmeNT  

Fill in the blanks 

1. to insert a _________ page break, select the row below where you want to insert the page 
break. 

2. to insert a ____________ page break, select the column to the right of where you want to 
insert the page break. 

3. the Breaks option is available under______________ group in the Page Layout tab. 

4.	 To	return	 to	Normal	view	after	you	finish	working	with	 the	page	breaks,	you	need	to	click	
_____________ in the _____________ group under the View tab. 

SeSSioN 5: SeT PAge LAYoUT 

relevant Knowledge
if you have a worksheet that contains a huge amount of data with many charts and you want a 
professional looking printout, what would you do? Spread sheet software provides various page 
layout	options	for	organizing	pages	using	the	Page	Layout	option.	In	this	exercise,	you	will	learn	
how to set the page layout options in the spread sheet application. Open a new spread sheet. 

To set the page layout options, do the following: 

•	 Click	on	Page Layout option under Workbook Views group on View tab. the spreadsheet 
will be displayed as shown below. You can set the 

	 •		Margins	

	 •		Orientation	

	 •		Page	headers	and	footers	

	 •		Hide	or	display	grid	lines	

	 •		Size	of	the	page	

	 •		Define	the	print	area	

	 •		Specify	the	background		
Figure 19
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•	 Click	on	Margins option under Page Setup group, a dropdown list appears as shown in 
figure	20.

•	 You	can	either	select	anyone	of	the	predefined	margin	option	available	or	else	you	can	define	
your own margin settings by clicking Custom Margins. option. A dialog box appears. 

•	 You	can	set	the	margin	values	manually	from	the	options	available	under	the	dialog	box.	

•	 You	 can	 set	 the	 orientation	 of	 the	 page	 to	 either	 Portrait	 or	 Landscape	 by	 clicking	 the	
Orientation option under Page Setup group in the Page Layout tab. 

•	 You	can	set	the	size	of	the	page	by	clicking	the	Size option under Page Setup group in the 
Page Layout tab. 

•	 You	can	specify	the	area	to	be	printed	by	selecting	the	area	and	then	clicking	Print Area 
option under Page Setup group in the Page Layout tab. A drop down list appears as shown 
below. 

•	 Click	on	Set Print Area to set the selected to get printed. You can also clear the print area by 
clicking the Clear Print Area option. 

Figure 20

Figure 21

Figure 22
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•	 You	 can	 specify	 a	 background	 for	 your	 sheet	 using	 the	Background option under Page 
Setup in the Page Layout tab. 

exerCiSe  

Perform the following activity till you are confident:

S.No. Activity 

1. Reopen	the	worksheet	created	in	the	previous	exercise	named	items_{your	name}.	
Modify the margins, view the document using print preview and observe the changes 

ASSeSSmeNT  

Fill in the blanks: 

1.	 Spread	sheet	software	provides	various	page	layout	options	for	organizing	pages	using	the	
_____________ View. 

2. Margins option is available under______________ group in the _____________ tab. 

3. two types of page orientation are __________________ & _______________. 

SeSSioN 6: mANAge WorKBooK VieWS 

relevant Knowledge 

Spread sheet offers the users with variable views for the purpose of viewing the outcome of the 
sheet while printing. 

There	are	five	types	of	views	available	in	the	spreadsheet.	

•	 Normal	

•	 Page	Layout	

•	 Page	Break	Preview	

•	 Custom	Views	

•	 Full	Screen	

You can select one of the above said views by clicking the appropriate option under Workbook 
Views in the View tab. 
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Normal View: the default view of the spreadsheet application is the normal. it’s a collection of 
cells arranged in the work area. 

Page Layout: You	can	select	the	Page	Layout	view	in	order	to	quickly	fine	tune	a	worksheet	that	
contains many charts or huge amounts of data and achieve professional looking results. 

Page Break Preview: this option is similar to the Page Layout option except you can set the area 
that is to be set as a page after inserting page break. 

Custom Views: if you would like to view selected areas of a document , you can use the custom 
view option. For example, if you would like to point out certain row and column, you can add that 
to the Custom view. 

Full Screen: Selecting this option makes the workbook cover the entire screen. All tabs are 
hidden from view. to get back the tabs, click on File> Restore. 

Additionally, in spreadsheet, you can open multiple windows that display the current spreadsheet 
and then arrange those windows in a variety of ways. You can also open and arrange multiple 
workbook windows. 

To open a second instance of a workbook in a separate window: 

•	 Click	the	New Window button on the View tab, in the Window group.  

To arrange multiple program windows: 

•	 Click	 Arrange All button in the Window group. An 
Arrange Windows dialog box appears. 

•	 Click	 either	 Tiled, Horizontal, Vertical, or Cascade 
options. 

•	 To	include	only	windows	displaying	views	of	the	current	
workbook, select the Windows of active workbook 
check box. 

•	 Click	OK. 

Figure 23

Figure 24



165information technology

Unit-4

exerCiSe 

Perform the following activities till you are confident:

S.No. Activities 

1. Reopen	 the	worksheets	created	 in	 the	exercises	SS	2	named	Marks_{your	name},	
SS3	named	expenses_{your	name}	and	SS	4	named	items_{your	name}	Using	the	
commands in the Window group on the View menu, tile the three windows, and then 
arrange them so that they overlap. Move each window separately and observe what 
happens in the others. try the Cascade and tile options too 

2. Use the new Window command to open a second instance of one of the workbooks. 
Then	arrange	only	the	two	windows	of	the	active	workbook	horizontally	

ASSeSSmeNT  

Fill in the blanks:

1. Different types of views are available under _______________ in the View tab. 

2.	 The	five	types	of	views	available	are	________	,	______,	______________,	______________	
& _________________________. 

3. the ________________ helps you to view a selected area of a workbook. 

SeSSioN 7: APPLY CeLL AND rANge NAmeS  

relevant Knowledge 

You	can	assign	names	 to	cells	 in	a	worksheet	and	use	 it	 for	quickly	 locating	specific	cells	by	
entering the names. this could be useful when working with large spread sheets. For example, if 
you	have	a	lengthy	list	of	groceries	and	prices,	you	can	use	names	to	quickly	locate	and	find	total	
pricing of fruits from the entire list. 

in this exercise, you will learn to work with cell and range names. 

Open a new spreadsheet and enter the following (figure below): 
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Now to apply range names, do the following: 

•	 Select	the	cost	against	the	cells	that	have	Apple,	Banana,	Cherry,	Grape,	Guava,	Mango,	
Pineapple values (Keep the Ctrl key pressed and click on the cells – you will be able to select 
selective cells together!). Right click and select Name a Range…. Alternatively, you can 
select Define Name under Defines Names group in the Formulas tab. 

•	 A	New Name dialog box appears prompting to enter a name. Enter Fruits in the Name field	
and click oK (figure	below).	

Figure 25

Figure 26
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•	 Select	the	cost	against	the	cells	that	have	Cabbage, Cauliflower, Chilli, Cucumber, Ginger, 
Potato, Pumpkin, Spinach, Tomato	values.	Right	click	define	the	name	Vegetables for this 
group. 

if you would like to calculate the total cost of fruits from the list, 

•	 Select	an	empty	cell	

•	 Type	Total	Cost	of	Fruits	and	in	the	adjacent	cell,	Type	=SUm(Fruits) and press enter. 

notice the total cost of all items named as Fruits is displayed. 

exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 

1  Apply names to cells and cell ranges and use them in formulae 

2. Using the worksheet created in this exercise, calculate the cost of Vegetables. Save 
the	workbook	as	Grocery_{your	name}.	

ASSeSSmeNT  

Fill in the blanks: 

1.	 Assigning	names	to	cells	in	a	worksheet	help	you	to	_________________	specific	cells.	

2.	 The	Define	Name	option	 is	 available	 under	 _________________	group	 in	 the	 ________	
tab. 

Figure 27 
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SeSSioN 8: CreATe moDiFY AND FormAT CHArTS 

relevant Knowledge 
A chart is a graphical representation of data, in which the data is represented by symbols, such 
as bars in a bar chart, lines in a line chart, or slices in a pie chart. A chart can represent tabular 
numeric data, functions or some kinds of qualitative structures. 

A Spread sheet enables you to create, modify and format charts based on the data given in the 
spread sheet. in this exercise you will learn how to create, modify and format chart using the 
spreadsheet. 

Reopen	the	worksheet	expenses_{your	name}.	

Now to create charts do the following. 

•	 Select	all	the	expenses	data.	

•	 Click	on	the	chart	type	that	you	want	from	Charts group under the Insert tab. 

•	 After	selecting	the	chart	type	the	spread	sheet	will	be	displayed	as	shown	below.

Figure 28

Figure 29
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•	 You	can	modify	the	chart	values	by	making	necessary	modifications	in	the	data	table.	

Chart has many elements; however, only some of the elements are displayed by default. Following 
is an description of the elements used in the above chart: 

1. Chart Area of the Chart 

2. Plot Area of the Chart 

3. Data Points that are plotted in the chart 

4. Horizontal and Vertical Axis in the chart 

5. Legend of the chart 

6. Chart and Axis Title used in the chart 

7. Data Label for identifying details of data point in the chart 

Note: Once you insert a chart in the spreadsheet three additional tabs are available on the Ribbon 
namely Design, Layout and Format. You can edit the chart, its design, layout and formatting 
options using the three tabs available. You can change the chart type, chart options etc. in the 
Design	tab	and	can	give	the	titles	etc.	in	the	Layout	tab	and	set	the	borders,	colors	and	size	of	the	
option under Format tab. 

Figure 30

Figure 31
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Chart Types:
Choosing the right type of chart is very important. Different charts display data in very different 
ways. Using the best chart type and format helps you to display data visually in the most 
meaningful way. 

Bar charts: A	bar	chart	(horizontal	bars)	emphasizes	the	comparison	between	items	at	a	fixed	
period of time. this chart type also includes cylinder, cone, and pyramid subtypes. 

Column charts: A	column	chart,	unlike	a	bar	chart	to	which	it	is	often	compared,	emphasizes	
variation over a period of time. this chart type also includes cylinder, cone, and pyramid 
subtypes 

Line charts: A line chart shows the relationship of the changes in the data over a period of 
time. 

Pie charts: Pie charts contain just one chart data series. A pie chart shows the relationship of 
the parts to the whole. 

Area charts: An area chart shows the relative importance of values over time. 

xY (Scatter) charts: Scatter charts are useful for showing a correlation among the data points 
that may not be easy to see from data alone. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a chart 

2. Create a worksheet using the sales data given below:
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3. Create bar and line charts using this data. Enhance the design of your chart  to make 
it more presentable.

4. Calculate the total sales for each city. Create a pie chart representing the total sales 
of each city. 

ASSeSSmeNT  

i. Fill in the blanks: 

1. A chart is a ______________ ______________ of data, in which the data is represented 
by symbols, such as ____ in a bar chart, _____ in a line chart, or ______ in a pie chart. 

2. the three tabs that are available after inserting the chart in the spreadsheet are 
_____________ , ____________________ & _________ _______________. 

ii. Answer the following: 

1. List seven chart elements. 

2.	 List	five	chart	types	available	in	spreadsheet.	

SeSSioN 9: SorT AND FiLTer DATA

relevant Knowledge  

Sort is a feature that helps you arrange the selected data either in an ascending or descending 
order. Filter is a feature used for extracting particular data using some conditions. Spread sheet 
offers	both	these	features	for	sorting	and	filtering	data	in	the	spreadsheet.	

open a new spreadsheet and enter the following data: 

Now to sort or filter the data do the following:

Figure 32
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•	 Select	the	data	to	be	sorted	and	then	click	on	Sort option under Sort & Filter group in the 
Data tab. A dialog box appears as shown below. 

•	 You	need	to	specify	on	what	basis	you	are	going	to	sort	the	data	in	the	Sort by field	and	
select the order that is ascending and descending and then click OK. For example, if you 
wanted to sort the data in Sales 2008, you would select the relevant detail in the Sort by list 
and click OK. the spreadsheet would be displayed as shown below. You can notice that the 
data	has	been	sorted	as	per	the	data	in	2008	and	also	that	values	in	the	Sales	2008	field	are	
arranged in ascending order that is from smallest to largest. 

To filter data, do the following: 

•	 Click	the	Filter option available under Sort & Filter group in the Data tab. Before applying a 
filter	you	have	to	select	the	data	along	with	the	header	as	shown	below.	

•	 Once	you	click	on	filter,	the	headers	will	be	displayed	with	a	down	arrow	as	shown	below.	

Figure 33

Figure 34

Figure 35

Figure 36
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If	you	want	to	filter	data	that	is	greater	than	75	in	the	Sales	2009	do	the	following.	

•	 Click	the	down	arrow	available	under	Sales	2009	header,	a	dropdown	list	appears	as	shown	
below. 

•	 You	can	specify	the	filter	by	selecting	the	available	values	in	the	list.	

•	 You	can	also	sort	the	filtered	data	by	selecting	Sort Smallest to Largest or Sort Largest to 
Smallest option available in the dropdown list. 

•	 Click	on	Number	Filters	option	under	the	dropdown	list,	once	you	click	the	following	submenu	
appears. 

•	 Here	you	can	select	the	condition	that	you	want	to	specify	for	the	data	in	the	list,	If	you	select	
Greater Than.. option the following dialog box appears. 

Figure 37

Figure 38
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•	 Specify	the	value	that	you	want	in	the	value	box,	(here	it	is	75)	and	click	OK. the spreadsheet 
will be displayed as shown below. notice that only data greater than 75 is displayed under the 
Sales 2009.

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 
1. Sort a dataset in the required order 
2. Filter	data	on	specified	criteria	

3. Create a worksheet with the data given below. Create totals. Calculate percentages. 
Use	this	to	sort	data	subject	wise	and	also	rank-wise.	Save	this	file	as	Student_{your	
name}.	

Figure 39

Figure 40
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ASSeSSmeNT   

Fill in the blanks: 

1. Sort helps you arrange the selected data either in an__________ or ___________ order. 

2.	 Using	filter	you	can	extract	data	based	on	_________.	

3. Sort option is available in _______________________ group under the Data tab. 

4. Filter option is available in _______________________ group under the Data tab. 

 

SeSSioN 10: CALCULATe DATA ACroSS WorKSHeeTS 

relevant Knowledge 

Suppose	you	were	working	at	the	head	office	maintaining	had	data	for	six	regions,	and	you	use	
exactly the same worksheet layout and labels to track the average sales of each region over the 
previous quarter. Each sheet contains headings by region (such as Region01, Region02 ….. 
Region06), and in cell H15 on each sheet, the calculated total sales for the quarter appear. if you 
want to obtain the average sales over the quarter, what would you do? 

in this exercise you will learn how to perform calculations on data across different worksheets. 

open a new spreadsheet. Name sheet 1 as year 1 and type the following data. 

Figure 41
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Now to calculate the data across worksheets do the following. 

•	 Go	to	sheet	2,	name	it	year	2	sheet,	and	insert	the	same	data	in	the	Sheet	2	for	the	next	
year. 

•	 Go	to	sheet	2,	name	it	Totals,	and	insert	the	same	labels.	

•	 Type	the	sum	formula	in	cell	B2,	=sum(	,	while	the	parenthesis	is	opened	go	to	year	1	sheet	
and go to year 2 sheet and press enter. Repeat the same step to calculate sum for other 
expenses.	Note	the	way	the	range	is	specified	(sheetname!cellnumber).	

To	answer	the	question	raised	earlier,	you	could	create	a	new	sheet,	called	Quarter	Summary.	
To	 find	 the	 average,	 enter	 the	 following	 formula	 in	 one	 of	 the	 cells	 in	 the	 Summary	 sheet:	
=AVERAGE(Region01:	Region06!H15)	

Spreadsheet calculates the average for all values stored in H15 on all sheets in the range 
Region01:Region06. if you move the Region06 sheet between Region04 and Region05, 
the software will adjust the calculation to include the sheets for Regions01, 02, 03, 04, and 
06; Region05 will be omitted. Similarly, if you delete or add a sheet anywhere between 
Region01 and Region06, the software will include all the sheets located within the range in 
its calculation. 

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 

1. Make calculations across worksheets 

2. Create 2 worksheets populated with subject and marks for 1st and 2nd terms. 
Create another worksheet called Average and calculate the average of marks for all 
subjects. 

 

Figure 42
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SeSSioN 11: USiNg mULTiPLe WorKBooKS AND LiNKiNg CeLLS 

relevant Knowledge 

Spreadsheet also allows you to link the cells from various worksheets and from various spread 
sheets	 to	 summarize	 data	 from	 several	 sources.	 In	 this	manner,	 you	 can	 create	 formulas	
that span different sources and make calculations using a combination of local and linked 
information. You can link data from other spreadsheets and keep the information up to date 
without editing multiple locations every time the data changes. For example, you can display 
data from multiple departments for an overview of details without sharing information between 
sources. 

in this exercise you will learn how to link cells from different spreadsheet applications. 

open a new spread sheet and enter the following data: 

To link cells from different worksheet do the following: 

•	 Open	a	new	spreadsheet	workbook.	

•	 Type	some	 formula,	 for	example	sum	 formula	 in	any	cell	=sum(,	while	 the	parenthesis	 is	
opened, click on Switch Windows option under Window group in the View tab. A dropdown 
list appears with the active workbook names. 

•	 Click	 on	 Book1	 to	 select	 the	 earlier	 spreadsheet	 you	 had	 created	 and	 select	 the	 cells	
A2:D2. 

Figure 43

Figure 44
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•	 Press	Enter. You are back on the second spreadsheet. the cell where you were entering the 
formula	has	the	total	of	the	values	in	the	first	spreadsheet!.	Note	the	way	the	software	gives	
the	cell	reference.	If	you	update	any	values	in	the	first	spreadsheet,	automatically	the	sum	
value in the second spreadsheet is updated! try this out. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 
1. Link cells and make calculations across workbooks 

 

ASSeSSmeNT  

Fill in the blanks: 

1. Switch Windows option is available in _____________ group under the View tab. 

2.	 Linking	cells	from	different	_______	/	__________	helps	you	to	summarize	data	from	different	
sources. 

3. Linking data helps you help to keep information __________ without editing at multiple 
locations. 

Figure 45 

Figure 46
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SeSSioN 12: SHAriNg WorKSHeeT DATA 

relevant Knowledge 

In	most	office	settings,	there	is	a	shared	drive	where	teams	can	store	common	files	for	everyone	
to	use.	This	usually	 leads	to	sighting	of	 the	message:	“The	document	 [file	name]	 is	 locked	for	
editing	by	another	user.	To	open	a	read-only	copy	of	this	document,	click“!!	This	message	appears	
because	someone	else	already	has	the	file	open.	Sometimes	however,	it	 is	necessary	to	have	
multiple	people	working	on	a	file	at	the	same	time.	This	can	be	to	either	speed	up	data	entry	or	
simply make things easier for collaboration purposes. 

Spreadsheet software allows the user to share the workbook and place it in the network location 
where several users can access it simultaneously. in this exercise, you will learn how to share a 
worksheet. 

open a new spreadsheet and type the following. 

Now to share the spreadsheet do the following. 

•	 Click	on	Share workbook option under Changes group in the Review tab. 

•	 A	dialog	box	appears	as	shown	below.	

Figure 47
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•	 Check	 the	option	Allow changes by more than one user at the same time. This also 
allows workbook merging. 

•	 Click	OK. 

Note: Most spreadsheet software automatically turn off some features in shared workbooks. this 
is	 to	simplify	 the	workbook	since	multiple	people	can	be	working	on	the	file	at	 the	same	time.	
For example, shared workbooks don’t allow merging cells, conditional formatting, or inserting 
pictures/graphs/etc.

exerCiSe  

Perform the following activity till you are confident:

S.No. Activity 

1. Share worksheet data with other users. 

 

ASSeSSmeNT  

Fill in the blanks: 

1. Share Workbook option is available in ___________ group under the Review tab. 

2. Shared workbooks don’t allow __________________, ________________ & inserting 
_________ or ________. 

Figure 48 
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SeSSioN 1: iNSerTiNg A moVie CLiP 

relevant Knowledge
Presentation allows the user to add movie clips to the presentation in order to make the 
presentation colourful and meaningful. You can insert movies or Youtube videos downloaded 
from the internet. 

In	this	exercise	you	will	learn	how	to	insert	a	movie	clip	in	slides.	Open	a	new	file	using	presentation	
software. 

You can insert a movie in two ways: 

•	 Using	Insert	tab	

•	 Using	Title	and	Content	Layout	Option	

Click on Movie option under Media clips group in the Insert tab, a drop down appears as shown 
below. 

You can select the Movie from File… option to insert the movie clip that you have already 
downloaded from the internet. A dialog box appears as shown below: 

You can locate the movie clip and click OK to insert the same in the slide. the presentation will 
be displayed as shown below.

Figure 1

Figure 2
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You can set one of the two options available for playing the media clip, i.e Automatically or 
When Clicked. 

Alternatively, you can select Movie from Clip Organizer… option to insert the movie clips that 
are	available	under	Clip	Organizer.	Doing	so	displays	the	clip	art	task	pane	as	shown	below:

You can select any of the movies available and insert it in the slide. Once you have inserted the 
movie clip in the slide, the presentation will be displayed as shown below. 

Figure 3

Figure 4

Figure 5
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Using Layout option 

Open	a	new	file	using	presentation	software	and	change	the	layout	of	the	slide.	

Click on Layout option available under Slides group in the Home tab, a dropdown list appears 
as shown below. 

Click on Title and Content option and a slide will be displayed with the layout as shown below. 

Figure 6

Figure 7
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You can insert a movie in the slide by clicking the  icon in the Layout option. Once you click 
the icon, a dialog appears as shown below.  

When you play the slideshow, the movie clip will be played automatically. 

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 
1. insert a movie clip using insert option 

2. insert a movie clip using Layout option 

3. Download	different	clips	on	either	“Effects	of	thoughts	on	water”	or	“Our	place	in	the	
cosmos”	or	“Effects	of	Global	Warming”.	Create	a	presentation	giving	an	appropriate	
name	to	the	file.	Insert	the	relevant	video	clips	and	save	the	presentation.	You	will	
use	this	file	in	future	sessions	too.	

 

ASSeSSmeNT  

Fill in the blanks: 

1. Presentation allows the user to add ______ _______ to the presentation in order to make the 
presentation colourful and meaningful. 

2. You can use two options to insert a movie clip the _________________ & 
______________________. 

3. the two options available under Movie option are _____________________ & 
_________________. 

4. Movie option is available in ______________ group under the insert tab.

Figure 8
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SeSSioN 2: iNSerTiNg AN AUDio CLiP 

relevant Knowledge 

You can include audio clips to a presentation similar to that of videos. For example, you can play 
mild background music while making your presentation. in this exercise you will learn how to 
insert an audio clip in slides. 

Open	a	new	file	using	presentation	software.	Click	on	Sound option under Media clips group in 
the Insert	tab,	a	drop	down	appears	as	shown	in	figure	9. 

You can select the Sound from File… option to insert the sound clip. A dialog box appears as 
shown below. 

Figure 9

Figure 10
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You can locate the audio clip and click OK to insert the same in the slide. You may follow the 
same	steps	as	you	learnt	while	inserting	a	Movie	Clip.	There	is	an	inbuilt	clip	organizer	for	a	list	of	
sounds. You can access them via the Sound from Clip Organizer… option. Go ahead and insert 
an audio clip using this option.When you have completed inserting the sound clip, and you play 
the slideshow, the audio clip will be played automatically. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. insert a sound clip in a presentation 

2. Download	appropriate	music	and	then	reopen	the	file	created	in	the	last	session.	Add	
the	music	files	to	enhance	the	effect	of	your	presentation.	

 

ASSeSSmeNT  

Fill in the blanks: 

1. You can include _______________ to a presentation similar to that of videos. 

2. Audio Clips are used for playing _____________________ while making presentations. 

3. Sound option is available in the Media Clips group under the _____________ tab.

 SeSSioN 3: WorKiNg WiTH TABLeS

relevant Knowledge 
Presentation software enables the user to add tables in the slides in order to represent the 
statistical data meaningfully. 

in this exercise you will learn to work with tables. 

Open	a	new	file	using	presentation	software.	You	can	insert	a	table	in	two	ways:	

•	 Using	Insert	tab	

•	 Using	Title	and	Content	Option	

Click on table option under Tables group in the Insert tab, a drop down appears as shown 
below. 
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You can have learnt to create tables in a word processor by dragging the mouse over requisite 
number of boxes. Follow the same method here and create the table shown below. now go ahead 
and try the insert Table… and Draw Table options to create the table. 

Figure 11

Figure 12

Figure 13
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Using Title and Content option 

Open	a	new	file	using	presentation	software	and	change	the	layout	of	the	slide.	To	change	the	
layout of a slide do the following: 

Click on Layout option available under Slides group in the Home tab, as you did while selecting 
a movie clip. Click on Title and Content option from the dropdown list. You can insert the table 
in the slide by clicking the  icon available within the layout. Once you click the icon, a dialog 
appears as shown below. 

now enter the values for the number of columns and rows that you would like to have in the table. 
For example, if you need a table with 3 columns and 3 rows, type 3 in both Number of columns 
and Number of rows fields.	

Once you have inserted the table into the slide, additional tabs - Design and Layout - are made 
available. You can use them for editing and formatting the table further.

You can change the design of the table by changing background, borders or effects by using Table 
Styles group in the Design tab. to use a particular design, Select a design under Table Styles 
group and double-click on it. if you would like to change a design, choose a different design under 
table Styles group and double-click on the new design. 

You have learnt to create a table in a presentation, but if the table already exists in a word 
processor document or a spreadsheet, you can directly import it from there. to do so: 

Figure 14

Figure 15
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With a slide in edit mode, choose Object from the Insert menu. 

•	 In	the	Insert Object dialog box, click the Create From File option and click Browse to locate 
and choose the document or spreadsheet that contains the table. By default, the presentation 
software will insert the table. 

•	 When	you	click	OK, the entire document or spreadsheet is imported to your slide. Double-
click the inserted text to remove extra text if the document contains more than the table. 

•	 If	you	check	the	Link checkbox while inserting. On doing so, after you update the table in the 
document or spreadsheet, then right click on the imported table in the presentation software, 
and select the option Update Link, the embedded table gets updated automatically. 

•	 Drag	and	drop	the	table	on	the	slide	to	position	it.

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 

1. insert a table in a presentation using insert and Layout tab 

2. Change the design and format of a table in a presentation 

3. import a table from another application 

4. Open	a	new	file.	Try	inserting	the	table	given	in	this	exercise	with	multiple	rows	and	
columns	and	also	use	different	pre-defined	styles	by	using	 the	Table Styles option 
under Design tab. 

ASSeSSmeNT 

Fill in the blanks: 

1. __________________ are used to represent the statistical data meaningfully in a 
presentation. 

2. table option is available in _____________ group under the insert tab. 

3. two ways to create a table are : _______________ & _______________. 

4. Additional tabs that will be available for editing and formatting the table are __________ & 
________________. 
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SeSSioN 4: WorKiNg WiTH CHArTS 

relevant Knowledge 

Presentation software enables the user to insert charts in slides to present statistical table data in 
a pictorial representation. this ensures that the audience can grasp complex data at a glance. 

In	this	exercise	you	will	learn	to	work	with	charts.	Open	a	new	file	using	presentation	software.	
to insert a chart in the slide, click on Chart option under Illustrations group in the Insert tab. A 
dialog box appears as shown below. 

You will notice different type of the charts that can be used in the presentation. 

Select a chart type and click OK. A default chart will be inserted on the slide. the default data 
table for that chart will be opened in a spreadsheet application separately as shown below. 

Figure 16

Figure 17



193information technology

Unit-5

You can edit the values in the spreadsheet and the presentation software will automatically update 
the chart. now enter the following in the spreadsheet window: 

Day 1 Savings Day 2 Savings Day 3 Savings 

Arun 300 250 500 

John 200 300 300 

Jacob 150 500 600 

Salim 500 750 150 

Once	you	have	modified	the	data	table	 in	the	spreadsheet	the	chart	 in	the	slide	gets	modified	
automatically and the chart will displayed similar to the one below. 

now change the values in the spreadsheet and observe the changes in the chart. 

You can change the colors and effects of the chart by using Chart Styles available under Design 
tab. to change to a different style, select a style from Chart Styles and double-click on it. 

Some Basic guidelines are as follows: 

•	 Convey	one	message	per	chart.	Make	the	message	the	heading.	

•	 Make	the	chart	easy	to	read.	Label	the	X	and	Y	axis	and	label	the	lines,	bars,	or	pie	wedges.	
Make the most important text largest, the most important data lines or sections darkest. 

•	 Make	bars	and	columns	wider	than	the	spaces	between	them.	

•	 Be	accurate.	Always	start	a	numerical	axis	at	zero.	Compare	only	like	variables.	

•	 Eliminate	all	unnecessary	details.	Avoid	grid	lines,	data	points,	boxes,	etc.	unless		they	relate	
to the message.

•	 Use	a	few	(maximum	four)	colors	per	visual.	

Figure 18 
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importing a chart
You can also import a chart from a spreadsheet. the method is the same as importing a table into 
presentation software. Since the entire sheet is imported, you may need to maneuver around and 
display	the	chart	in	the	embedded	object.	To	increase	/		decrease	the	size	of	the	object,	you	can	
double	click	on	it	and	resize	it.	

exerCiSe  

Perform	the	following	activities	till	you	are	confident:	

S.No. Activities 
1. insert a chart onto a slide 
2. Modify an already created chart 
3. import a chart from another application 
4. Create a chart using the data below in a spreadsheet. import the chart onto a slide. 

 
ASSeSSmeNT  

Fill in the blanks: 

1. Presentation enables the user to insert __________ in slides to present statistical table data 
in a pictorial representation. 

2. Chart option is available in _____________ group under the insert tab.

 

SeSSioN 5: iNSerTiNg TrANSiTioNS  

relevant Knowledge 
transition effects can help in increasing audience’s interest during a presentation. 

A slide transition is the visual motion when one slide changes to the next during a presentation. By 
default, one slide simply replaces the previous one on screen, just like a slide show of photographs 
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would change from one to the next. Most presentation software provides many different transition 
effects that you can use to liven up your slide show. 

In	 this	 exercise	 you	 will	 learn	 to	 add	 transitions	 in	 the	 presentation.	 Open	 a	 new	 file	 using	
presentation software and add contents to the presentation based on the guidelines provided 
earlier. to work with transition effects, click the Animations tab. You will be displayed with list of 
transition effects similar to the one below. 

to apply, select an effect from Transitions to this slide group and double-click on it. 

You can also increase or decrease the duration of the transition effect by setting up the time 
interval (in seconds) in duration option under Timing group. try setting the duration as 1 minute 
and observe the effect by performing the slide show. 

You can set sound effects during transitions by selecting a sound scheme available in Sound 
option under Timing group. try using different sound schemes and observe the sound effect by 
performing the slide show. 

if you would like to keep the same transition and sound effect across the entire presentation, 
click Apply to all under the Timing group. Selecting this option will apply all the selected effects 
across all slides. 

Note:	A	common	mistake	made	is	using	too	many	transitions,	or	using	one	that	doesn’t	fit	well	with	
the	subject	matter.	Try	to	find	one	transition	that	doesn’t	detract	from	the	presentation	and	use	
it throughout the show. Using too many makes your  presentation looks amateurish. A transition 
is	the	final	effect	to	be	given	to	your		presentation	so	edit	and	arrange	all	slides	in	the	preferred	
order before setting them. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Apply transitions to slides 

Figure 19
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2. Now	 open	 the	 presentation	 created	 in	 Exercise	 1	 (either	 “Effects	 of	 thoughts	 on	
water”	or	“Our	place	in	the	cosmos”	or	“Effects	of	Global	Warming”.)		and	try	applying	
different transition effects to your presentation slides. 

ASSeSSmeNT  

Fill in the blanks: 

1. ____________ effects can help in increasing audience’s interest during a presentation. 

2. A ___________ is the visual motion when one slide changes to the next during a 
presentation. 

3. the list of transition effects will be available under _____________ tab. 

4. transition effects are available in ___________________________ group under the 
Animations tab. 

5. ___________________, _________________________, _____________________, 
____________, ________________ are some of the transition effects available in a 
presentation software. 

SeSSioN 6: iNSerTiNg ANimATioNS  

relevant Knowledge 

While transition occurs between each slide, animation allows you to put slide elements, such as 
text and graphics, in motion within a slide! Animations are helpful way to make your slides look 
more	dynamic.	Besides	adding	action,	they	help	steer	audience	focus	and	emphasize	important	
points. they are also a great way to reveal text or object on a slide one step at a time. For 
example,	you	could	have	five	bullet	points	of	text,	and	reveal	them	one-by-one	on	the	slide	with	
each click. 

In	 this	 exercise	 you	 will	 learn	 to	 add	 animations	 in	 a	 presentation.	 Open	 a	 new	 file	 using	
presentation software and add contents to the presentation based on the guidelines provided 
earlier. to work with animations, Click Animations tab. You will see Animation options similar 
to the one below. 
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to apply, select the graphical object and click Animate under Animations group. Select the 
animation effect under the Animate dropdown list. You can apply an animation effect by selecting 
different animation scheme from the dropdown menu. 

Once you have selected an animation scheme, play the slideshow to preview the effect. 

Surveys show that animation effects are one of the most annoying elements in presentations. 
However, when used effectively, these effects can insert a dramatic moment to a particular 
message and add spice to a dull presentation. 

To summarize the effective uses of animation effects: 

•	 Helps	focus	audience	attention	on	information.	

•	 Controls	the	flow	of	information	especially	while	explaining	a	diagram.	

•	 Reveal	concepts	one	by	one.	

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Apply animation on slide objects 

2. Create a presentation with 3 slides on your favorite sport. Use different animation 
effects available in the presentation software to enhance your presentation as per 
your choice. Make your presentation in the class. 

 

Figure 20

Figure 21
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ASSeSSmeNT  

Fill in the blanks: 

1. __________________ enables you to put slide elements, such as text and graphics, in 
motion within a slide. 

2. ____________ are helpful way to make your slides look more dynamic. 

3. to apply an animation, select the Animate option available in ________ group under the 
Animations tab. 

SeSSioN 7: groUPiNg oBJeCTS  

relevant Knowledge

Grouping	can	help	when	you	want	to	move,	rotate	or	resize	multiple	objects	in	a	presentation.	
You can group objects such as pictures, clip art, shapes and text box; once grouped they appear 
as a single object. 

In	this	exercise	you	will	learn	to	work	with	grouping	and	ungrouping	of	objects.	Open	a	new	file	
using presentation software and add graphical objects to the presentation based on the guidelines 
provided earlier. to group the graphical objects, select all the objects that you want to group in the 
slide. to select more than one objects in the slide hold down the ctrl key and select the object in 
the slide. 

to group the objects, click Format tab. 

You can select the Group option available under Arrange group in the Format tab. Once you 
select the option, you should see a dropdown similar to one displayed below. 

Figure 22
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Click on Group, to group all the selected graphical objects in the slide. 

Similarly you can ungroup the grouped objects by selecting the ungroup option available under 
Group dropdown menu.

exerCiSe  

Perform the following activities till you are confident:  

S.No. Activities 

1. Group objects on a slide 

2. Open a new presentation, and create the following images and add small textboxes 
as headers to describe them:

now try selecting the objects, practice grouping and ungrouping functions. 

ASSeSSmeNT  

Fill in the blanks: 

1. ___________ helps to move, rotate	or	resize	multiple	objects	in	a	presentation.	

2. the Group option is available in ___________ group under the Format tab. 

3. the three options available under Group dropdown option are: _______________, 
______________ & ________________ . 

Figure 23
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SeSSioN 8: iNSerTiNg SPeAKer NoTeS  

relevant Knowledge

Good presenters always rehearse their presentations well but there’s often one more thing that 
helps	them	deliver	flawless	presentation	–	speaker	notes.	Speaker	notes	are	guided	text	used	
by the presenter during a presentation. Speaker notes can be short or long texts that can be 
used as a reference by the presenter while making a presentation. An area of a PowerPoint or 
OpenOffice	Impress	slide	that	 is	hidden	during	the	presentation	 is	reserved	for	notes	for	 the	
speaker. Here you as the presenter can note important key points that you wish to cover during 
the presentation. 

You can print these notes out, accompanied by a thumbnail version of the appropriate slide, to 
keep as a handy reference to use when you are making your oral presentation. this can help you 
to	communicate	specific	points	related	to	each	slide	and	make	the	presentation	effective	for	the	
audience. 

In	this	exercise	you	will	learn	to	add	speaker	notes.	Open	a	new	file	using	presentation	software.	
to add notes to a particular slide, select the slide and type the notes in the Click to add notes 
area located at the bottom of the presentation software (Figure below). 

Figure 24
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Alternatively, you can select View tab and click Notes page under Presentation Views Group. 

Key things to remember about speaker notes: 

1. they should not restate the contents of the slide. 

2. Speaker notes should support the content of the slide with in-depth information. 

While the regular presentation slides are shown on the main screen for the audience, the view 
on your computer screen is slightly different – you can not only see the current slide but also 
the text notes and other key points that should be discussed with that slide. to do so, open the 
presentation	file	using	your	presentation	software,	go	to	the	Slide Show tab and check the option 
Use Presenter View. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. insert speaker notes on slides 

2. Open	the	presentation	you	had	created	in	Exercise	1	(either	“Effects	of	thoughts	on	
water”	or	“Our	place	in	the	cosmos”	or	“Effects	of	Global	Warming”.)	and	enhanced	
in Exercise 5. Add speaker notes to each of your  slides. 

ASSeSSmeNT  

Fill in the blanks: 

1. _________________ are guided text used by the presenter during a presentation. 

2. _________________ can be short or long texts that can be used as a reference by the 
presenter. 

3. notes page option is available in ______________ group under the View tab.
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SeSSioN 9: reVieWiNg CoNTeNT  

relevant Knowledge

You should always review the presentation and make changes if required before you present it to 
the audience. Presentation software includes options such as spell checks for correcting errors 
in a presentation. However, it is the presenters’ responsibility to check each and every point 
manually on each slide before attempting to make a presentation. 

in this exercise you will learn to make an effective presentation. Making effective presentations 
takes practice, but with a few tips up your sleeve, you are ready to take on the challenge. 

1. Know your topic. 

 You may want to charge right in and start using the presentation software. 

	 However,	 do	 the	 research	 first	 and	 know	your	material,	 think	 through	what	 and	how	you	
will present get comfortable with the matter before beginning the project on the computer. 
Creating the presentation is the easy part. the best classroom presentations are created by 
people who are comfortable with what they are going to talk about. 

2.  Use key phrases about your topic. 

 Good presenters use key phrases and include only the most important information. Choose 
only the top three or four points and make them several times throughout the presentation. 
Highlight key points that are necessary for the audience to remember. Keep the points as 
short as possible, use 5-6 words to describe the point. 

3. Avoid too much text on each slide. 

 Do not write your whole speech on the slides. the slide show is meant to accompany your 
oral	presentation.	Summarize	the	content	as	bullet	points.	Use	simple	language	and	limit	the	
number of bullets to three or four per slide. 

4. Limit the number of slides. 

 too many slides in a presentation may cause you to rush to get through them and your 
audience might end up paying more attention to the changing slide than to what you are 
saying. On average, one slide per minute is about right in a classroom presentation. 

5. Plan the layout of your slide. 

 Make your slides easy to follow. Put the title at the top. Phrases should read left to right and 
top to bottom. Keep important information near the top of the slide. 
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6. Avoid fancy fonts. 

 Make sure the fonts, design and colors are consistent throughout the presentation; don’t 
use different styles for each slide. Use fonts that are readable; recommended fonts are Arial, 
Tahoma,	Verdana.	Use	standard	font		size	that	is	readable	even	from	the	last	row	if	presented	
in a large hall or to a  large audience. Use combination of capital and small letters; Do nOt 
use	all	 	 capital	 letters	as	 it	may	be	difficult	 to	 read.	Use	bold,	 italics	or	underline	only	 	 if	
required or to highlight key points. 

7. Use contrasting colors for text and background. 

 Use reasonable mix of text color and background; preview to check if it is readable without 
any	difficulty.	Dark	text	on	a	light	background	is	usually	the	best	as	this	combination	offers	the	
maximum visibility. Keep your slide color scheme consistent throughout your presentation. 

8. Use a slide design template to keep your presentation look consistent. 

 Use a single background on all slides; do nOt use multiple backgrounds. Use a pleasant 
template or style set; do nOt use different style sets for different slides as it will distract the 
audience and they might lose the focus. 

9. Use animations and transitions sparingly. 

 You may enjoy applying animations and transitions in every place that you can. this will 
certainly be entertaining, but at the same time very distracting. So use this feature with 
prudence. 

10. Also, always review the presentation 2-3 times before making a presentation; 

 this can help in reducing or eliminating any errors in it. Remove irrelevant points during the 
review, add or remove images during review. try presenting to a smaller audience, make 
necessary corrections before presenting it to a larger audience 

Note: Most presentation software includes many features; do nOt try to overuse them!!! 

Once you have created the presentation of your choice using the guidelines, you may  now 
proceed to reviewing the presentation. Use the additional guidelines below: 

•	 Do	a	thorough	spell	check	across	all	slides	

•	 Perform	a	manual	spell	check	for	terms	that	is	not	included	during	the	standard	spell	check	
in the presentation software; nOt all terms (particularly technical terms such as biological 
names, etc.) will be checked 

•	 Remove	irrelevant	content	such	as	images	or	clip	arts,	terms,	etc.	if	they	are	not	required.	
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exerCiSe  

Perform the following activity till you are confident: 

S.No. Activity 

1. Prepare a presentation with a topic of your choice or as assigned by your teacher. 
Review using the guidelines and have it validated by your teacher. 

 

ASSeSSmeNT  

Fill in the blanks:

1. Presentation software includes options such as ____________ spell checks for correcting 
errors in a presentation. 

2. tips to make an effective presentation are: 

 a) ________________________________________________________ 

   ________________________________________________________ 

 b) ________________________________________________________ 

  ________________________________________________________ 

 c) ________________________________________________________  

  ________________________________________________________ 

 d) ________________________________________________________ 

  ________________________________________________________ 

 e) ________________________________________________________  

  ________________________________________________________ 
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SeSSioN 10: PrePAriNg To DeLiVer A PreSeNTATioN  

relevant Knowledge 

Now	 that	 you	have	a	presentation	 ready,	 you	can	customize	 the	delivery	of	 the	presentation.	
For	example,	you	can	customize	 to	display	selected	slides	 to	be	displayed	to	 the	audience	or	
configure	for	multiple	monitors,	etc.	

in this exercise, you will learn to deliver a presentation. 

to work with Slide Show, open an existing presentation in the presentation software. 

Click on Set Up SlideShow option under Set Up group in the Slide Show tab. 

Once you click Set Up SlideShow, a dialog box appears as shown below. 

if the presentation is to be made to an audience, use the Presented by a speaker (full screen) 
option. 

if the presentation is to be made to an individual, use Browsed by an individual (window) 
option. 

if the presentation is to be made at Kiosks, use the Browser at a Kiosk (full screen) option. 

Note: A	 kiosk	 is	 a	 computer	 terminal	 featuring	 specialized	 hardware	 and	 software	 designed	
within a public exhibit that provides access to information and applications for communication, 
commerce, entertainment, and education. 

In	addition,	you	can	configure	the	presentation	to	be	automated	(run	continuously),	with	or	without	
animation by using the options under Show Options group. 

You can display selective slides from a presentation using the Show slides option. 

Figure 25
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exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a slide show 

2. Reopen	 the	 presentation	 created	 in	 Exercise	 1	 (either	 “Effects	 of	 thoughts	 on	
water”	or	“Our	place	in	the	cosmos”	or	“Effects	of	Global	Warming”.)	and	enhanced	
in Exercises 5and 8. Prepare to deliver the presentation based on all you have 
learnt in this session, preview and make your presentation. 

 
ASSeSSmeNT  

Fill in the blanks: 

1. Set Up Slide Show option is available in _______________ group under the Slide Show 
tab. 

2. the _______________ option should be used while presenting the presentation to an 
audience. 

3. the _______________ option should be used while presenting the presentation to an 
audience. 

4.	 A	 ____________	 is	 a	 computer	 terminal	 featuring	 specialized	 hardware	 and	 software	
designed within a public exhibit that provides access to information and applications for 
communication, commerce, entertainment, and education.

SeSSioN 11: PriNT A PreSeNTATioN  

relevant Knowledge 

Sometimes you may need to provide print outs of the presentation to the audience as a reference 
material. You can print notes, handouts or outline of the presentation using the presentation 
software. in this exercise, you will learn to print notes, handouts and outline. 

to print, open an existing presentation and select the Print option. 

Select the Notes Page option under Print what: dropdown	list	(figure	26.)
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Click OK once you are ready to print the notes. 

You can print handouts for audience reference by selecting the Handouts option under Print 
what: dropdown list. to save paper, you can print multiple slides on a single sheet. 

to print multiple slides, select the number of slides that you would like to print by choosing the 
number displayed under Slides per page dropdown	under	Handouts	Group	(figure	27).	

if you would to print only the text part of the presentation, you can use the Outline option in the 
presentation software. 

to print the outline, select the outline View option under Print what: dropdown list. 

Figure 26

Figure 27

Figure 28
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exerCiSe  

Perform	the	following	activities	till	you	are	confident:	

S.No. Activities 

1. Print a presentation 

2. Create a presentation (10-12 slides) on any two of the following topics. 

•	 School	Annual	Day	function.	

•	 Sports	Day.	

•	 Independence	Day.	

•	 Healthy	Diet.	

•	 Savings	Plan	(Post	Office).	

•	 Creating	Presentations.	

While making the presentations use the following features based on the presentation 
guidelines learnt earlier. 

•	 Use	Transition	effects	for	slides.	

•	 Use	Animation	effects	for	text	and	objects.	

•	 Group	related	pictures.	

•	 Use	tables	and	format	them	with	different	table	styles.	

•	 Use	charts	to	represent	data	in	graphical	form.	

•	 Download	and	use	templates.	

ASSeSSmeNT  

Fill in the blanks: 

1. Print option is used to print __________ , __________ & __________ of a presentation. 

2. Handouts option is available under ____________ dropdown list. 

3. the ______________ option is used to print only the text part of the presentation. 
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SeSSioN 1: WorKiNg WiTH CALeNDAr 

relevant Knowledge
Time	Management	is	the	act	of	planning	to	stay	organized	that	will	result	in	increased	efficiency	
and productivity. time management can be performed using simple techniques such as a paper 
and pen; you can also use calendar software to plan your time. 

Calendaring software provides the user an electronic version of a calendar. it is a time management 
tool,	a	system	of	organizing	days	for	social,	religious,	commercial,	or	administrative	purposes.	Most	
email applications include support for working with Calendar; you can also use online calendar 
such as Google Calendar however this requires internet connectivity. 

in this exercise, you will learn to work with a calendar application. in these exercises, you will be 
practicing on Outlook Calendar. At the end of the sessions, you can easily navigate on any other 
calendar software as the features are almost the same. to learn about Google calendar you can 
explore	 the	 site	 http://services.google.com/apps/resources/overviews_breeze/Calendar/index.
html. 

Start the email program by: 
Click	Start	>	Programs	>	Microsoft	Office	>	Microsoft	Outlook.	
Click	Calendar	located	at	the	bottom	left	corner	(figure	below).	

A window similar to the one below appears.
Figure 1
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You can create appointments and schedule day-to-day activities using calendar. the application 
provides three views: 
•	 Day	
•	 Week	
•	 Month	

For example, to schedule an activity for a particular time in the day, choose Day view. the default 
view	is	by	“Day”.	
You can select either the Show work week (Monday to Friday) or Show full week (Sunday to 
Saturday) to view the appropriate days in the week by selecting one of the given options. 

Selecting the Month view shows calendar for a month. You can plan your monthly schedule 
here. Any appointments/meetings/commitments previously set in the day/week view will also be 
reflected	here.	
You	can	switch	over	to	a	specific	date	in	the	calendar	by	selecting	the	date	in	the	data	navigator.	

Figure 2

Figure 3

Figure 4

Figure 5
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You can set the options for the calendar by selecting Tools > Options. A dialog box appears as 
shown below. 

Click on Calendar Options… and a dialog box appears as shown below. 

You can make changes to the calendar by using appropriate options in the dialog box.

Figure 6

Figure 7
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exerCiSe 

Perform the following activities till you are confident: 

S.No. Activities 
1. try each of the options in the Calendar Options dialog box and observe the changes. 

Make a note of all changes in your notebook. 

ASSeSSmeNT  

Fill in the blanks:

1.	 _________________	 is	 the	act	of	planning	 to	stay	organized	 that	will	 result	 in	 increased	
efficiency	and	productivity.	

2. A _____________ software provides the user an electronic version of a calendar. 

3. the three view supported by a calendaring software are ________ , _______ & ______. 

SeSSioN 2: SCHeDULe AN APPoiNTmeNT

relevant Knowledge  

You can create appointments using the calendar. For example, you can create an appointment 
for visiting a dentist. 

in this exercise, you will learn to schedule an appointment. 

You can schedule an appointment in two ways: 

1. Using menu bar. 

2. Using calendar view. 

Go to File > New > Appointment, a window similar to the one below will be displayed. 
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Once you have created an appointment, click the Save & Close option for the calendar to store 
this	information.	The	details	will	be	reflected	in	the	calendar.	

Calendar software prompts you with an alert based on entries scheduled in the calendar. 

Figure 8

Figure 9
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You can create appointments on a daily, weekly, monthly or yearly basis. You can create recurring 
appointments, for example, you create your breakfast schedule everyday between 7:30 to 8:00 
AM. to do so, right-click on the calendar and click New Recurring Appointment. 

An Appointment Recurrence window appears. You can specify the appointment time, recurrence 
pattern and the range of recurrence here. 

Figure 10

Figure 11
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Enter a recurring event, select multiple days and click oK. 

Recurring appointments appear on the calendar as a daily activity as displayed below. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 
1. Schedule a onetime and a recurring appointment 

2. Create appointments for the following items: 
1. Daily class schedule. 
2. Exam schedule. 
3. Exam preparation schedule. 
4. Visit to Circus (One time activity). 
5. Parent / teacher Meeting (Monthly activity). 
6. Visit to a book store (One time activity). 
7. Vaccine Schedule (Yearly activity). 

Save the appointments, you will use them in the next exercise. 
 

Figure 12

Figure 13
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ASSeSSmeNT  

Fill in the blanks: 

1. the two ways to schedule an appointment are: ____________________________ & 
_____________. 

2. Calendar software prompts with an __________ based on entries scheduled in the 
calendar. 

3. _______________ appointments can be used for scheduling repetitive tasks. 

SeSSioN 3: CATegoriZe AN APPoiNTmeNT 

relevant Knowledge
You	can	categorize	the	appointments	in	time	management	software	by	giving	the	specific	colors	
to the appointments. For example, you can use green color for all school related activities and 
blue for all personal activities. Using Calendar you can name colors (and change the names when 
you	want	to).	You	use	colors	to	make	specific	entries	stand	out	at	a	glance	and	catch	your	eye.	In	
this	exercise,	you	will	learn	to	categorize	appointments.	

You	can	either	categorize	the	appointments	at	the	time	of	creation	of	the	appointment	or	categorize	
after creating the appointment. 

to use a category while creating an appointment, select a color from the Categorize dropdown 
list	(figure	above).	To	apply	category	for	an	existing	appointment,	double-click	on	the	appointment	
and select a color from the Categorize dropdown list. 

Figure 14
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You can name all the categories. A sample has been shown below: 

exerCiSe  

Perform the following activity till you are confident: 

S.No. Activity 

1. Create appointments with different categories and apply categories to existing 
appointments created in the previous exercise. Also, try to rename a named 
category and to remove a category you have created. 

 

ASSeSSmeNT  

Fill in the blanks: 

1.	 You	can	categorize	appointments	in	time	management	software	by	giving		specific	__________	
to appointments. 

2. Some of the categories in the time management software are: 

 a) ______________________________________________ 

 b) ______________________________________________ 

 c) ______________________________________________ 

 d) ______________________________________________ 

 e) ______________________________________________ 

 f) ______________________________________________ 

Figure 15
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SeSSioN 4: SHAre A CALeNDAr 

relevant Knowledge

You can also share your calendar with someone else by sending the calendar to the concerned 
person’s email id. the question that comes to the mind is why should i? Sharing your calendar 
helps to share various segments of your time-centric life with your spouse, family, and others. 
You are able to receive time-centric news and updates from trusted providers. Calendar sharing 
is the last frontier for true collaboration and social networking. Moreover, you can create calendar 
folders	and	choose	specific	folders	to	share.	For	example,	you	can	create	a	calendar	folder	for	a	
particular project and share it with your co-workers. You can also grant them permission to modify 
the events and appointments in the calendar. 

in this exercise, you will learn to share a copy of your calendar in an email message using email 
server. the calendar will be uploaded to the mail server and can be accessed by others using 
their email id. 

Click on Publish My Calendar… option available in the navigation Pane of the Calendar as 
shown below. 

Note: in order to upload your calendar to the mail server, you must have an email account 
in Microsoft Mailing service. Click Sign in, to login with your account, if you having one; otherwise 
create an email account by selecting click here to sign up for a free account available  
in the window. Enter your email iD and password and click Sign in. the following window 
appears: 

Figure 16
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Click Finish to publish the calendar on the mail server. the following dialog box appears: 

Select the time span in the calendar to be shared by selecting the drop down values. You can 
configure	what	details	are	to	be	shared	with	others	using	the	Detail list and Permissions options. 
After specifying necessary details, click OK. the following dialog box appears as shown below. 

You are asked to enter your email account details to publish the calendar. 

Figure 17

Figure 18

Figure 19
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Once you enter all the details, click OK. Once you click OK the following message box appears. 

to send the invitation, click Yes. the Calendar - Share window appears. 

Enter the email accounts to whom you would like to share the calendar with and click Send and 
the invitation will be sent to their email accounts. 
When others sign in into their mail accounts, the following message will be displayed to the 
recipients. 

to view the shared calendar, the recipients have to click on Subscribe to this Calendar option 
available at the top of the message. the following dialog box appears: 

Figure 20

Figure 21

Figure 22

Figure 23
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Click Yes to subscribe to the shared calendar. Once you click Yes, the recipients will be displayed 
with a window similar to the one below to enter their account details. 

Once the authentication is complete, the calendar will be downloaded and made available on their 
calendar program. 

now other users can view your calendar. 

You can also send a copy of your calendar to other users as a standard email message. the 
calendar will be displayed as an attachment to the recipients in the email. to do so, click on Send 
a Calendar via E-mail option available in the navigation Pane of the Calendar as shown below. 

Figure 24

Figure 25

Figure 26
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the Send a Calendar via E-mail dialog box appears. 

You can send either the entire calendar or particular week or day in the calendar by selecting the 
appropriate option and click oK. 

You can specify the address of the user to whom you want to share the calendar and click Send 
to send the calendar to the person. 

exerCiSe   

Perform the following activities till you are confident: 

S.No. Activities 

1. Share the calendar you have created in the previous sessions with your classmates 
using both the methods you have learnt in this exercise. 

Figure 27

Figure 28
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ASSeSSmeNT  

Fill in the blanks: 

1. _____________ your calendar helps to share various segments of your time-centric life with 
your spouse, family, and others. 

2. _____________ is the last frontier for true collaboration and social networking. 

3. to share a calendar you have to select __________________ option available in the 
navigation Pane. 

SeSSioN 5: PriNT A CALeNDAr 

relevant Knowledge

You can print the calendar and keep it for reference. this might be useful in situations when you 
don’t have access to a computer. in this exercise, you will learn to print a calendar. 

Go to File > Print, the Print dialog box appears.

Figure 29
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Select the range of the calendar by specifying the dates that you need to be printed and click 
OK. 

now try printing using different styles (Daily, Weekly, and Monthly) available in the Print style box 
(figure	above).	

to print the details of private appointments, uncheck the Hide details of private appointments 
check box. 

to print non-adjacent days, change to Week or Month view and then select the days you want to 
print, and then click File > Print.

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 

1. Print a calendar using options in the print dialogue box. You may opt for either the 
daily, monthly or weekly style as per your choice.

 

ASSeSSmeNT  

Fill in the blanks: 

1. Print option is available under ___________ menu. 

2. to print the details of private appointments you have to uncheck ______________________ 
checkbox. 

SeSSioN 6: CreATiNg A meeTiNg reQUeST

relevant Knowledge

A meeting is an appointment to which you invite people or reserve resources for (meeting hall, 
equipment etc.). You can create and send meeting requests and reserve resources for face-to-
face meetings or for online meetings. to create a meeting, you identify the people to be invited, 
the resources to be reserved and pick a meeting time. Responses to your meeting request appear 
in your inbox. You can also add people to an existing meeting or reschedule a meeting if the 
schedule is not convenient. in this exercise, you will learn to create a meeting request. You can 
schedule a meeting request using email application software. 
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Go to File > New > Meeting Request, the following window will be displayed: 

You can send the meeting details to another user by setting the Subject, Location and timings of 
the meeting in the window shown above. 

Click Send. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities

1. Create meeting request for the following items: 
1. School Annual Day function discussion. 
2. Blood donation camp discussion 

ASSeSSmeNT  

Fill in the blanks: 

1. A __________ is an appointment to which you invite people or reserve resources. 

2. You can specify ________, _________ & ______ while sending a meeting request. 

Figure 30
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SeSSioN 7: reSPoND To A meeTiNg reQUeST  

relevant Knowledge

Calendar software allows the user to respond to other users meeting requests. in this exercise, 
you will learn to respond to a meeting request. 

Open the email application to view the request. to respond, select Accept, Tentative, Decline or 
Propose New Time options	(figure	below)	

As a meeting attendee, you can propose an alternative meeting time. However, the meeting 
organizer	must	accept	the	new	time.	Meeting	organizers	can	send	meeting	requests	that	restrict	
the	ability	to	propose	alternate	meeting	times.	If	the	meeting	organizer	has	restricted	meeting	
proposals, the Propose New Time command is not available. By default, when you propose 
a new time, you tentatively accept the meeting. However, if you click the text Propose New 
Time, you have the additional options to click Tentative and Propose New Time or Decline 
and Propose New Time. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Respond to the meeting requests sent by one of your classmates using mentioned 
procedure you have learnt today. 

Figure 31

Figure 32
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2. Respond to requests from other classmates using options such as Accept, tentative, 
etc. and observe the results sent to your mail. 

ASSeSSmeNT  

Fill in the blanks: 

1. Calendar software allows the user to _________ to other users meeting requests. 

2. Responses to your meeting request appear in your ____________. 

3. Some of the response options for meeting request are __________,____________,______
_____ & ________________ . 

4. You have received a meeting request for which the schedule is not convenient  to you; 
however you would like to reschedule this meeting. Which option should be used when 
responding to this meeting request? ________________ 

SeSSioN 8: CreATe AND eDiT A TASK 

relevant Knowledge

tasks refers to actions that can be performed by an user; tasks may include action items such 
as booking a conference room, booking tickets, reminder for a task completion itself, etc. in this 
exercise, you will learn to create and edit a task. 

You can create tasks in email calendar application software. 

Go to File > New > Task, a Task window will be displayed as shown below. 

Figure 33
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Here	you	can	define	a	subject	name	for	the	task;	the	start	date	and	end	date	of	the	task;	the	status	
of the task and the priority of the task. Once you have given the entire details click Save & Close 
at the top of the page. A window is displayed as shown below. 

You can also the edit the task by double clicking the task name available in the email application 
software. 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a new task 

2. Edit an existing task

ASSeSSmeNT  

Fill in the blanks: 

1. _______ refers to actions that can be performed by a user. 

2.	 While	creating	a	task	you	can	define_______________	,	____________,	______________,	
_______________ & _________________ of a task. 

Figure 34
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SeSSioN 9: CreATe AND eDiT A NoTe 

relevant Knowledge

notes are short text messages that can be used for taking quick notes. You can create  notes in 
the calendar software. in this exercise, you will learn to create and edit a note. 

Go to File > New > Note, a window will be displayed as shown below. 

You can type the content of the note and click the  icon. Once you click the  icon, a dropdown 
list appears as shown below. 

to view the notes that you have created, click Notes in the calendar application. if you would like 
to edit the note, double-click on it and edit as required. 

Figure 35

Figure 36
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exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a note 

2. Edit a note

3. Create note for the following items:
1. Grocery list. 
2. Books to buy list.

 

ASSeSSmeNT  

Fill in the blanks: 

1. __________ are short text messages that can be used for taking quick notes. 

2. to view the list of notes you select the ___________ option in the Calendar application.  

SeSSioN 10: CreATe AND eDiT A JoUrNAL eNTrY 

relevant Knowledge

Journal entry creates a timeline of transactions that can be linked to a contact. A transaction might 
be an email, task, appointment etc. the following activities can be automatically recorded: 
•	 Emails	Sent	&	Received	
•	 Telephone	calls	
•	 Meeting	requests	&	responses	
•	 Office	documents	you	manage	

By	automatically	recording	all	documents	you	work	on,	email	sent	to	specific	contacts,	and	phone	
calls made, the journal logs all your activity. this is very useful when you needs to know how long 
you worked on a document or spent on a phone call because the journal tracks the elapsed time 
along with the event; or when a manager might want to know the number of calls made or email 
sent by the team members or track the number of documents created per hour. 

in this exercise, you will learn to work with journal entries. 
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if you would like to track the usage of an application such as Microsoft Word, go to Tools > 
options, a dialog box will be displayed as shown below. 

Click on Journal options button. 

Once you click the button, a dialog box will be displayed as shown below.  

Check Microsoft Word under Also record files from Section and Click oK. Close the time 
management software. 

Figure 37

Figure 38
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now open the word processing software, create a document and save it. Close the Word 
Processing software. Open the time management software. 

Select Go > Journals. 

Following window will be displayed: 

notice the document that you created earlier is listed. You can edit the journal entry by double-
clicking the entry or by right-clicking the entry and selecting open Journal entry. 

A window similar to the one below will be displayed: 

Figure 39

Figure 40



235information technology

Unit-6

Notice the following items that are displayed: 
•	 Document	file	name	and	path	
•	 Created	time	and	date	
•	 Duration	(Amount	of	time	spent	on	that	document)	

•	 Shortcut	to	the	document	itself!	(Double-clicking	the	shortcut	will	open	the	document)	

Similarly if you would like to track emails send to your contacts, Go to Tools > Options. Click on 
Journal options button. 

Figure 41

Figure 42
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Under For these contacts: section, select the contacts that you wish to track by placing a check 
against each contact. Click oK. 

Note: the contacts added in the calendar application will be visible here. 

now send mail to the contacts (selected in the previous step). Once you have completed sending 
the mails, Click go > Journals. A window similar to the one will be displayed. 

notice the mail entries (sent & received) displayed. Right-click on the entry and select open 
Journal entry. 

Figure 43

Figure 44
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notice the following items that are displayed: 

•	 Mail	Subject	

•	 Timestamp	(time	and	date)	

•	 Shortcut	to	the	mail	itself!	(Double-clicking	the	shortcut	will	open	the	mail)	

now that you have learnt to work with Journal, work with different other options such as task 
requests, meeting requests, etc. and observe the tracking in the time management software.

exerCiSe  

Perform the following activities till you are confident:

S.No. Activities 

1. Create a new journal entry 

2. Edit an existing journal entry 

ASSeSSmeNT  

Fill in the blanks: 

1. _______________ creates a timeline of transactions that can be linked to a contact. 

2. __________________, __________________, ________________, ______________ are 
some of the items that can be automatically recorded by the Calendar Software. 
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SeSSioN 1: DATABASe CoNCePTS  

relevant Knowledge

A	database	is	an	organized	collection	of	data.	You	can	visualize	it	as	a	container	of	information.	
The	data	is	typically	organized	to	model	relevant	aspects	of	reality	(for	example,	the	availability	of	
rooms	in	hotels),	in	a	way	that	supports	processes	requiring	this	information	(for	example,	finding	
a hotel with vacancies).

Suppose if you own a stationary shop, you need to keep detailed records of the materials available 
in your shop. You also need to store information about pricing, stock levels for reordering, old 
stocks,	etc.	While	 in	 the	manual	system,	you	would	maintain	several	files	with	different	bits	of	
information;	 in	 the	computerized	system	you	would	use	database	programs	such	as	Microsoft	
Access,	OpenOffice.org	Base,	and	MySQL,	to	organize	the	data	as	per	your	business	need.

The	database	concept	has	evolved	since	the	1960s	to	ease	increasing	difficulties	in	designing,	
building, and maintaining complex information systems (typically with many concurrent end-users, 
and with a large amount of diverse data).

in this lesson, you will learn database concepts and to work with a Database Management System 
(DBMS).

Database management System

A database management system is a software package with computer programs that controls the 
creation,	maintenance,	and	use	of	a	database.	 It	allows	organizations	to	conveniently	develop	
databases	for	various	applications.	A	database	is	an	integrated	collection	of	data	records,	files,	
and other objects. A DBMS allows different user application programs to concurrently access the 
same database.

Well	known	DBMSs	include	Oracle,	IBM	DB2,	Microsoft	SQL	Server,	Microsoft	Access,	PostgreSQL,	
MySQL,	FoxPro,	and	SQLite.

Data can be organized into two types:

•	 Flat File: Data is stored in a single table. Usually suitable for less amount of data.

•	 relational: Data	is	stored	in	multiple	tables	and	the	tables	are	linked	using	a	common	field.	
Relational is suitable for medium to large amount of data.

Database Servers

Database servers are dedicated computers that hold the actual databases and run only the 
DBMS and related software. typically databases available on the database servers are accessed 
through command line or graphic user interface tools referred to as Frontends; database servers 
are referred to as Back-ends. Such type of data access is referred to as a client-server model.
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rDBmS

A relational database management system (RDBMS) is a database management system that is 
based on the relational model as introduced by E. F. Codd, of iBM’s San Jose Research Laboratory. 
Most popular databases currently in use are based on the relational database model.

The	relational	model	for	database	management	is	a	database	model	based	on	first-order	predicate	
logic,	first	formulated	and	proposed	in	1969	by	Edgar	F.	Codd.	In	the	relational	model	of	a	database,	
all	data	is	represented	in	terms	of	tuples,	grouped	into	relations.	A	database	organized	in	terms	of	
the relational model is a relational database.

the purpose of the relational model is to provide a declarative method for specifying data and 
queries: users directly state what information the database contains and what information they 
want from it, and let the database management system software take care of describing data 
structures for storing the data and retrieval procedures for answering queries.

Database Concepts

Database contains objects that are used for storing and managing information. to understand 
a database in very simple language, let’s look at the example of your address book. What do 
you store in an address book? You may have people’s name, people’s address, people’s phone 
number and maybe even people’s birthdays. there is a common element here – people. in this 
example, each person is considered an “item”. So, an item is what the database is storing 
information about. When you were recording information in your address book, what did you ask 
the people? What is your address? What is your phone number? etc. Each question that we ask 
about our item is a “field”. now, say you make new friends and want to add their information 
to your address book. You will ask questions, get the answers and create a new “record”. So a 
record	is	a	set	of	information	(made	up	of	fields)	stored	in	your	database	about	one	of	the	items.	A	
“value” is the actual text or numerical amount or date that you put in while adding information to 
your database. When you put all the information together in a grid (like you do in a spreadsheet), 
a collection of similar records creates a table.

A database can have one or many tables. An address book example is a very simple one, in real 
life there are many more details involved. A big company would have in its database, one table for 
its products, one table for its suppliers, one table for its customer details, one for orders received 
and maybe many others. Basically each table in a database contains information about one type 
of item. So a database is basically a container that holds tables and other objects and manages 
how they can be used.

Another very important thing to remember is that when we put in information, we may have people 
with the same name (there can be more than one Charu Arora) or the same address (members 
of a family). But when creating a database an important feature is record uniqueness in every 
table. it is important to be able to distinguish between different items having duplicate values.



242

Unit-7

Uniqueness helps to avoid accidental duplication of records caused by user or computer error. this 
can	be	achieved	by	using	some	number	or	value	that	uniquely	identifies	a	record.	If	such	a	unique	
value	does	not	exist	in	your	fields,	as	the	database	designer,	you	can	create	a	special	additional	
field	in	a	table	where	unique	numbers	or	values	can	be	assigned	for	each	new	entry.	Therefore,	
every table has a key field which ensures that there are 100% unique values throughout the 
database.

Every	database	table	should	have	one	or	more	fields	designated	as	key.	You	can	assign	a	unique	
value to this key for differentiating records that may have similar names or address. Look at the 
following example of student database:

Name Standard Section
Ram X A
Ravi X A
Ravi X A

Sanjay X B

In	 this	 table,	 it	will	be	extremely	difficult	 to	differentiate	between	student	 records	as	 they	have	
names	that	are	similar.	To	differentiate,	you	can	add	additional	field	-	roll	number	-	that	will	be	
unique for each record (example below).

rollno Name Standard Section
19 Ram X A
20 Ravi X A
21 Ravi X A
22 Sanjay X B

 

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Analyze	database	requirements	for	a	retail	shop.	Record	the	business	requirements	
and document. (You can use this information for creating a database to suit this 
business requirement) 

2. Analyze	database	requirement	for	your	school;	visit	different	departments	such	as	
library, student admission centre, to gather requirements. Document the business 
requirement. (You can use this information for creating a database to suit this 
requirement 
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ASSeSSmeNT  

Short Answer Questions

1. What does DBMS stands for?

2. What does RDBMS stands for?

3.	 How	is	data	organized	in	a	RDBMS?

Fill in the blanks:

1.	 A	__________	is	an	organized	collection	of	data.	

2. A ________________ is a software package that can be used for creating and managing 
databases. 

3. A __________________________ is a database management system that is based on the 
relational model. 

4. three popular DBMS software are ________________, ___________________, & 
_________________________. 

SeSSioN 2: DATA STorAge  

relevant Knowledge

Data	in	a	relational	database	management	system	(RDBMS)	is	organized	in	the	form	of	tables.	
You will now quickly recap what you learnt in the last session and assimilate more concepts.

Tables:

A	table	 is	a	set	of	data	elements	 (values)	 that	 is	organized	using	a	model	of	vertical	columns	
(which	are	identified	by	their	name)	and	horizontal	rows.	A	table	has	a	defined	number	of	columns,	
but	can	have	any	number	of	rows.	Each	row	is	identified	by	the	values	appearing	in	a	particular	
column	identified	as	a	unique	key	index	or	the	key	field.

Columns or Fields:

A column is a set of data values of a particular simple type, one for each row of the table. 
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the columns provide the structure according to which the rows are composed. For example, 
cFirstName,	or	cLastName	are	fields	in	a	row.

rows or records or Tuples:

A row also called a record or tuple represents a single, data item in a table. in simple terms, a 
database	table	can	be	visualized	as	consisting	of	rows	and	columns	or	fields.	Each	row	in	a	table	
represents a set of related data, and every row in the table has the same structure.

Data types:

Datatypes are used to identify which type of data (value) we are going to store in the database. 
Fields themselves can be of different types depending on the data they contain. Data types in 
OpenOffice	base	is	broadly	classified	into	five	categories	listed	below.
•	 Numeric	Types
•	 Alphanumeric	Types
•	 Binary	Types
•	 Date	time
•	 Other	Variable	types

Numeric Types:

Numeric	data	 types	are	used	for	describing	numeric	values	for	 the	field	used	 in	 the	table	of	a	
database. numeric data types in a database can be using for storing information such as mobile 
number, roll number, door number, year of school admission, true or false statements, statistical 
values, etc. the different types of numeric data types available are listed here.

Name Data type Description

BOOLEAn Yes / no Values as 0 or 1. Example: true or False, Yes or no.

tinYint tiny integer Store integer range between 0 to 255

SMALLint Small integer Store integer range between -215	to	+215-1

intEGER integer Store integer range between -231	to	+231-1

BiGint Big integer Range between -263	to	+263-1

nUMERiC number Maximum precision of e(+/-)231

DECiMAL Decimal Maximum precision of e(+/-)231

REAL Real 2-1074 to (2-2-52)* 21023

FLOAt Float 2-1074 to (2-2-52)* 21023

DOUBLE Double 2-1074 to (2-2-52)* 21023
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Alphanumeric Types:

Name Data type Description

LOnGVARCHAR Memo Stores up to the max length or number indicated 
by user. it accepts any UtF 8 Character.

CHAR Text	(fix)
Stores	exactly	the	length	specified	by	user.	Pads	
with trailing spaces for shorter strings. Accepts 
any UtF 8 Character.

VARCHAR text Stores	 up	 to	 the	 specified	 length.	 No	 padding	
(Same as long var char)

VARCHAR_iGnORE
CASE text

Stores	up	the	specified	length.	Comparisons	are	
not case sensitive but stores capitals as you type 
them.

Binary Types:

Binary data types are used for storing data in binary formats. Binary data types in a database can 
be	using	for	storing	photos,	music	files,	etc.	In	general,	files	of	any	format	can	be	stored	using	the	
binary data type. the different types of binary data types available are listed here.

Name Data type Description

LOnGVARBinARY image Stores any array of bytes (images, sounds, etc.). no 
validation required.

BinARY Binary	(fix) Stores any array of bytes. no validation required.

VARBinARY Binary Stores any array of bytes. no validation required.

Date time:

Date	time	data	types	are	used	for	describing	date	and	time	values	for	the	field	used	in	the	table	of	
a database. Date time data types in a database can be using for storing information such as date 
of birth, date of admission, date of product sale, etc. the different types of date time data types 
available are listed here.

Name Description Format

Date Stores month, day and year information 1/1/99 to 1/1/9999

time Stores hour, minute and second 
information Seconds since 1/1/1970

timestamp Stores date and time information
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other Data Types:

Name Description

Other/Object Stores	serialized	Java	objects	â€“	user	application	must	supply	
serialization	routines

You had used the example of an address book in the previous lesson. An address book uses only 
one table. But look at a different situation. if you are a dealer selling a single type of item and 
want to record details of your sales in the past month and also want the details of the client who 
purchased the item ( name, address, phone, date purchased, number of items bought etc), what 
would you do?. You create a table Sales with all the details:

orderiD Customer Name Customer Address Phone Sale Date #itemsBought

000789 Sheela Arora xxxxxxnoida 2444490 01/11/12 3

000790 Vaibhav Mittal xxxxGhaziabad 2443358 01/11/12 4

000791 Saurabh tayal xxxxnew Delhi 2678945 02/11/12 12

000792 Vaibhav Mitttal xxxxGhaziabad 2443258 02/11/12 23

000793 Prashant Singh xxxxRohtak 6784534 02/11/12 4

000794 Shila Arora xxxxxxnoida 2444490 03/11/12 18

000795 Vaibhav Mittal xxxxGhazibad 2443258 03/11/12 45

Do you see a problem here? Every time you sell an item to Sheela or Vaibhav or any other 
customer (client) you need to store the details again. So, what is the solution? Create one table 
for client details and another for sale details. Since each record has to be unique, you can insert a 
ClientID	field	to	uniquely	identify	each	client	in	the	client	table.	In	the	Sales	table,	you	would	give	
a	point	of	reference	which	“points”	to	a	particular	record	in	the	Client	table.

In	the	example	here,	the	field	ClientID	occurs	once	in	the	Client	table,	but	since	one	client	can	
place many orders, it occurs a number of times in the Sales table.  Since we cannot have an order 
without a customer, we call Client the parent and Sales the child table. Related tables like these 
share	a	common	field.	You	store	data	about	people	once,	but	refer	to	those	people	many	times	
in the database.

This	unique	field	is	called	the	primary key (PK). A primary key is a unique value that identifies 
a row in a table. in our example, ClientiD is the primary key in the Client table. Primary Keys are 
also indexed in the database, making it faster for the database to search for a record.

The	referred	field	ClientID	which	occurs	in	the	Sales	table	is	called	the	foreign key (FK). Hence, 
the	foreign	key	identifies	a	column	or	set	of	columns	in	one	(referencing)	table	that	refers	to	a	
column	or	set	of	columns	in	another	(referenced)	table.	The	“one”	side	of	a	relation	is	always	the	
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parent,	and	provides	the	PK	attributes	to	be	copied.	The	“many”	side	of	a	relation	is	always	the	
child, into which the FK attributes are copied. Memorize it: one, parent, PK; many, child, FK.

Another point to remember is that the end users will/may never have direct access to the 
database. they can only see what you permit them to and can select only from the options you 
give them.

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a database for a stationery shop.
Hint	:	Create	fields	for	items,	price,	color,	vendor,	etc.	

ClientiD Name Address Phone

0000001 Sheela Arora xxxxxxnoida 2444490

0000002 Vaibhav Mittal xxxxGhaziabad 2443358

0000003 Saurabh tayal xxxxnew Delhi 2678945

0000004 Prashant Singh xxxxRohtak 6784534

Client Table

Primary Keyone client, three 
orders for that client. 

Sales Table

OrderiD ClientiD SaleDate #itemsBought

000789 0000001 01/11/12 3

000790 0000002 01/11/12 4

000791 0000003 02/11/12 12

000792 0000002 02/11/12 23

000793 0000004 02/11/12 4

000794 0000001 03/11/12 18

000795 0000002 03/11/12 45

Primary Key
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ASSeSSmeNT  

Short Answer Questions 

1. List the data types used in a DBMS /RDBMS?

2. State the relationship and difference between a primary and foreign key?

3.  List datatypes available in numeric Datatype?

4. List datatypes available in Alphaumeric Datatype?

5. List datatypes available in numeric Datatype?

6. List datatypes available in Data Datatype?

Fill in the blanks: 

1.	 A	___________	is	a	set	of	data	elements	that	is	organized	using	a	model	of	vertical	columns	
and	horizontal	rows.	

2. A _________ is a set of data values of a particular simple type, one for each row of the 
table. 

3. A ___________ represents a single, data item in a table. 

4. _____________ are used to identify which type of data we are going to store in the 
database. 

5.	 A	____________	is	a	unique	value	that	identifies	a	row	in	a	table.

SeSSioN 3: mANiPULATiNg DATA  

relevant Knowledge 
In	 a	 database	 you	 can	 define	 the	 structure	 of	 the	 data	 and	manipulate	 the	 data	 using	 some	
commands. there are two types of languages for this task. these are:

•	 Data	Definition	Language	(DDL)

•	 Data	Manipulation	Language	(DML)

Data Definition Language (DDL)

A	data	definition	language	or	data	description	language	(DDL)	is	a	standard	for	commands	that	
define	the	different	structures	in	a	database.	DDL	statements	create,	modify,	and	remove	database	
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objects such as tables, indexes, and users. Common DDL statements are CREAtE, ALtER, and 
DROP.

Data manipulation Language (DmL)

A data manipulation language (DML) is a language that enables users to access and manipulate 
data	 in	 a	 database.	 The	 goal	 is	 to	 provide	 efficient	 human	 interaction	with	 the	 system.	Data	
manipulation involves:

•	 Retrieval	of	information	from	the	database-	SELECT	statement

•	 Insertion	of	new	information	into	the	database	-	INSERT	statement

•	 Deletion	of	information	in	the	database	-	DELETE	statement

•	 Modification	of	information	in	the	database	-	UPDATE	statement

A query language is a part of DML involving information retrieval only. the terms DML and query 
language are often used synonymously.

A	popular	data	manipulation	language	is	Structured	Query	Language	(SQL).	This	is	used	to	retrieve	
and manipulate data in a relational database. Other forms of DML are those used by iMS/DLi, 
CODASYL	databases,	such	as	IDMS	and	others.	Data	manipulation	language	comprises	the	SQL	
data change statements, which modify stored data but not the schema or database objects.

There are two types of DmL:

•	 Procedural: The	user	specifies	what	data	is	needed	and	how	to	get	it

•	 Nonprocedural: The	user	only	specifies	what	data	is	needed.	This	is	easier	for	the	user	but	
may	not	generate	code	as	efficient	as	that	produced	by	procedural	languages.

ASSeSSmeNT  

Fill in the blanks:

1. types of languages used for creating and manipulating the data in the Database are 
___________________ & ________________. 

2.	 A	____________________	is	a	standard	for	commands	that	define	the	different	structures	in	
a database. 

3. A ______________ is a language that enables users to access and manipulate data in a 
database. 

4. A _____________ is a part of DML involving information retrieval only. 

5. A popular data manipulation language is _________________. 

6. Common DDL statements are _________, ___________ and __________ . 
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SeSSioN 4: CreATiNg A DATABASe oBJeCT  

relevant Knowledge 

There	are	a	variety	of	DBMS/RDBMS	available;	in	this	exercise,	you	will	learn	about	OpenOffice	
Base an Open Source RDBMS.

Launching Openoffice

•	 To	 launch	 OpenOffice,	 click	 Start>Programs>OpenOffice.org 3.4.1>OpenOffice.org. 
Alternatively,	you	can	also	double-click	on	the	OpenOffice.org	3.4.1	shortcut	on	the	desktop	
if available. You should see a Window similar to the one displayed below

Select the option database to launch the base application.

You can also directly launch the OpenOffice Base Application by doing the following:

•	 Click	 Start>Programs>OpenOffice.org 3.4.1>OpenOffice.org Base. You should are 
guided	 through	 the	Database	Wizard	 for	 creating	 a	 database.	You	will	 see	 a	 dialog	 box	
similar to the one displayed below.

Figure 1
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You can create a new database by selecting the option Create a new database.

You	can	also	open	an	existing	database	file	that	you	have	already	created	by	selecting	the	option	
Open an existing database file.

Click Next. A dialog box similar to the one displayed below appears.

Click Finish. the Save As dialog box appears as shown below.

Figure 2

Figure 3
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Specify a name for the database in the File name: field	and	click	Save. A window similar to the 
one displayed below.

now that you have created a database, you can work with the database as outlined in the next 
few sessions.

Figure 4

Figure 5
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exerCiSe  
Perform the following activities till you are confident:

S.No. Activities 

1. Create a database 

ASSeSSmeNT  

Short Answer Questions: 

1.	 What	is	the	file	extension	for	databases	created	using	OpenOffice.Org	Base?	

2.	 List	any	three	file	formats	that	can	be	managed	using	OpenOffice.Org	Base?

SeSSioN 5: CreATiNg A TABLe  

relevant Knowledge
tables are the basic building blocks of a database. You store the data in the database in the 
form of tables. in the previous exercise you have learnt how to create database objects in 
OpenOffice.

in this exercise you will learn how to create a table in a database. 

After creating the database, you see a window as shown below.

Figure 6
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Click on Create Table in Design View… option available under tasks and a Table Design 
window appears as shown below.

Specify	the	field	name	and	data	type	of	the	field	to	be	created	by	selecting	the	appropriate	type	
available under Field type dropdown list.
Now	create	a	table	with	the	following	fields	displayed	below:

Specify	the	field	name	and	the	data	type	for	each	field	name.	For	example,	the	table	contains	
Name	field	and	the	data	type	of	the	Name	is	TEXT	[VARCHAR].	You	can	specify	the	length	of	the	
field	value.

Field Name Data type Length

name VARCHAR 50

Rollno tinYint 3

DOB Date DD/MM/YY

Class Char 1

Phone intEGER 10

Email VARCHAR 75

Colour VARCHAR 15

Location VARCHAR 30

After	specifying	the	field	name	and	data	type	for	the	field	variables,	save	the	table	by	clicking	on	
File>Save shown below.

Figure 7
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Specify the table name. the default name is table1. Click oK.

A dialog box appears, similar to the one displayed below.

You are asked to set a primary key for the table you just created. You can select the appropriate 
option to set the primary key or leave the table without a primary key.

if you click Yes,	the	application	will	set	the	primary	key	for	the	first	field	created	automatically.	If	
you click No, you should see a window similar to the one displayed below.

Figure 8

Figure 9

Figure 10

Figure 11
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notice the table by the name SDetails created and visible under tables section.

Create the following records:

to insert values into the table, just double-click the table name, you should see a window similar 
to the one displayed below.

Start typing the records in the table with the data provided in the excel sheet and select File > 
Savecurrent record to save data in the table.

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a table and enter data in it

2. Create a database to store your academic records using the guidelines below:

•	Use	your	roll	number	as	the	file	name	for	your	database.

•	Create	 fields	 such	 as	 subject	 name,	 required	 score,	 passing	 score	 and	 your	
percentage.

•	Set	the	subject	name	field	as	the	primary	key.

Populate your database with your most recent exam results. 

Figure 12

Name Roll no DOB Class Phone Email Color Location

Ravi Kaul 23 13/08/99 X 123456 ravikaul@gmail.com Blue Delhi

Bijendar Dalal 13 15/01/99 X 567889 dalal@gmail.com Green Mumbai

Radha swami 7 01/02/00 X 234353 radhasw@gmail.com Orange Gujarat

Vikas Maheswari 32 17/11/98 X 233445 vikawari@gmail.com Blue Maharashtra

Vimla Rani 14 23/09/99 X 242526 Vimla99@gmail.com Yellow Orissa

Sandhya Reddy 26 19/12/98 X 213141 sandhyared@gmail.com Blue Delhi
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 ASSeSSmeNT   

Fill in the blanks:

1. __________ are the basic building blocks of a database. 

2. to design a table, you need to select __________ _______in _________ _______ option 
available under task. 

SeSSioN 6: BUiLDiNg FormS  

relevant Knowledge
A form provides the user a systematic way of storing information into the database. it is an interface 
in	a	user	specified	 layout	 that	 lets	users	 to	view,	enter,	and	change	data	directly	 in	database	
objects such as tables.

in this exercise, you will learn to create a form.

to create a form, Click on Forms option located under Database section (Figure below).

Click Use Wizard to Create Form… option under Tasks	group.	The	Form	Wizard	dialog	box	
appears as shown below. 

Figure 13



258

Unit-7

You	can	select	selective	fields	to	be	sent	onto	the	form	by	selecting	the	field	name	and	clicking	>	
button.	You	can	select	individual	fields	in	a	database	or	all	fields	in	a	database.

To	use	all	the	fields	in	the	table	in	a	form,	click	the	>>	button.

Notice	the	fields	displayed	under	Fields in the forms section (Figure below).

Click Next>. You see the Set up a sub form step	dialog	box	of	the	wizard	as	shown	below.

Figure 15

Figure 16

Figure 14
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You can select the option Add Subform if you need to insert the contents in the table in a separate 
form. Click Next>.

Now	you	need	 to	 arrange	 selected	 fields	 in	 a	 form.	You	 can	use	different	 styles	 from	 the	 list	
displayed below:

Once you have selected a style, click Next >

A dialog box appears wherein you can select the data entry model.

Click Next >. You should see a dialog box wherein you can specify the styles to be used in the 
form.

Figure 17

Figure 18

Figure 19
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Click Next >. You see a dialog box where you can specify the name of the form. Click Finish.

A form window appears. notice that the records in the table are displayed automatically within the 
form that you just created.

You can add new records to the table using the form by clicking the  symbol located at the 
bottom as shown below.

Once you click the  symbol, you will be displayed with a window for creating records (Figure 
below).

Figure 21

Figure 22

Figure 20
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You have learnt to create records using design view in the earlier sessions. You can add records 
using the form as displayed below. type the following data in the textbox provided in the box as 
shown below:

name Gautam

Rollno 43

DOB 10/12/99

Class X

Phone 325476

Color Pink

Email gautam43@gmail.com

Location Assam

to view the saved records, Double-click SDetails (table name) under tables section. A window 
similar to the one below will be displayed; notice the record that you created using a form is also 
displayed along with other records (Figure below)

Figure 23
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now enter three more records using the form and view them using the above mentioned 
procedure.

exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a form 

2. Enter data in a table using a form 

3. Create a form for the academic database created in the earlier session. Populate the 
academic database with mark results using the form.

ASSeSSmeNT  

Fill in the blanks:

1. A _______ helps the user to systematically store information in the database. 

2. A ________ enables users to view, enter, and change data directly in database objects such 
as tables. 

3. to create a form you need to select _________ option available under Database section. 

Figure 24
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SeSSioN 7: CreATe AND mANAge QUerieS  

relevant Knowledge

Having created the tables and entering data into them, now you want to extract some information. 
That’s	when	you	query	the	database.	As	the	name	suggests,	query	is	to	collect	specific	information	
from	 the	 pool	 of	 data.	A	 query	 helps	 us	 join	 information	 from	 different	 tables	 and	 filter	 that	
information. Filtering means that the query uses criteria you provide it to hide some data and 
present only what you want to see.

Some RDBMS provide a graphical means to create queries, but most RDBMS do not do so. that’s 
where	you	use	SQL	(pronounced	as	“sequel”)	or	Structured	Query	Language.	Query	languages	
are	computer	languages	used	to	make	queries	into	databases	and	information	systems.	Queries	
are	commands	that	are	used	to	define	the	data	structure	and	also	to	manipulate	the	data	in	the	
database.

A	SELECT	statement	retrieves	zero	or	more	rows	from	one	or	more	database	tables	or	database	
views. in most applications, SELECt is the most commonly used Data Manipulation Language 
(DML) command.

the SELECt statement has many optional clauses:

•	 WHERE	specifies	which	rows	to	retrieve.

•	 ORDER	BY	specifies	an	order	in	which	to	return	the	rows.

to retrieve all the columns in a table the syntax is:SeLeCT * From <TABLeNAme>;

in order to execute queries click on the Queries option available on the left side under database 
section, click Create Query in SQL View as shown below.

A window appears similar to the one displayed below.

Figure 25
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You can type the query in the above window and execute it by using the F5 function key or by 
clicking the  icon in the window. 

For example, if you want to display all the data in the table that you created in the early session, 
then the select statement will be: select * from SDetails;

After executing the select query the output will be shown similar to the one displayed below.

to get details about the list of students whose favorite color is blue, you can use:
select * from SDetails where Color=’Blue’;
After executing the select query the output will be shown similar to the one displayed below.

Figure 26

Figure 27

Figure 28
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to view records in ascending order of Rollno, from the table the select statement will be: 

select * from SDetails order by “Rollno” ASC;

You can add, modify or delete records using the insert, Update and Delete commands.

To	type	and	execute	SQL	commands,	click	on	Tools > SQL. A window similar to the one below 
will be displayed.

You	can	type	the	SQL	Commands	in	the	Command to execute space and click on Execute.

iNSerT statement

inSERt statement is used to add one or more records to a database. the general syntax of the 
insert statement is shown below.

INSERT INTO <table_name><column1, column2, column3...> VALUES <value1, value2, 
value3 ...>;

to add a record in the database created earlier, type the following and click Execute.

insert	into	SDetails	(“ID”,	“Name”,	“Rollno”,	“DOB”,	“Class”,	“Phone”,	“Email”,	“Color”,	“Location”)	
values (‘8’, ‘Ranjith Singh’, ’67’, ‘12-03-99’,’X’, ‘435363’, ‘ranjth99@gmail.com’, ‘White’, ‘Bihar’);

Figure 29

Figure 30
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After inserting the data into the table, use select query to view the updated table. After execution 
you should see a window similar to the one displayed below.

UPDATe statement
Update statement is used for modifying records in a database. the general syntax of the update 
statement is as follows:

UPDATE <table_name> SET <column_name> = value [, column_name = value ...] [WHERE 
<condition>]

to update a record using update statement, type the following and click Execute.

update SDetails set Location = ‘Bhubaneswar’ where Rollno = 14;

Execute select query to view the updated table. After execution you should see a window similar 
to the one displayed below.

DeLeTe statement
Delete Statement is used to remove one or more records in a database. the general syntax of the 
delete statement is as follows:

DELETE FROM <table_name> [WHERE] <condition>;

Figure 31

Figure 32
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to delete one of the records in the table created earlier using delete statement, type the following 
and click Execute:

delete from SDetails where ID=8;

Execute select query to view the updated table. After execution you should see a window similar 
to the one displayed below.

notice the record with the Roll no 8 is deleted from the database.

CreATe Statement

Create statement is used for creating a database or a table in any RDBMS Software. A commonly 
used CREAtE command is the CREAtE tABLE command. the general syntax of the create 
statement is shown below.

CREATE TABLE <TABLENAME> ([column definitions]) [table parameters]

Column	definitions:	A	comma-separated	list	consisting	of	any	of	the	following

Column	definition:	[column	name]	[data	type]	{NULL	|	NOT	NULL}	{column	options}

Primary	key	definition:	PRIMARY	KEY	([comma	separated	column	list])

For example, if you would like to create a table using the Create statement, type the following and 
click Execute.

CREAtE tABLE Employee (iD intEGER, name VARCHAR (50),

    Department VARCHAR (50),

    Address VARCHAR (120),

    Contact_number intEGER);

Now	create	5	records	in	the	table	and	use	the	SQL	statements	to	view,	modify	and	delete	them.

Figure 33
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exerCiSe  

Perform the following activities till you are confident:  

S.No. Activities 

1. Open the academic database created in the previous sessions.

2. Use the select query statement to query and sort on subjects marks scored was 
greater than 50%.

3. Create a database for a school library.

Hint	:	Create	fields	for	book	title,	cost,	provider,	availability,	etc	

4. Create a database for maintaining a song collection.

Hint	:	Create	fields	for	fields	such	as	artist,	movie,	year	released,	etc.

5. Create a database for collecting and maintaining census data.

Hint	:	Create	fields	for	fields	such	as	First	Name,	Last	Name,	DOB,	Place	of	birth,	
Employment Status, etc.

ASSeSSmeNT  

Fill in the blanks:  

1.	 A	__________	is	helps	to	collect	specific	information	from	the	pool	of	data	in	the	database.	

2.	 _________	 statement	 retrieves	 zero	 or	more	 rows	 from	one	 or	more	 database	 tables	 or	
database views. 

3. __________ statement is used to add one or more records to a database. 

4. __________ statement is used for modifying records in a database. 

5. __________ statement is used to remove one or more records in a database. 

6. __________ statement is used for creating a database or a table in any RDBMS Software.  
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SeSSioN 8: DeSigN rePorTS  

relevant Knowledge
A report is used to generate the overall work outcome in a clear format. You can also create 
reports in database.

Click	on	Reports	section	under	Database	in	the	OpenOffice	base	application.

Once you select the option, you should see a window similar to the one displayed below.

now we can generate the report for the table created earlier.

Click on Use Wizard to Create Report… option available under tasks.

Once you select the Use Wizard to Create report… option. You should see a window similar to 
one displayed below.

You	have	to	select	all	the	table	fields	by	selecting	the	>>	button,	once	you	click	the	button	>>	you	
should see a dialog box similar to the one displayed below.

Figure 34

Figure 35
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Click Next >.
Once you click Next>.you should see a dialog box similar to the one displayed below.

You	can	redefine	the	label	of	the	fields	in	the	reports	or	else	you	can	set	the	default	name.

Click Next >.

Once you click Next >, you should see a dialog box similar to the one displayed below.

Figure 36

Figure 37

Figure 38
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You	can	define	grouping	for	the	fields	of	the	table.

Click Next >.

Once you click Next >, you should see a dialog box similar to the one displayed below.

You	 can	 sort	 the	 field	 variables	 in	 the	 report	 by	 selecting	 the	 appropriate	 field	 and	 sorting	
method.

Click Next >.

Once you click Next >, you should see a dialog box similar to the one displayed below.

You can select the layout of the report by selecting the appropriate option available under the 
Layout of data down list and you can also select the orientation of the report.

Click Next >.

Once you click Next >, you should see a dialog box similar to the one displayed below.

Figure 39

Figure 40
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You	can	define	a	name	for	the	report	or	you	can	use	the	name	of	the	table	itself	for	the	report	
also.

Click Finish.

Once you click Finish you should see a window similar to the one displayed below with the 
report.

now create a report containing only name, Rollno and Phone details. Use different layouts for 
the report design.

Figure 41

Figure 42
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exerCiSe  

Perform the following activities till you are confident: 

S.No. Activities 

1. Create a report to display data from table 

2. Open the academic database created earlier. 

3. Design a report to display your entire academic score card. 

ASSeSSmeNT  

Fill in the blanks:

1. A ____________ is used to generate the overall work outcome in a clear format. 

2. to create reports you need to select ___________________ option available under tasks.




